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MED2020 Health Care Software Inc. 

MED2020 Health Care Software Inc. (MED2020) is a leading provider of modular health 

information management solutions for the health care industry. 

MED2020 provides solutions to assist capturing, reporting and analyzing health data to: 

• Enable enhanced information sharing  

• Encourage informed decision making, and  

• Streamline facility operations.   

MED2020’s flagship product, WinRecs™, is the foundation for a complementary suite of modules 

designed to assist health information management departments with their operational needs. 

Contact Details 

MED2020 is open Monday to Friday between 07:00 and 19:00 (Eastern Time), except Canadian 

federal holidays and Ontario provincial holidays. 

Head Office  

MED2020 Health Care Software Inc. 

4471 Innes Road, Suite 200  

Ottawa, Ontario  

K4A 1A7 

Tel: (613) 830-3761  

Fax: (613) 830-2410 

Toll Free: (800) 461-2020 

E-mail:   support@med2020.ca 
Web:  http://www.med2020.ca 

 

  

mailto:support@med2020.ca
http://www.med2020.ca/
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End-User Licence Agreement 

 

MED2020 retains proprietary rights for all information disclosed in this manual.  

Permission to reprint this document is provided to facilities and users of a licenced MED2020 

WinRecs™ application, provided the document is complete and its contents remain unaltered. 

No proof of status is required. 

Neither this document nor the information disclosed herein, or any part thereof, shall be 

transferred to other documents, used by, or disclosed to other parties for any purpose except as 

explicitly authorized by MED2020 Health Care Software Inc.  

MED2020 Health Care Software Inc. cannot give permission for use of any third-party content. 
 

 

Microsoft, Windows, Windows server, and Microsoft SQL Server are either registered trademarks 

or trademarks of Microsoft Corporation in the United States and/or other countries. 

Microsoft product screen shot(s) reprinted with permission from Microsoft Corporation. 

CMG, DPG, RIW and CACS are registered trademarks of the Canadian Institute for Health 

Information. 

Crystal and Crystal Reports are registered trademarks of Business Objects SA. 

Other trademarks remain the property of their respective owners. 
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Document Convention 

 

Convention Description 
screen Courier font shows an example of information or code displayed on 

the screen or specific names. 
boldface Boldface text indicates commands; keywords or menu selections you 

use to do a task. Example: click the menu File 
italics Indicates information that should be entered in a field. 

→ Indicates navigation from an icon or menu to another. Example: click 
the menu File→Open 

 
Toolbar Icon – When a specific toolbar item is referenced 

[Ctrl + ?] or [F00] This convention is used to describe a specific key combination or key 
that must be pressed to trigger an action. 

Underlined Underlined text refers to a hyperlink or cross reference 

Table 1 - Document convention 

 

This is the note format. 

This is the tips format. 
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Printing This Document  

For the best print quality when printing this document, select the Print as Image option in the 

Adobe® Acrobat® Reader™ print window or the Advance→Print as Image option in the Adobe® 

Acrobat® print window.   
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About WinRecs 

First introduced to the Canadian market in 1996, MED2020’s flagship product, WinRecs™, has 

evolved to become one of the most comprehensive Health Information Management software 

solutions on the Canadian market. WinRecs is a customizable abstracting and reporting system 

that is currently being used by hospitals to support decision-making at corporate, regional and 

provincial levels. The WinRecs Suite of Products provides solutions for Inpatient, Clinical and 

Ambulatory Care Services, including modules for DAD, NACRS, CJRR, Cancer Care, OHMRS, 

NRS and CCRS. Furthermore, WinRecs offers an Edit Engine to allow the creation of user-

defined edits, in addition to the complementary modules, Concurrent Review and Chart 

Maintenance. 

WinRecs Features 

o Docking windows allow users to expand, collapse, tab or pin information windows in the 

application, such as Visit History, Message List, Grouper and Module Menu.  

o Individuals can customize their view of the abstracting window for font size, row height and 

column width. 

o More options are available to navigate the abstract including the mouse, function or arrow 

keys or the Enter key to tab through the abstract. 

o Text can be directly entered into data entry fields, eliminating the data entry dialog box and 

reducing key strokes. Users may also copy and paste directly into text fields. 

o Contextual look up tables can be accessed by double-clicking in the entry field. 

o Multiple abstracts can be open at the same time, allowing users to toggle between as many 

open abstracts as they like. The active window is highlighted so users are certain which 

abstract is being worked on. 

o Multi-forms are presented in a new horizontal format which allow users to see multiple lines 

of occurrences at a single glance. 

o Multi-form columns can be re-arranged for quick revisions to data. 

o An Edit Engine module provides users with an intuitive interface that enables health records 

professionals to define and create their own data quality edits. 
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1.  Opening the WinRecs Application 

To open the application, double-click on the shortcut displayed below: 

 

 

 Figure 1 - Log In Screen 

If the WinRecs application cannot be found on the workstation contact the site IT department. 

o User Name:  This is assigned by the System Administrator 

o Password:  This is assigned by the System Administrator.  Change the password at any 

time by clicking on the ‘Change Password’ button on the right hand side of the Log in 

Window.  The password area is masked for security reasons.  

o Server Name: Depending on whether the dropdown or text options is selected. Press 

the down arrow and choose the Server Name where WinRecs resides or Type in the 

Server Name. The information will retain for subsequent sign in. 

o Database Name:  Depending on whether the dropdown or text options is selected. 

press the down arrow and these are databases available for the Server or type in the 

Server Name. This will retain for subsequent sign in.  

 

 

 

 

 

 

 

 

The buttons displayed in the WinRecs Log On dialog are: 
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Click this button to log in to WinRecs once all fields have been 

populated. 

       
Click to initiate a password change. 

 

Click to close the log in screen 

                    

Click this button to toggle between the drop down and text field 

options for Server Name & Database. 

Table 2 – WinRecs Log On   

Changing your Password: 

To change an existing password, type in the current password but do not hit ‘Enter’ or ‘OK’ (this 

will actually log into the WinRecs application).  

Click on the Change Password button.   

Type a new password, and confirm in the boxes provided.  Click Change Password and the new 

password will be saved.   

Clicking Cancel will return to the initial sign on.   

 

Figure 2 – Change Password 

 

For security reasons, the password is masked.  WinRecs tracks all user activity.  For 

new installation, it is recommended to change a password as soon as possible.  Do 

not share this password and passwords are case sensitive.   
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Once Connect is clicked or press Enter, the CIHI Licensing requirement is displayed press OK 

button or ESC key on the keyboard to bypass this screen. 

 

Figure 3 – License Agreement Window 

1.1 Custom Privacy Message  

The Privacy Message can be set at the Regional or Hospital Level from the Options tab. By 

default, this feature is disabled and only available if there is text entered into the Privacy Message 

field for either the Regional Profile or Hospital Profile. If no text is entered at either level, then the 

Privacy Message will not show. 

If there is text entered, then The Privacy Message will be displayed after the user closes the 

License screen. The Privacy Message will display the message provided in the Regional or 

Hospital Profile with the option to Accept or Decline. If the user accepts the agreement, then they 

will have access to WinRecs. However, if the user declines the agreement, they are immediately 

logged off the application.  

If there is a message in both the Regional and Hospital settings, then the Hospital Privacy 

Message will override the Regional Privacy Message. 
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Figure 4 - Privacy Message 

To configure  

o At the Regional Level: Enter text in the “Privacy Message” field in Regional Profile settings. 

The privacy message will be the same for all the Hospitals in that Region.  

o At the Hospital Level: Enter text in the “Privacy Message” field in Hospital Profile settings. 

The privacy message will only display for all the institution assigned to that specific hospital.   

 

Figure 5 - Configure Privacy Message 

1.2  WinRecs User Interface  

WinRecs uses the newest technology available to deliver a state of the art user interface, which 

allows users to tailor the display of individual tasks and user preferences. To provide this new 

feature, the concept of Dockable windows is used. Dockable windows and their management will 

be described in this section. The following section will describe the parts of the user interface; the 

menu items and toolbar actions. 
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Figure 6 - Main Screen 

1. The Menu Bar – The menu bar displays the menu items which include File, Preferences, 

View, Actions, Modules, Tool, Options, Maintenance and Help. 

2. The Toolbar – The toolbar provides single-click shortcuts to commonly used activities. 

3. WinRecs Module Menu – This Dockable Window provides access to the WinRecs 

modules. Only the module(s) licenced by the site’s institution will be listed. 

4. Main Window – This is the main part of WinRecs. It displays all currently opened 

abstracts. 

5. Message List – This Dockable window displays information messages from the system, 

hard errors and warnings for Canadian Institute for Health Information (CIHI) edits and 

user defined edits created using the Edit Engine module. 

6. Dockable Windows – This allows a user to customize what they would like to display from 

the options from the View menu bar.    

1.3 The Menu Bar 

 

Figure 7- Menu Bar 
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The menu bar provides access to all of the functions of WinRecs. Only the functions and modules 

licenced by the user’s institution will be available. 

The File Menu 

 

   

Figure 8 - The File Menu 

The File Menu provides access to core functions of WinRecs. The features included are: 

o WinRecs Version 3 Application Menu [CTRL + M] – Displays the WinRecs 

Module Menu. 

o Recent Records – Hovering will open a list of the l0 last records accessed. 

o Log Off – Logs the user off and returns to the Log In screen. 

o Exit – Exits the application.  When finished using WinRecs it is best practice to use Exit 

from the File Menu.   

o (Who) View Other Logged On Users – Opens the Other Logged In Users (Who) 

page, with the options to: 

o  ‘Clear My Dead Log In’ – Clears any log in that is not being used by the user 

o   ‘Log Off User’ – Allows the user to log off any other one user 

o  ‘Log Off All Users’ – Allows the user to log off all users 
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The Preferences Menu 

 

Figure 9 - The Preference Menu 

The Preferences Menu provides access to certain user preference settings in WinRecs. The 

features included are: 

o Select Hospital Link – A pop up display which allows users with regional access to 

select the preferred hospital link.   

o Show Edit Messages Window – Displays the Edit Messages Window, can press ‘Esc’ 

button to remove the message.   

o Show Quick Search – Displays the Quick Search Window. 

o Show Multiple User Access List – Displays the Multiple User Access List Window. 

o Font – Allows you to change the font size used to display the information in the modules, 

Grouper Window and Record Information window. 
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The View Menu 

 

Figure 10 - The View Menu 

The View Menu provides access to the view functions in WinRecs. It allows the user to view the 

windows that are not displayed. Selecting one of the View Menu items will open the selected 

window in the last location it was previously opened. 

o WinRecs Version 3 Application Menu [CTRL + M] – Displays the WinRecs 

Module Menu. 

o Record Information Elements – Displays the Record Information Element window. 

o Message List – Displays the Message List window. 

o Chart Information – Displays the Chart Information window. 

o Visit History – Displays the Visit History window. 

o Assessment Links – Displays the Clinical Modules assessment links 

o Chart Volume List – Displays the Chart Volume window. 

o Request History – Displays the Request History window. 

o Deficiency History – Displays the Deficiency History window. 

o Deficiency Detail List – Displays the Deficiency Detail List window. 

o Chart Deficiency – Displays the Chart Deficiency window. 
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o Grouper Calculator – Displays all grouper calculations pertaining to the accessed 

module. 

o Cancer Disease Registration – Displays the Cancer Disease Registration information 

o Chart Activity – Displays the Chart Activity 

o Field Audit History – Displays the Field Audit History window. 

o Record Update History – Displays the Record Update History window. 

o Interchange Update History - Displays the Interchange Update History window. 

o File Create History - Displays the File Create History window. 

o PDF File Viewer – Launches the window to open PDF files. 

The Actions Menu 

 

Figure 11 - The Actions Menu 

The Actions Menu provides access to all of the actions available in WinRecs. All of the action 

items are available on the Toolbar and via shortcut keys. The Toolbar and shortcut keys are 

described below. 

o Find [F4] – Opens the Record Search window. This window is context sensitive and will 

automatically select the appropriate module based on the currently selected module in 

WinRecs. 

o New [F5] – Creates a new record in the currently selected module. 

o Edit [F6] – Enables editing of the currently selected record.  

o Save [F7] – Saves the current record if there are unsaved changes. 

o Undo [F8] – Undoes any unsaved changes to the current record and returns it to the 

previously saved state. 

o Delete [F9] – Deletes the current record.  

o Verify [F11] – Verifies the current record for any errors or warnings. 

o Report Manager [F10] – Opens the Report Manager window.  
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The Modules Menu 

 

 

 

 

Figure 12 - The Modules Menu 
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The Modules Menu provides access to all the modules of WinRecs. Selecting an item from this 

menu will add a new tab in the Main window. It allows you to toggle between tabs in the Main 

window. 

 

The Tools Menu 

 

Figure 13 - The Tools Menu 

The Tools Menu provides access to the following functions: 

o File Management – Creates the CIHI submission, correction, deletion, institution and no 

separation files. 

o Batch Grouper – Running the Batch Grouper ensures that Grouper values are assigned to 

all records in a batch.  

o Batch Interface – Allows users to locate and run an existing batch interface. 

o Purge/Recover – Used to completely remove or restore deleted data. 

o Edits Management – Allows users to create their own user-defined data quality edits that 

are run at the time of validation with other CIHI-defined edits. 

o Abstract Profile – Creates the Abstract Profile for DAD/SDS/NACRS. 

o Database Update History – The area to run .wru patches 

o Schedule Report – The ability to attach reports to modules and set up report schedules. 

o Set View Permission – The ability to allow users access to the views or have Read-Only 

access. 

o Historical Data Import Utility – The ability to allow users access to Historical Data 

Import Utility (HDIU). 
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The Options Menu 

 

Figure 14 - The Options Menu 

The Options Menu provides access to the following functions: 

o User Profile – Maintains the users of the system and their privileges. 

o Control File - Used to specify default values for fields, change field names, restore 

fields to the main grid, make fields visible/invisible or enable/disable fields for each module. 

o Regional Profile – Maintains the regional profile of the system. 

o Hospital Profile – Maintains the hospital profile. 

o Institution Profile – Maintains the institution profile. 

The Maintenance Menu 

 

Figure 15 - The Maintenance Menu 

The Maintenance Menu provides access to the following functions: 

o Look Up Code Maintenance – Opens the Look Up Code Maintenance window.  

o Provider Maintenance – Opens the Provider Maintenance window to edit information for 

a facility’s physicians and other health providers. 

o Project Maintenance – Open the Project Maintenance window to add new projects or 

edit existing projects. 
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o Report Maintenance – Opens the Report Maintenance window to run and schedule 

Crystal Reports within WinRecs.     

o Auto Batch Interface Maintenance – Opens the Auto Batch Interface to run the 

batch in/out Interface.   

The Help Menu 

 

Figure 16 - The Help Menu 

The Help Menu provides access to the following functions: 

o View WinRecs Version 3 User Guide – Open the WinRecs User Guide (this 

document) in PDF format. 

o Download PDF Viewer – Downloads and installs the Adobe® Acrobat® Reader™. 

o About WinRecs Version 3 – Opens the About dialog box and displays the WinRecs 

application information and MED2020 contact information. 

o Licence Agreement – Opens the licence agreement window. 

 

1.4 The Toolbar 

 

The toolbar provides quick access to all of the actions that can be performed in WinRecs.  

Icon Menu Item Function Keyboard 

 
Module Menu Opens the WinRecs Module Menu [Ctrl+M] 

 
Find Search for a record [F4] 

 
New Creates a new record 

[F5] 

 
Edit Makes changes to a record.  

[F6] 
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Save Saves changes to the current record. 

[F7] 

 
Cancel 

Cancels changes made to record since the 

previous save.  Warning prompt will display. 

[F8] 

 
Delete Deletes a record and puts in the purge file 

[F9] 

 
Verify 

Verifies (edit checks) the current record, 

without saving the record.  This is applicable 

for abstracting modules. 

[F11] 

 
Print 

If applicable , this button displays a list of 

available reports to view on screen (or 

view/print). 

[F10] 

 
PDF viewer 

Opens the Windows Explorer folder allowing 

you to view PDF files stored on the PC or 

Server.  The path to the scanned patient 

records will be provided to you by your 

instructor.  

N/A 

 

Chart 

Maintenance 

Menu  

Allows quick access to Chart Maintenance 

Menu  

N/A 

 

Abstracting 

Menu  
Allows quick access to Abstracting menu  

N/A 

 

 

WinRecs 

Environment 

Colour  

Allows the user to assign specific colour to a 

WinRecs Session.  This is beneficial if user 

accesses more than one WinRecs 

environment. 

 

N/A 

 

Abstract 

Queue 
Allows the user to access the Abstract Queue 

 

N/A 

Table 3 - The Toolbar Icon 
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WinRecs Shortcuts Cheat Sheet 

Shortcut Action 

[F2] Opens the Lookup table for the selected field. 

[F3] Fields grid quick search; only available in modules. 

[F4] Opens the Find dialog box for the selected module or field. 

[F5] Creates a new record in the current module. 

[F6] Set the current record in edit mode. 

[F7] Saves the current record. 

[F8] Undoes any unsaved changes to the current record and returns it to the 
previously saved state. 

[F9] Deletes the current record. 

[F10] Report Manager 

[F11] Verifies the current record for any errors. 

[CTRL + M] Displays the WinRecs Module Menu. 

[ALT + F3] Opens the Notes Window 

[ESC] Closes popup messages 

[CTRL + C] Copies Fields that are enabled 

[CTRL + V] Pastes fields that have been copied 

Table 4 - WinRecs Shortcuts 

 

Figure 17 shows enabled fields have white background and disabled fields have grey 

backgrounds. 

 

 

Figure 17 - Fields 

In order to copy text from a disabled field, user can right click the field and selecting copy.  

 

Figure 18 - Copy Option 
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1.5 Dockable Windows 

 

WinRecs now allows moving, hiding, custom sizing, docking or undocking of certain windows. 

A Dockable window is a window that can exist in a floating state or be attached to the main 

application window. This feature allows the user to tailor the user interface to suit their particular 

needs. By being able to hide, dock or float some windows, the user can display only the 

information necessary to perform specific tasks. This section will explain how to manage the 

Dockable windows. 

The highlighted windows below - WinRecs Module Menu, Message List, Chart Information and 

Field Audit - are dockable. The dimmed portion, in the center of the figure, is the main abstracting 

area. This is where the module-specific windows will be added. 

 

Figure 19 - Dockable Windows 
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Dockable Window Parts  

A Dockable window has a title bar, control buttons and a display area. 

o Title Bar – Displays the name of the window. Can be used to drag the window or to 

make the window float or dock. How to interact with the title bar is described in detail in 

this section. 

o Control Buttons  

 

This button will switch the AutoHide feature. The Pin pointing down is 

displayed when AutoHide is disabled and the window is showing. The Pin 

pointing to the left indicates that AutoHide is enabled; the window automatically 

hides when the focus is on a different window. Interacting with the pin button is 

described in detail in this section. 

 
Clicking this button will close the window. Closed windows can be reopened via 

the View menu. Example: after closing the Visit History window it can be 

reopened by selecting View→Visit History. 

 Table 5 – Control Buttons 

o Display – This area displays the content of the window. Users can interact with it at all 

times; floating or docked. 

 

 

Figure 20 - Dockable Window Parts 
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Pin / AutoHide 

The following windows support Pin/AutoHide: WinRecs Module Menu, Record 

Information Elements, Message List, Chart Information, Visit History, Request History, 

Grouper Calculator, Field Audit History, Record Update History, Interchange Update 

History and File Create History. This feature allows a user to hide a window while being 

able to quickly consult the information displayed in it. This feature is only to show or hide 

the window; to change the location of the window see To turn off AutoHide 

o Click the window to keep visible and to give it focus. 

o Click the Pin icon on the title bar. 

AutoHide Disable  

When AutoHide is disabled the window will be visible, docked left, right, up or down. 

 

 

Figure 25 - Example of AutoHide 
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To dock a window. 

 

To turn on AutoHide 

o Click on the window needed to keep visible and to give it focus. 

o Right click the title bar to display the context menu, then click AutoHide. 

 

Figure 21 - Dock Context Menu (AutoHide) 

 

— or — 

 

o Click the Pin on the title bar of the window. 

AutoHide Enabled  

When an “AutoHidden” window loses focus it will automatically slide back to its edge, creating 

a tab with the name of the window. 

 

Close/Hide 

The following windows support Close / Hide: WinRecs Module Menu, Record Information 

Elements, Message List, Chart Information, Visit History, Request History, Grouper Calculator, 

Field Audit History, Record Update History, Interchange Update History and File Create History. 

This feature allows the user to hide a window that is not regularly needed. 

 

To close/hide a window 

o Click the window needed to keep visible and to give it focus. 

o Right click the title bar to display the context menu, then click Hide. 
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Figure 22 - Dock Context Menu (Hide) 

 

— or — 

 

o Click the  on the title bar of the window. 

 

To show a closed window 

o Open the View menu, then select the window to display. 

o If the window you select is already displayed no action will be performed 

o The window will be displayed at its last location. 

— or — 

o To show the WinRecs Module Menu press [CTRL + M] 

— or — 

o To show the WinRecs Module Menu press  on the Toolbar 
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Floating/Docking 

A floating window appears detached from the main screen and can be displayed outside of the 

boundary of WinRecs or on a different screen (when using a dual monitor workstation). 

 

To float a window 

o Click the window needed to keep visible and to give it focus. 

o Right click the title bar to display the context menu, then click Floating. 

 

Figure 23 - Dock Context Menu (Floating) 

— or — 

o Double click the title bar of the window to automatically make the window float. 

— or — 

o Click and drag the title bar to make the window float. Release the drag action when the 

window is in the desired position. 
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Figure 24 - Example of a Floating Window 

To turn off AutoHide 

o Click the window to keep visible and to give it focus. 

o Click the Pin icon on the title bar. 

AutoHide Disable  

When AutoHide is disabled the window will be visible, docked left, right, up or down. 
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Figure 25 - Example of AutoHide 
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To dock a window 

o Click the window needed to keep visible and to give it focus. 

o Right click the title bar to display the context menu, then click Dockable. 

 

Figure 26 - Dock Context Menu (Dockable) 

— or — 

o Double click the title bar of the window to automatically dock the window to its last docked 

position. 

— or — 

o Click and drag the title bar to make the dock controller appear. Drag the cursor over the dock 

controller to dock the window to the desired position. 

 

 

Docks to the top of the application. 

 

Docks to the right of the application. 

 

Docks to the bottom of the application. 

 

Docks to the left of the application. 

 

This control is displayed in the center of the application and allows you to 

dock the floating window to any location based on the selected control you 

drop the window on. 

 

This control is displayed in a docked window.  It allows you to create a 

group of window tabs, explained in  

Docked window group. 

Table 6 - Docking Controls 
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Example of docking controls 

 

Figure 27 - Example of the dock controls 
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Example of docking control for tabbed windows 

 

Figure 28 - Example of docking control for tabbed windows 

Docked window group 

Grouping docked windows in tabs allows the user to minimize the space used by the windows 
while giving the ability to quickly toggle between the windows. 
 
As seen in the figure below the Grouper and Visit History windows are grouped. 

 



 [T WinRecs Version 2025.01 User Guide 

© 2025 MED2020 Health Care Software Inc. All rights reserved. Page 32 

 

Figure 29 - Example of grouped docked windows 

 

To toggle between grouped docked windows 

o Click on the tab of the window the user wants to view. 
 

To group Dockable windows 

o Follow the instruction To turn off AutoHide 

o Click the window to keep visible and to give it focus. 

o Click the Pin icon on the title bar. 

AutoHide Disable  

When AutoHide is disabled the window will be visible, docked left, right, up or down. 
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Figure 25 - Example of AutoHide 
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o To dock a window and drop the window on the docking tab control  
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Resizing a window 

Windows can be resized, which allows the user to view more of the data needed to see to 

perform the tasks. Docked and floating windows can be resized. 

To resize a floating window with the mouse 

o Move your cursor to the edge of the window; the mouse pointer will switch to an adjustment 

icon. 

 

Figure 30 - Window resizing with the mouse pointer 

 

o When the mouse pointer icon is displayed as an adjustment icon, click and drag the edge of 

the window. 

o Release the drag motion when the window is the desired size. 
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To resize a floating window with the keyboard 

o Press [ALT + SPACEBAR] to display the window context menu. 

 

Figure 31 - Floating window context menu Click Size. 

— or — 

o Press [ALT + S]. 

— or — 

o Move the focus to Size using the keyboard arrows. 

 

Next: 

o Use the keyboard arrows to resize the window to the desired size. 

o When the window is the desired size, press [ENTER]. 
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To resize a docked window with the mouse 

Docked windows can only be resized with the mouse. 

o Move the cursor to the edge of the window; the mouse pointer will switch to an adjustment 

icon. 

 
For side docked windows 

 
For top and bottom docked windows 

Table 7 - Docked Window Cursors 

 

Figure 32 - Docked window cursors 

o When the mouse pointer icon is displayed as an adjustment icon, click and drag the edge of 

the window. 

o Release the mouse button when the window is the desired size. 
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Example of configuration 

This configuration allows for a maximum number of fields to be displayed while still providing 

access to the messages and Record Information Elements. The WinRecs Module Menu can be 

viewed by clicking the side tab or pressing [CTRL + M] or View → WinRecs Application Menu. 

The Visit History can also be consulted by clicking the side tab Visit History or by clicking View → 

Visit History. 

 

 

Figure 33 - Docking windows example 
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1.6 Grid Manipulation 

Grids are used in a lot of different areas of the application. For example, the result of the search 

feature is displayed in a grid and Look Up values are also displayed in a grid. Grids can be 

manipulated in a variety of ways; columns can be sorted, moved or their width can be modified. 

 

 

Sorting 

Most columns in grids can be sorted. When a column header is clicked the grid will be sorted 

based on the column clicked.  A sorted column will display an icon indicating that it’s sorted and 

the direction of the sort. 

 

 This icon is displayed on the header of a column when it’s sorted in ascending order. 

 

This icon is displayed on the header of a column when it’s sorted in descending order. 

 

Table 8 - Grid Manipulation Sorting Icons 

To sort a grid 

o Click on the column header 

 

Figure 34 - Sorting a grid 

  

The main abstracting area can NOT be manipulated like grids; 
it can, however, be tailored via the Control File. 
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o Clicking the UserDescription column header will initially sort the grid in ascending order by 

user description. 

 

Figure 35 - Grid sorted in ascending order 

 
o Clicking the UserDescription column again will sort the grid in descending order by user 

description. 

 

Figure 36 - Grid sorted in descending order 

o Clicking the UserDescription column again will return the grid to its original sort order. 
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Moving columns 

Most columns in the grid can be moved. This feature is particularly useful when you need to 

compare values from different columns and you need to view two columns side by side. 

To move a column 

o Click on a header and hold the mouse button down (to initiate the drag). 

o Move your mouse pointer to the left or right. 

o A blue marker line will appear between two (2) adjacent columns and this will be the new 

location of the column.  

o Release the mouse button when the marker line is located at the desired position. 

 

 

Figure 37 - Grid column moved 

In this example, the column ValidTo will be moved to the right of the CoderNumber column. 

  

The sequence of sort is ascending, descending and original. 
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Increasing / Decreasing Column Width 

On some occasions, the text displayed in a column is wider than the width of the column, 

preventing the user from viewing the complete data. In this case, the user can increase or 

decrease the width of the column.  

To increase or decrease the width of a column 

o Move the mouse pointer, slowly from over the grid header, until the mouse pointer changea 

to the column width adjustment cursor . 

o Click and hold the mouse button. 

o Move left or right; increasing the width of one column decreases the width of the 

neighbouring column. 

o Release the button when satisfied with the new widths. 

 

 

Figure 38 - Grid column adjustment 
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1.7 Grid Orientation 

Grids can be displayed vertically or horizontally; this feature is useful when changing the 

orientation of the window via the docking feature. 

The Grids in the following windows can be toggled: Grouper, Record Information 

Elements and Visit History.  

 
For example, in the figure below, the Grouper window is displayed while the grid is displayed 

horizontally, preventing the user from easily viewing all of the grouper information. This scenario 

will be used to describe the grid orientation feature. 

 

Grid orientation example 

 

Figure 39 - Grid orientation example 
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To toggle the grid orientation 

o Right click on any data on the grid- NOT the header - to display the context menu. 

 

Figure 40 - Grid orientation context menu 

o Click on the menu item. 

 

Grid orientation after toggling the view to vertical 

Using the vertical view for the Grouper window allows the user to view more information at once 

and to quickly scroll through the information. 

 

Figure 41 - Grid orientation after toggling the view to vertical 

A grid displayed horizontally will provide the Vertical View menu.  

A grid displayed vertically will provide the Horizontal View menu. 
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2.  WinRecs Options Menu 

The WinRecs Menu consists of the 5 features in the Options Menu:  Regional Profile, 

Hospital Profile, Institution Profile, User Profile, and Control File.  

2.1 Options Menu Use 

The following will be the options that are the same for Regional Profile, Hospital Profile, Institution 

Profile & User Profile.   

 

Figure 42 – Options Menu Layout 
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1. Tool bar 

Icon Description Shortcut Keys 

 

Search for existing Institutions [F4] 

 

Create a New Institution [F5] 

 

Enables editing of the currently selected record.  

[F6] 

 
Saves the current record if there are unsaved changes.  

[F7] 

 
Undoes any changes and returns the record to the previous state since the last 

save. 

 

[F8] 

 

Verifies the current record for any errors or warnings.   

[F11] 

Table 9 - User Profile Maintenance Toolbar 

2. Profile Options - Clicking on any of these options gives the administrator the option to 
choose or not choose it.   

3. Field Panel - Displays the field that can be modified for each of the options chosen. 
4. Interface Panel- Provides the option to add the Interface In value for the HL7 and 

Batch Interface fields.   
5. Mandatory Items – The items that are mandatory will display 
6. Update History – Displays the coder(s) who made changes in that field. 

To edit the current record 

o Click the  on the toolbar. 

— or — 

o Press [F6]. 

This will set the current record in edit mode, allowing the user to modify the values. 

To save the current record 

o Click the  on the toolbar. 

— or — 

o Press [F7]. 

This action will save the record and set it back to read only. 
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To undo the changes of the current record 

o Click the  on the toolbar. 

— or — 

o Press [F8]. 

This action returns all modified values to their last saved state. 

To access an existing entry 

o Click the  icon. 

— or — 

o Press [F4]  

o Double click on the Entry the user would like to view 

 

Figure 43 – Accessing an existing entry 

To create a New Entry 

o Click the  icon. 

— or — 

o Press [F5]  

 
 
 
 
 
 
 
 
 
 
 
 
 



 [T WinRecs Version 2025.01 User Guide 

© 2025 MED2020 Health Care Software Inc. All rights reserved. Page 48 

2.2 Regional Profile and Hospital Profile 

Regional Profile 

The Regional Profile is used to specify default values to be inherited by the individual Hospital 

Profiles.   

If a field is configured in the Regional Profile, it will be inherited by the Hospital Profile if the 

corresponding fields in the Hospital Profile are blank.  If the Hospital Profile field is populated it 

will override the Regional Profile settings.  Administrators can use this feature to manage 

multiple hospitals that use the same WinRecs database.    

If a Regional solution is not being used, then the Hospital Profile will be used.    

Hospital Profile 

The Hospital Profile is used to specify default values for hospitals.  The Hospital Profile contains 

the same fields as the Regional Profile.   

To access the Regional Profile 

o Select Options → Regional Profile. 

To access the Hospital Profile 

o Select Options → Hospital Profile. 
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WinRecs Options Regional Profile & Hospital Profile 

Look Up Values  

 

 

Figure 44 – Regional Profile/ Hospital Profile – Look Up Values Screen 

o Profile Links (Hospital Profile only) – Gives the user the ability to link the 

hospital to a region if there is more than one region in the database.   

o User Code – The code or number assigned to the Region or Hospital. 

o Validate Code – This code will populate with the User Code (Once the record is saved 

this field cannot be changed) 

o User Description – The description of the Region/Hospital (Once the record is saved this 

field cannot be changed) 

o Validate Description – This will populate with the default description 

o Look Up Note – Defines note text viewed when performing Look ups 

o Valid From - The date the region/hospital is valid from 

o Valid To – The date the region/hospital is valid to 

o Interface Out – Value used as region/hospital in interface populating out of WinRecs, 

populates with User Code. 

o Interface In – Value used as the region/hospital in Batch and HL7 Interfaces 

• To add a value press  
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• Add the Interface In value 

 

• Press  to save the entry 

•  to cancel the entry before saving 

•  to delete the entry after it is saved 

• used to edit an existing value 

 
  



 [T WinRecs Version 2025.01 User Guide 

© 2025 MED2020 Health Care Software Inc. All rights reserved. Page 51 

System-Wide Options 

 

 

Figure 45 – Regional Profile/ Hospital Profile – System-Wide Option Screen 

o Province Number – This is a drop down list of the provinces, choose the province the 

region or hospital belongs to 

o Paediatric Age - Defines the Paediatric Age for Pediatric Services.  The value may be 

defined by the specific institution or specified province and must be manually entered.  For 

example: ‘14’ defines Paediatric Age as patients 14 years old and under.  

o Chart Number Mask - Defines how to view chart numbers on the system - without the 

leading zeros, or with characters between the characters. Examples:  ########## (10 X #) 

will view a chart number without any leading zeros unless ‘0’ is part of the number.   E.g. 309.   

#####00000, will view the chart number 00309.  #####00-000 will view the chart number 00-

309.  #####000-00 will view the chart number 003-09. 

o Terminal Digit – Used to re-arrange the chart number in order to produce report sorted 

in a way that leads to randomized distribution.  If this field is configured, the value must be 10 

digits long using all digits between 0 and 9.  Each number represents the new position of the 

corresponding chart number.  For example:   

 

Chart Number Terminal Digit Mask Terminal Digit Value 

0000123456 9012345678 5600001234 
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o Lockdown Date - Defines the date records will be locked down and accessible in a ‘View’ 

mode only. For example, once all corrections are made for fiscal 2015 a lock down date of 

2016/04/01 the users will have read-only access to all data prior to this date (system 

mandatory). 

o Date Format – The date format the hospital or region would like displayed in WinRecs.  

The following options are: 

 

o Max # of Search Records to Return – Defines the maximum number of records to 

return in a search 

o Filter Non-Abstracted Visits From Visit History – Checking this will filter all 

non-abstracted visits from the Visit History, unchecking will keep all visits 

o Enable Search Audit – When checked, a record of all searches plus all abstracts 

appearing in searches is stored in the database. 

o Enable Report Audit – This is for the audit trail and has 3 levels: 

o N…None – Turn off Audit Report 

o B…who, what, when, where info of main and sub-reports – When a report is 

generated, the Audit Trail records the user running the report from WinRecs, 

records when the user logged on, when the report was run and the report path.   

o B…. Binary – (Basic plus binary image of main report) 

o Store Optimize Data – When checked the optimized data will be stored on the 

database.   

o Keep Batch Interface Audit (in weeks)– The date in weeks that Batch data will 

be kept anything after that date will be purged.   

o Keep HL7 Interface Audit (in weeks)– The date in weeks that HL7 data will be 

kept anything after that date will be purged.  

o Use Patient Service Worksheet – Enables the Transfer Worksheet in the [DAD] 

AbsCare Inpatient module 

o SMTP Server – Enter the mail server address here  

o SMTP Server Port – Enter the port if it is not a standard port 

o Email Sender – The email that indicates where the email is coming from  
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System Files and Folders 

 

Figure 46– Regional Profile/ Hospital Profile – System Files and Folders 

 

o Folio ICD 10 CA File – Pressing the  will bring up the browser folder to find the 

ICD-10-CA Folio file  

o Folio ICD 10 CCI File – Pressing the  will bring up the browser folder to find the 

ICD-10-CCI Folio file  

o Reports Folder – Pressing the will bring up the browser folder to find the Folder 

Reports are kept. 
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Module Options 

[CPI] Central Patient Index 

 

Figure 47 – Regional Profile/ Hospital Profile – Module Options/[CPI]Central 
Patient Index 

o Chart Numbers Can Be Re-Issued? – Checking this will allow the Region or Hospital to 

re-issue chart numbers to be used again.  Must be unchecked for the Un-Merge function to 

work.   

o Auto-Generate Chart No.? – If checked WinRecs uses the Start with Chart 

Number field to assign new chart numbers.   

o Unique Chart Number -  Used for regional set up to display the unique number shared 

among the different hospitals.   

o Start with Chart Number – This defines the starting point for chart number 

assignment.  The Start with Chart Number field will automatically increment as the 

number are used.   For example, the value 123 is entered, the next patient chart created that 

does not have a records will be assigned chart number 124.  If attempting to create a new 

chart number using a number other than the number outlined in the Start with Chart 

Number field, the program will try to assign the Start with Chart Number value.  Going 

back to the Chart Number field in the CPI before proceeding will ensure the chart number 

value is the appropriate one.   

o Fixed Chart Length – This field saves a zero filled version of the chart number to the 

database where the chart number is always the same length.  The value is pulled from the 

CPI and is saved with the chart not the visit.  Can be left blank.   
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[VOL] Chart Volumes  

 

Figure 48 – Regional Profile/ Hospital Profile – Module Options/[VOL]Chart 
Volumes 

o Unique Volume Number – A check mark indicates that all volume numbers must be 

unique.  

o Maintain Site Specific Chart Volumes – A check mark indicates that all chart 

volumes will be site specific.   

o # of Labels to queue before Print – Users who interface chart volumes can 

define the number of labels to print.   

o Batch Volume Printer – The path the labels are to print.  For example:  

\\medcorp2\SHARP_Copier  

o Volume Sort – The ability to sort how the volumes appear in the Chart Volumes module: 
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[LOC] Chart Locator 

 

o Pull List ID Format – Gives the site ability to sort the Pull List by: 

 

o Manual Default Return Location – When the box is checked and the Transaction 

Type is ‘R’, users are prompted to select the Return Location and more than one chart can be 

returned to that location.  When the box is unchecked, when the Transaction Type is ‘R’, it 

must be entered for each chart being returned.   
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[DEF] Chart Deficiency  

 

Figure 49 – Regional Profile/ Hospital Profile – Module Options/ [DEF]Chart 
Deficiency 

o Deficiency Add Days – This indicates when to start counting the day that the chart is 

deficient.  If the user does not want to count the day the deficiency is put in the Provider’s 

chart completion area, enter “1” in this field and the count will begin one day after the 

deficiency is entered.   

o Minimum Deficiency Count – The minimum number of deficiencies for a letter to be 

generated.   
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[ROI] Release of Information (See ROI documentation) 

 

Figure 50 – Regional Profile/ Hospital Profile – Module Options/ [ROI] Release of 
Information 

o GST Number – This number is used for billing purposes in the ROI module.   

o Tax Rate 1 – Used to enter the GST or PST for the ROI module 

o Tax Rate 2 – Used to enter the GST or PST for the ROI module 
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3-M CodeFinder Options – used to configure 3M Bridge – Contact MED2020 for further 

instructions.   

 

Figure 51 – Regional Profile/ Hospital Profile – Module Options/ 3-M CodeFinder 
Options 

o 3M CMD:  DAD – Used to configure 3M Bridge – Contact MED2020 regarding this field 

o 3M PAY:  DAD – Used to configure 3M Bridge – Contact MED2020 regarding this field 

o 3M CMD:  SDS – Used to configure 3M Bridge – Contact MED2020 regarding this field 

o 3M PAY:  SDS – Used to configure 3M Bridge – Contact MED2020 regarding this field 

o 3M CMD:  NACRS – Used to configure 3M Bridge – Contact MED2020 regarding this field 

o 3M PAY:  NACRS – Used to configure 3M Bridge – Contact MED2020 regarding this field 
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User Account Access 

 

Figure 52 – Regional Profile/ Hospital Profile – Module Options/ User Account 
Access 

o Allow Password Attempts – Enter the number of times a user can attempt to log in to 

WinRecs 

o Change Password Days – Enter the number of days till a user must change a password 

o Minimum Password Length – Enter a number for the minimum length the password must 

be. 

o Password Start with Alphabetic – If checked the password must start with a letter 

o Password Include Special Characters – If checked the password must include 

special characters 

o Password Include Lower-case – If checked the password must include lower case 

letters 

o Password Include Upper-case – If checked the password must include upper case 

letters 

o Password Not Match Previous Password – If checked the password must not match 

the previous password 

o Password Not Match Username – If checked the password must not match the WinRecs 

Username field 
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o Password Not Match First Name - If checked the password must not match the First 

Name field 

o Password Not Match Last Name – If checked the password must not match the Last 

Name field 

o Multiple User Access Save – Yes - will allow a user to save a record already 

accessed by another user.  No – able to open the record access by another user but unable 

to save, the chart will be Read-Only.   

o Show Multiple User Access List – Yes - will allow a user to see the list of users 

accessing the record, No – user will not see the list of users accessing the record.   

Privacy Message 

 

Figure 53 – Regional Profile/ Hospital Profile – Privacy Message 

 

 

o Privacy Message -  Enter text to be displayed or leave blank so no message is displayed 

• Press the Edit  or [F6]and type in message 

• Press the Save or [F7] to save 

• Press the Undo  or [F8] to undo any changes made since last saved.  
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2.3 Institution Profile 

The Institution Profile is where institution specific information is entered. More than one institution 

profile can be defined per hospital profile. 

To access the Institution Profile 

o Select Options → Institution Profile. 

WinRecs Options - Institution Profile 

Look Up  

 

Figure 54 – Institution Profile– Look Up Screen 

o Profile Links– The ability to link an institution to a region if there is more than one 

region in the database or to a specific hospital if there is more than one hospital 

o Institution/Facility Number - The Institution number  

o Validate Code – This number populates from the Institution/Facility Number (cannot 

change after saved) 

o User Description –The description of the Institution 

o Validate Description – Populates from the User Description (cannot change after 

saved) 
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o Care Type – Describes the type of Institution the facility is: 

 

o Look Up Note – Defines note used in [F2] lookup 

o Valid From - The date the Institution is valid from 

o Valid To - The date the Institution is valid to 

o Uses Mental Health Data – Determines at what level the Institution is collecting Mental 

Health Data: 

 

o Hospital Type – The type of Hospital 

o Institution Type – The type of Institution 

o Interface Out – Value used as region/hospital in interface populating out of WinRecs, 

populates with User Code. 

o Interface In – Value used as the region/hospital in Batch and HL7 Interfaces 

• To add a value press  

• Add the Interface In value 

 

• Press  to save the entry 

•  to cancel the entry before saving 

•  to delete the entry after it is saved 

• used to edit an existing value 
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Settings 

 

Figure 55 – Institution Profile–  Settings Screen 

o CIHI Site Number – distinguishes multiple sites of the same care type within a facility 

o Lock Down Date – Defines the date records will be locked down and accessible in a ‘View’ 

mode only. For example, once all corrections are made for fiscal 2015 a lock down date of 

2015/04/01 to have read-only access to all data prior to this date (system mandatory as 

shown on bottom of page).  Please note:  If you enter the date in Institution Profile 

it will override the Lock Down Date in the Hospital and/or Regional Profile.   

o New Chart Prefix – Defines the alpha prefix used when creating a new chart.  It can be 

used to limit user access as defined in User Profile.   

o Auto-Generate Encounter No? – Checking this box will have WinRecs automatically 

generate encounter numbers.   

o Start with Encounter Number – The starting number for the ‘Auto-Generate 

Encounter No?’ field and WinRecs will automatically increment as the numbers are used.  

If you try to create a new Encounter Number other than what is outlined in the ‘Start 

with Encounter Number’ field, WinRecs will still try to assign the value.   
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o Use Patient Service Worksheet - Enables the Transfer Worksheet in the [DAD] 

AbsCare Inpatient module.   

o Use CJRR Worksheet - Enables the CJRR worksheet in order to capture CJRR records 

in the Institution chosen (DAD or NACRS) 

o Enable Intervention Copy Button - Enables the Intervention Copy button found in 

the Intervention multiform in AbsCare Inpatient and NACRS modules.   

o Overlook CIHI Edits – Checking this box will allow the Institution to overlook the CIHI 

edits when abstracting.  Please contact CIHI if using this option.   

o Costs per RIW – The institution’s cost per resources intensity weight.   

 
File Path 

 

Figure 56 - Institution Profile – File Path 

 
o CIHI Directory – Defines the path for the CIHI Submission and CIHI Correction files.  

Press the  and then select the path where the submission files are stored.  Select the 
folder and click OK.  If this is left blank, the files and folders will default to the C:WR3 on the 
PC the user is on when running the files.   
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Submission 

 

Figure 57 – Institution Profile – Submission Screen 

 

o CIHI Batch Year – Can enter the current Batch Year for the institution 

o CIHI Batch Period – Can enter the current Batch Period for the institution 

o Region Year – Can enter the current Batch Year for the Region (if using) 

o Region Period – Can enter the current Batch Period for the Region (if using) 
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Basic Options 

 

Figure 58 – Institution Profile – Submission Screen 

Entering a Basic Option: 

1. Press the  or [F4] and select the institution from the Institution look up 

2. Press the  or [F6] to edit the Institution 

3. Press the Basic Option tab on the left-hand side 

 

o Basic Option 1 - 19 – Enter the name of the Basic Option in the desired Basic Option 

o Basic Option (1-19) State – Click on Drop Down Menu to choose the State 
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o CIHI Mandatory – Choose this if the Basic Option is mandated by CIHI and 

needs to be submitted 

o Disabled – Choose this option to no longer collect the Basic Option 

o Enabled – Choose this option to collect the Basic Option with no errors or 

warnings 

o Hospital Error – Choose this option to display an error if it is left blank 

o Hospital Required – Choose this option to not be able to save a record if it is 

left blank 

o Hospital Warning – Choose this option to display a warning if it is left blank 

 

Basic Option Look Up Values 

1. To add look up values for Basic Options go to Maintenance/ Look Up Code 

Maintenance 

2. On the left hand side go to Abstracting and choose the module the Basic Option is in 

3. Click on the Basic Option Box (1-19) – choose the corresponding number you entered in 

Institution Profile. 

o Press or [F5] to create a new entry.   

o Institution Number – will link to the Inst number the Basic option is located 

o User Display Code – the display code to be displayed in the abstract 

o Validation Code – will automatically populate the User Display Code, cannot 

change after saved 

o User Description – the description of the display code 

o Default Description – will default the user description, cannot change after 

saved 

o Look Up Note – enter any notes (optional) 

o Valid From – this will correspond with the discharge date or registration visit date 

and the value will start displaying at this time 

o Valid To – the date the value to stop being used 

o Interface Out – an optional field if the user would like the value to used in a 

Batch Out 

• Interface In – enter the interface in value if bringing in a value from the interface. 

• Press  or [F7] to save the record.  
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2.4 User Profile 

Any user wanting to access WinRecs must have a unique User Profile created.  The User Profile 

controls the access level to modules and assigning user ID and passwords.   

The profile is used to log entries and to track modifications to WinRecs patients and system 

records.   

To access the user profile 

o Select Options → User Profile. 

To create a new user 

o Press the   

— or — 

o Press [F5]. 

o A Search Results window will pop up with existing users 
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o Choose the user or Role ID you would like to base the User Profile by highlighting and double 

click or press ‘Select Record’

 

Figure 59 – Institution Profile – Submission Screen 

 

o Enter the required fields 

To search the user profile 

o Press [F4] or click on the  icon. 

The search screen opens to allow for a search of a user.  
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Figure 60 – User Profile Search Screen 

o Enter a user name or coder number in the User Profile Record Search box.  If there is 

only one match, the record will open in the User Profile window for editing.  If there is 

more than one match, the matching records will be presented in the Search Results 

window.   

o In the example below, the user has entered the search “me”. WinRecs has returned two 

matching user profiles. A User profile is selected by double-clicking on it, which opens it 

in the User Profile window for editing. 
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Figure 61 – User Profile Record Search 
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Role ID 

Links users to a common profile/template. When a user is linked to a Role ID, all User Profile and 
Control File settings will be identical to those of the Role ID User Profile it is linked to. This 
feature is used to maintain groups of users. If a change is made in the Role ID user profile, all 
users linked to the Role ID will have the same change.  
 

To use the Role ID: 

o Use the [F4] function key or  to call up the search window, choose the user you would 
like to assign the Role ID 

o In the Role ID field, press [F2] to select the user to be used as the Role ID 

 

Figure 62 – User Profile Role ID Search  

o Save the user profile.  

 
o All user permission fields for the User are now disabled. Additionally, this user will not be 

available in the Control File user list. 
 

Once a user is linked to another user’s setting (using the Role ID), individual profile 

settings cannot be modified until the Role ID is removed. 
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o All user permissions and Control File settings will be identical to the Role ID this 

profile is linked to.  
 

 

 

WinRecs Options - User profile 

Profile 

 

Figure 63 – User Profile – Profile Screen 

o Profile Links– The ability to link an institution to a region if there is more than one 

region in the database or to a specific hospital if there is more than one hospital 

Any time changes are made to the source Role ID (in the Users Profile or Control File), 

all users linked to the source profile will be affected. 

If a user wants to have most of the same settings as another user, but would like 

different settings such as a different sort of fields, link the user to the Role ID and 

save the record, then remove the Role ID and save again.  Now all of the settings will 

be identical, and now changes can be made to the profile.    
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o Role ID- Identifies the user account the user is linked to, please see Role ID  

o Is Administrator? – Check the box if the user has administrative privileges, allowing 

the user to view all other users in the profile and make changes.  If the box is not 

checked, the user can only view their own profile.   

o Sensitivity Level – There are 5 sensitivity levels in the drop down box to choose 

from: 

 

o Search Chart Prefix – The alphabetic prefix of the chart numbers the user can 

access.  If blank, the user can access all records in the database.  For example, if a site 

uses ‘M’ as their chart number prefix, and ‘M’ is typed in the Search Chart Prefix field, 

then the user will only see charts with a prefix of ‘M’.  This is useful for regions that are 

using a shared database.  

o Date Format – Click on the drop down menu to specify the date format used to display 

on abstracts:   

 

o Coder Number – The unique number assigned to each WinRecs user 

o CIHI Code Value – This is the value submitted to CIHI where applicable. This defaults 

to the coder number.  

o User Description – The custom description of the user. 

o Last Name – The Last Name of the user 

o Middle Name – The Middle Name of the user 

o First Name - The First Name of the user 

o Valid From – The date defining the start date of when the user is valid.  The user 

account cannot be used before this date.  (Mandatory) 

o Valid To – The date defining the end date of when the user is valid.  The user account 

can’t be used after this date.  (Mandatory) 

o User Name – The name used to log in to WinRecs.   

o User Password – The password used to log in to WinRecs, the value entered in the 

field is masked, see Password Setup  
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o Interface Out – Value used as region/hospital in interface populating out of WinRecs, 

populates with User Code. 

o Interface In – Value used as the region/hospital in Batch and HL7 Interfaces 

• To add a value press  

• Add the Interface In value 

 

• Press  to save the entry 

•  to cancel the entry before saving 

•  to delete the entry after it is saved 

• used to edit an existing value 

 

Settings/Options 

 

Figure 64 – User Profile – Settings/Options Screen 

o Show Quick Search – Checking this enables the Quick Search feature.  The Quick Search 

feature is available in Abstracting Modules.  After an abstract is saved, a Visit Date and Chart 

number search window will display.  The Window will display the previous visit date search.  

You can modify the date if required or you can modify the chart number.  This can be set in 

the Preferences Menu  
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o Show Edit Messages Window – Checking this creates a pop up message of all the error 

messages when the abstract is opened, validated or saved.   

o Show Multiple User Access List – Check this enables the Show Multiple User 

Message feature.  When a user accesses a record when another user is in it, a message 

displays.  “At least one other User is currently accessing this record’.    This can be set in the 

Preferences Menu.   

o Show Other Logged In Users (Who) - Allows access to a list of other users logged into 

WinRecs 

o View Deleted Records Search - This field gives rights to the user to be able to see 

visits that have been deleted.   In the search window there is a check box to 'View Deleted' 

records” 

o Font Size – Can set the font size for the user.  This can be set in the Preferences Menu.   

o Show All Regional Data – Users in a regional solution can be configured to have no 

access, read only or full access.  

o Use Grouper Data on Server – Allows the user to determine if the grouper runs local 

on the workstation or if the calculation is performed on the server. For users with less 

powerful workstations, setting the grouper to run on the server will decrease the amount of 

local resources required for WinRecs and may increase WinRecs speed. Users with more 

powerful workstations are recommended to set the grouper to calculate on the workstation. 
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Access Tools – Access to all modules in the Tools menu 

 

Figure 65 – User Profile – Access Tools Screen 

 

o Access File Management – The drop down displays an ‘Y’ or ‘N’ option, click ‘Y’ will give 

the user access to File Management under the Tools Menu. 

o Access Batch Grouper – The drop down displays an ‘Y’ or ‘N’ option, click ‘Y’ will give 

the user access to Batch Grouper under the Tools Menu. 

o Access Batch Interface – The drop down displays an ‘Y’ or ‘N’ option, click ‘Y’ will give 

the user access to Batch Interface under the Tools Menu. 

o Access Purge/Recover - The drop down displays an ‘Y’ or ‘N’ option, click ‘Y’ will give the 

user access to Purge Recover under the Tools Menu. 

o Access Edits Management - The drop down displays an ‘Y’ or ‘N’ option, click ‘Y’ will 

give the user access to Edits Management under the Tools Menu 

o Access Abstract Profile – This drop down displays an “Y’ or ‘N’ options, click ‘Y’ will 

give the user access to the Abstract Profile in the Tools Menu.   

o Access Database Update - This drop down displays an “Y’ or ‘N’ options, click ‘Y’ will 

give the user access to the Access Database Update History which is the tool used 

to run updates.   

o Access Historical Data Import - This drop down displays an “Y’ or ‘N’ options, click 

‘Y’ will give the user access to the Historical Data Import in the Tools Menu.  
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Access Options – all modules found under the Options menu 

  

Figure 66 - User Profile – Access Options Screen 

o Access User Profile - The drop down displays ‘No Access’ the user has no access to 

User Profile, ‘Read Only’ access where the user can only view the User Profile and 

‘Full’ the user can view and make changes to the User Profile.  The User Profile is 

under the Options menu. 

o Access Control File - The drop down displays ‘No Access’ the user has no access to 

Control File, ‘Read Only’ access where the user can only view the Control File and 

‘Full’ the user can view and make changes to the Control File.  The Control File is 

under the Options menu. 

o Access Regional Profile - The drop down displays ‘No Access’ the user has no 

access to Regional Profile, ‘Read Only’ access where the user can only view the 

Regional Profile and ‘Full’ the user can view and make changes to the Regional 

Profile.  The Regional Profile is under the Options menu. 

o Access Hospital Profile - The drop down displays ‘No Access’ the user has no 

access to Hospital Profile, ‘Read Only’ access where the user can only view the 

Hospital Profile and ‘Full’ the user can view and make changes to the Hospital 

Profile.  The Hospital Profile is under the Options menu. 

o Access Institution Profile - The drop down displays ‘No Access’ the user has no 

access to Institution Profile, ‘Read Only’ access where the user can only view the 

Institution Profile and ‘Full’ the user can view and make changes to the 

Institution Profile.  The Institution Profile is under the Options menu. 
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Access Maintenance 

 

Figure 67 – User Profile – Access Maintenance Screen 

o Access Look Up Maintenance - The drop down displays ‘No Access’ the user has no 

access to Look Up Maintenance, ‘Read Only’ access where the user can only view the 

Look Up Maintenance and ‘Full’ the user can view and make changes to the Look Up 

Maintenance.  The Look Up Maintenance is under the Maintenance menu. 

o Access Provider Maintenance- The drop down displays ‘No Access’ the user has no 

access to Provider Maintenance, ‘Read Only’ access where the user can only view the 

Provider Maintenance and ‘Full’ the user can view and make changes to the Provider 

Maintenance.  The Provider Maintenance is under the Maintenance menu. 

o Access Project Maintenance - The drop down displays ‘No Access’ the user has no 

access to Project Maintenance, ‘Read Only’ access where the user can only view the 

Project Maintenance and ‘Full’ the user can view and make changes to the Project 

Maintenance.  The Project Maintenance is under the Maintenance menu. 

o Access Update History- The drop down displays a ‘Y’ or ‘N’ option, click ‘Y’ will give the 

user access to Access Update History.  Access Update History is the Window 

Pane that displays Coder, Date and Time record was saved.     

o Access Scheduler Report – The drop down displays a ‘Y’ or ‘N’ option, clicking ‘Y’ will 

give user access to scheduled reports.  

 

 



 [T WinRecs Version 2025.01 User Guide 

© 2025 MED2020 Health Care Software Inc. All rights reserved. Page 81 

File/Folder Paths 

 

Figure 68 – User Profile – Folio/Folder Paths Screen  

o Folio ICD10 CA File – Allows user to launch FOLIO when on the Diagnosis Code 

field when in the Diagnosis Multiform.  Press on the  to open the File Directory to find 

the ICD10-CA File. 

o Folio ICD10 CCI File – Allows user to launch FOLIO when the on the Intervention 

Code field when in the Intervention Multiform.  Press on the to open the File Directory 

to find the ICD10 CCI file.   

 

 

 

 

 

See Section 5.15 Interfacing with Folio Views Code Basket 
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Module Settings 

[CPI] Central Patient Index 

 

Figure 69 – User Profile – Module Settings/[CPI] Central Patient Index screen 

o Select All – Checking this button will check all the buttons below. 

o Read – When checked allows the user read only access to the CPI module 

o New – When checked allows the user to create new abstracts in the CPI module 

o Edit – When checked allows the user to edit abstracts in the CPI module 

o Delete – When checked allows the user to delete abstracts in the CPI module 

o Purge – When checked allows the user to purge abstracts from the CPI module 

o Print – When checked allows the user to print in the CPI module 

o Modify Charts – Allows the user to the Modify Charts module in the CPI Chart 

Management feature 

o Show Chart Linkages – When checked it will display if a chart number is linked to 

another chart number.  The information pane will display Potential Duplicates or Chart 

Ancestry.  When not checked the Patient Visit History will display.   

o Set Chart Terminal Digit – When checked allows the user to use the Set Chart 

Terminal Digit Utility.   

o Clear CPI MODULE Lock – When checked allows the user to clear any CPI MODULE 

locks by going to CPI MODULE/Actions/Clear CPI MODULE Lock and this will allow an 

unmerge of records.   
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[VH] Visit History 

 

Figure 70 – User Profile – Module Settings/[VH] Visit History screen 

o Select All – Checking this button will check all the buttons below. 

o Read – When checked allows the user read only access to the Visit History module 

o New – When checked allows the user to create new abstracts in the Visit History module 

o Edit – When checked allows the user to edit abstracts in the Visit History module 

o Delete – When checked allows the user to delete abstracts in the Visit History module 

o Purge – When checked allows the user to purge abstracts from the Visit History module 

o Print – When checked allows the user to print in the Visit History module. 
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[LOC] Chart Locator 

 
 

Figure 71 – User Profile – Module Settings/[LOC] Chart Locator screen 

o Select All – Checking this button will check all the buttons below. 

o Read – When checked allows the user read only access to the Chart Locator module 

o New – When checked allows the user to create new abstracts in the Chart Locator module 

o Edit – When checked allows the user to edit abstracts in the Chart Locator module 

o Delete – When checked allows the user to delete abstracts in the Chart Locator module 

o Purge – When checked allows the user to purge abstracts from the Chart Locator module 

o Print – When checked allows the user to print in the Chart Locator module 

o Abstracts Prompt – When checked when an abstract is saved, a prompt will display 

asking you to go to Chart Locator, selecting Yes will take you to the Chart Locator module.  
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[DEF] Chart Deficiency 

 

Figure 72 – User Profile – Module Settings/[DEF] Chart Deficiency screen 

o Select All – Checking this button will check all the buttons below. 

o Read – When checked allows the user read only access to the Chart Deficiency module 

o New – When checked allows the user to create new abstracts in the Chart Deficiency 

module 

o Edit – When checked allows the user to edit abstracts in the Chart Deficiency module 

o Delete – When checked allows the user to delete abstracts in the Chart Deficiency module 

o Purge – When checked allows the user to purge abstracts from the Chart Deficiency 

module 

o Print – When checked allows the user to print in the Chart Deficiency module 

o Abstracts Prompt – When checked when an abstract is saved, a prompt will display 

asking you to go to Chart Deficiency, selecting Yes will take you to the Chart Deficiency 

module.  
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[ROI] Release of Information 

 

Figure 73 – User Profile – Module Settings/[ROI] Release of Information screen 

o Select All – Checking this button will check all the buttons below. 

o Read – When checked allows the user read only access to the Release of Information 

module 

o New – When checked allows the user to create new abstracts in the Release of Information 

module 

o Edit – When checked allows the user to edit abstracts in the Release of Information 

module 

o Delete – When checked allows the user to delete abstracts in the Release of Information 

module 

o Purge – When checked allows the user to purge abstracts from the Release of Information 

module 

o Print – When checked allows the user to print in the Release of Information module 
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[CCR] DAD Concurrent Review 

 

Figure 74 – User Profile – Module Settings/ [CCR] DAD Concurrent Review 
screen 

o Select All – Checking this button will check all the buttons below. 

o Read – When checked allows the user read only access to the DAD Concurrent Review 

module 

o New – When checked allows the user to create new abstracts in the DAD Concurrent 

Review module 

o Edit – When checked allows the user to edit abstracts in the DAD Concurrent Review 

module 

o Delete – When checked allows the user to delete abstracts in the DAD Concurrent Review 

module 

o Purge – When checked allows the user to purge abstracts from the DAD Concurrent 

Review module 

o Print – When checked allows the user to print in the DAD Concurrent Review module 
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[DAD] AbsCare Inpatient 

 

Figure 75 – User Profile – Module Settings/ [DAD] AbsCare Inpatient screen 

o Select All – Checking this button will check all the buttons below. 

o Read – When checked allows the user read only access to the AbsCare Inpatient module 

o New – When checked allows the user to create new abstracts in the AbsCare Inpatient 

module 

o Edit – When checked allows the user to edit abstracts in the AbsCare Inpatient module 

o Delete – When checked allows the user to delete abstracts in the AbsCare Inpatient 

module 

o Purge – When checked allows the user to purge abstracts from the AbsCare Inpatient 

module 

o Print – When checked allows the user to print in the AbsCare Inpatient module.  

o Create Submit File – When checked allows the user to create a CIHI Submission File 

o Create Correction File- When checked allows the user to create a CIHI Correction 

File 

o Load Record Profile – Allows the user access to the Copy Abstract Profile in 

AbsCare Inpatient module. 

o Load Record Clone – Allows the user access to the Clone Abstract routine in 

AbsCare Inpatient module.   

o Auto-calculate Grouper – When checked allows the grouper to automatically calculate 

values when relevant grouper data is provided for that user.  
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o Show Complete Message – When checked, if there are no hard (red) errors, a message 

displays after each abstract prompting if the abstract is complete.  ‘Y’ or ‘N’ is used to 

respond to the prompt.    

o Create DAD Institution File – When checked allows the user to create a DAD 

Institution File 

o Create DAD Separation File – When checked allows the user to create a DAD 

Separation File.   

o Import DAD CIHI Error File – When checked allows the user to use the Import CIHI 

Error File  
 
 

[SDS] AbsCare Day Surgery 

 

Figure 76 – User Profile – Module Settings/ [SDS] AbsCare Day Surgery screen 

o Select All – Checking this button will check all the buttons below. 

o Read – When checked allows the user read only access to the AbsCare Day Surgery 

module 

o New – When checked allows the user to create new abstracts in the AbsCare Day Surgery 

module 

o Edit – When checked allows the user to edit abstracts in the AbsCare Day Surgery 

module 

o Delete – When checked allows the user to delete abstracts in the AbsCare Day Surgery 

module 

o Purge – When checked allows the user to purge abstracts from the AbsCare Day Surgery 

module 
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o Print – When checked allows the user to print in AbsCare Day Surgery module 

o Create Submit File – When checked allows the user to create a CIHI Submission File 

o Create Correction File- When checked allows the user to create a CIHI Correction 

File 

o Load Record Profile – Allow the user access to the Copy Abstract Profile in 

AbsCare Day Surgery module. 

o Load Record Clone – Allows the user access to the Clone Abstract routine in 

AbsCare Day Surgery module.   

o Auto-calculate Grouper – When checked allows the grouper to automatically calculate 

values when relevant grouper data is provided for that user.  

o Show Complete Message – When checked, if there are no hard (red) errors, a message 

displays after each abstract prompting if the abstract is complete.  ‘Y’ or ‘N’ is used to 

respond to the prompt.    

 

[NACRS] AmCare Ambulatory All Levels 

 

Figure 77 – User Profile – Module Settings/ [NACRS] AmCare Ambulatory All 
Levels 

o Select All – Checking this button will check all the buttons below. 

o Read – When checked allows the user read only access to the AmCare Ambulatory module 

o New – When checked allows the user to create new abstracts in the AmCare Ambulatory 

module 
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o Edit – When checked allows the user to edit abstracts in the AmCare Ambulatory module 

o Delete – When checked allows the user to delete abstracts in the AmCare Ambulatory 

module 

o Purge – When checked allows the user to purge abstracts from the AmCare Ambulatory 

module 

o Print – When checked allows the user to print from the AmCare Ambulatory module 

o Create Submit File – When checked allows the user to create a CIHI Submission File 

for AmCare Ambulatory module 

o Create Correction File- When checked allows the user to create a CIHI Correction 

File for Amcare Ambulatory module 

o Load Record Profile – Allow the user access to the Copy Abstract Profile in 

Amcare Ambulatory module 

o Load Record Clone – Allows the user access to the Clone Abstract routine in Amcare 

Ambulatory module 

o Auto-calculate Grouper – When checked allows the grouper to automatically calculate 

values when relevant grouper data is provided for that user.  

o Show Complete Message – When checked, if there are no hard (red) errors, a message 

displays after each abstract prompting if the abstract is complete.  ‘Y’ or ‘N’ is used to 

respond to the prompt.   

o Create NACRS Facility File – When checked allows the user to create a NACRS 

Facility File 

o Re-Set Submission – When checked allows the user to Re-Set Submissions in the 

NACRS Abstract under File Settings→Re-Set File Create Status 

o Set File Correction – Gives the user different options on how to set NACRS Level 1 

corrections. 

• A -  Automatic – Automatically set the correction status as needed 

• M – Manual – Correction status will not be set; you will need to set it manually in the 

actions menu 

• P – Prompt – A prompt will appear asking to set the correction status.   
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[CJRR] Canadian Joint Replacement Registry 

 

Figure 78 – User Profile – Module Settings/ [CJRR] Canadian Joint Replacement 
Registry 

o Select All – Checking this button will check all the buttons below. 

o Read – When checked allows the user read only access to the CJRR module 

o New – When checked allows the user to create new abstracts in the CJRR module 

o Edit – When checked allows the user to edit abstracts in the CJRR module 

o Delete – When checked allows the user to delete abstracts in the CJRR module 

o Purge – When checked allows the user to purge abstracts from the CJRR module 

o Print - When checked allows the user to use the print feature in the CJRR module 

o Create Submit File – When checked allows the user to create a CJRR CIHI Submission 

File 

o Load Record Profile – Allow the user access to the Copy Abstract Profile in the 

CJRR module 

o Load Record Clone – Allows the user access to the Clone Abstract routine in CJRR 

module 

o Show Complete Message – When checked, if there are no hard (red) errors, a message 

displays after each abstract prompting if the abstract is complete.  ‘Y’ or ‘N’ is used to 

respond to the prompt.   
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o Re-Set Submissions – When checked allows the user to Re-Set Submissions in the 

CJRR Abstract → File Settings → Re-set File Create Status 

 

[MDS] Continuing Care Reporting System 

 

Figure 79 – User Profile – Module Settings/ [MDS] Continuing Care Reporting 
System 

o Select All – Checking this button will check all the buttons below. 

o Read – When checked allows the user read only access to the MDS module 

o New – When checked allows the user to create new abstracts in the MDS module 

o Edit – When checked allows the user to edit abstracts in the MDS module 

o Delete – When checked allows the user to delete abstracts in the MDS module 

o Purge – When checked allows the user to purge abstracts from the MDS module 

o Print - When checked allows the user to use the print feature in the MDS module 

o Create Submit File – When checked allows the user to create a MDS CIHI Submission 

File 
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o Create Correction File – When checked allows the user to create a MDS CIHI 

Correction File 

o Show Complete Message – When checked, if there are no hard (red) errors, a message 

displays after each abstract prompting if the abstract is complete.  ‘Y’ or ‘N’ is used to 

respond to the prompt.   

o Re-Set Submissions – When checked allows the user to Re-Set Submissions in the MDS 

Abstract → File Settings → Re-set File Create Status 

[NRS] National Rehabilitation Reporting System 

 

Figure 80 – User Profile – Module Settings/ NRS  

o Select All – Checking this button will check all the buttons below. 

o Read – When checked allows the user read only access to the NRS module 

o New – When checked allows the user to create new abstracts in the NRS module 

o Edit – When checked allows the user to edit abstracts in the NRS module 

o Delete – When checked allows the user to delete abstracts in the NRS module 

o Purge – When checked allows the user to purge abstracts from the NRS module 

o Print - When checked allows the user to use the print feature in the NRS module 
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o Create Submit File – When checked allows the user to create a NRS CIHI Submission 

File 

o Create Correction File – When checked allows the user to create a NRS CIHI 

Correction File 

o Show Complete Message – When checked, if there are no hard (red) errors, a message 

displays after each abstract prompting if the abstract is complete.  ‘Y’ or ‘N’ is used to 

respond to the prompt.   

o Re-Set Submissions – When checked allows the user to Re-Set Submissions in the NRS 

Abstract → File Settings → Re-set File Create Status 

o Use Interim Assessment – When checked allows the user to use the Interim 

Assessments 

o Use Post Discharge Assessment – When checked allows the user Use Post Discharge 

Assessments.   

 

 

[OMHRS] Ontario Mental Health Reporting System 

o Re-Set Submissions – When checked allows the user to Re-Set Submissions in the NRS 

Abstract → File Settings → Re-set File Create Status 

 

Figure 81 – User Profile – Module Settings/ OMHRS 
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o Select All – Checking this button will check all the buttons below. 

o Read – When checked allows the user read only access to the OMHRS module 

o New – When checked allows the user to create new abstracts in the OMHRS module 

o Edit – When checked allows the user to edit abstracts in the OMHRS module 

o Delete – When checked allows the user to delete abstracts in the OMHRS module 

o Purge – When checked allows the user to purge abstracts from the OMHRS module 

o Print - When checked allows the user to use the print feature in the OMHRS module 

o Create Submit File – When checked allows the user to create an OMHRS CIHI 

Submission File 

o Create Correction File – When checked allows the user to create an OMHRS CIHI 

Correction File 

o Show Complete Message – When checked, if there are no hard (red) errors, a message 

displays after each abstract prompting if the abstract is complete.  ‘Y’ or ‘N’ is used to 

respond to the prompt.   

o Re-Set Submissions– When checked allows the user to Re-Set Submissions in the 

OMHRS Abstract → File Settings → Re-set File Create Status 
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[IRRS] Integrated interRAI Reporting System 

 

Figure 82 – User Profile – Module Settings/ [IRRS] 

o Select All – Checking this button will check all the buttons below. 

o Read – When checked allows the user read only access to the OMHRS module 

o New – When checked allows the user to create new abstracts in the OMHRS module 

o Edit – When checked allows the user to edit abstracts in the OMHRS module 

o Delete – When checked allows the user to delete abstracts in the OMHRS module 

o Purge – When checked allows the user to purge abstracts from the OMHRS module 

o Print - When checked allows the user to use the print feature in the OMHRS module 



 [T WinRecs Version 2025.01 User Guide 

© 2025 MED2020 Health Care Software Inc. All rights reserved. Page 98 

o Show Submit Message – When checked displays the message ‘Is this record ready to 

send for submission?’ giving the user a ‘Yes’ or ‘No’ option.  Not checking the message will 

not display the assessment will not submit.   

o Show Correction Message – When checked displays the message for Corrections or for 

Correction/Updates depending on the fields being corrected or updated.  

o Show Complete Message – When checked, if there are no hard (red) errors, a message 

displays after each abstract prompting if the abstract is complete.  ‘Y’ or ‘N’ is used to 

respond to the prompt.   

o Use IRRS Service Viewer – When checked, will give the user access to the ‘IRRS 

Submit Viewer’ which displays all the PASS and FAIL transactions that have been submitted 

to CIHI. 

o Re-Set Submit/Correct – Not applicable for IRRS 

o Use Discharge Assessment – When checked, gives the user access to Discharge 

Assessments 

o Use Tracking Assessment – When checked, gives the user access to the Discharge 

Tracking Assessments 

o Use Referral Assessment – When checked, gives the user access to the Referral 

Assessment 

o Edit Historical (no edits) – Not applicable for IRRS 

o Set File Correction – Not applicable for IRRS 

2.5 Control File 

The Control File is used to specify default values for fields, change field name, restore fields on 

the main grid, make fields visible/invisible or enable/disable for each module.   

 

 

To access the Control File 

Select Options → Control File 

If a user does not have administrative rights, the user can only modify their own 

settings.  If a user is linked to a Role ID in the User Profile, the user will not be able to 

change the Control File settings.   
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Figure 83 – Control File Screen Options 

1. Control File Options – Displays the list of modules  

2. Toolbar  

       

Toolbar items with functionality and short cut keys listed. 

Icon    Menu Item Function Keyboard 

 
         Find  Search for an existing profile 

[F4] 

 

Copy Copy a profile 
[F5] 

 
Save Saves changes to the current profile [F7] 

 
Cancel Cancels changes made  [F8] 

 
Reports 

If applicable this button displays a list of 

available reports to view 
[F10] 

 

Multiple 

Occurrence 

Fields 

Apply settings, change sort order to each of the 
fields in the multiform 

N/A 
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Group 

Headers 
Apply settings for each Field Group N/A 

 

Search Fields 

List 
Apply the fields to display in the Search 
Results for each module.   

N/A 

 

Record 

Information 

Fields List 

Apply the fields that display in the Record 
Information Elements window. 

N/A 

Table 10 - Control File Toolbar 

 

3. Select Field Group – The fields in the main grid within WinRecs are grouped together.  The 
drop down menu provides the Group Header.   

4. Fields – The list of the fields that are within the selected module.   
5. Field Group -  The fields that are within the group chosen in the Select Field Group 
6. Settings Options – The settings option for each group/field: 

• Header – the name of the field,  the name of a field can be changed to reflect 

terminology a site may use.   

• Status – the drop down allows the assignment of the following options: 

▪ Not Set – there is no status assigned to the field 
▪ Hospital Required – the abstract will not save if the field is blank 
▪ Hospital Error – the field will generate an error if left blank  
▪ Hospital Warning – the field will generate a warning if left blank 

• Enabled -  when checked the field is accessible in the abstract, not checked the field will 

be greyed out and not accessible. 

• Visible – when checked the field can be viewed in the abstract, not checked the field 

will be not show in the abstract 

• Default – can enter a default value for the field. If there are set values can select  the 

value from a drop down list or press [F2] and a searching window for the field will popup.  

• Save All – this function allows the field to be saved on all users and profiles.   

7. Update History– Display the details of whom made changes to the item selected from the 
control file options section.  The coder name and the date and time the changes were made 
will be listed 

Find  

The first step to accessing fields the Control File is to select a User or Role ID.  When editing the 

Role ID all users linked to the Role ID will have the same Control File settings.   

o Press [F4] or click on the  icon. 

o Double click the User  
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Figure 84 – Control File Search Screen 

Copy  

Copy is a function that allows another users module settings to the copied to another users 

account. 

When working on a user account select the module that needs to be copied.  

Press the Copy Button  and the following message will display: 

 

 

Figure 85 - Control File Message for Copying a User Account 

o Selecting ‘Yes’ will bring up the Search Results window with the list of users and Role ID’s 

that can be copied.   

o Select the user account that needs to be copied. Once complete the user will be back to the 

main Control File screen with all the changes applied.   
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Choosing Modules 

Once the user has been selected, the modules that the user has access to will be displayed on 

the left-hand side.  Click on the module that needs to be modified.  Once the module has been 

selected the fields will be displayed and the Select Field Group drop down will now have options 

available to select from.  

 

Figure 86 - Control File Options 

Field List 

This gives the user the ability to adjust the fields within the main grid of the abstract.   
o Click on the module that contains the field that needs to be adjusted. 
o The list of fields available for that module will appear on the Fields List panel.   
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Figure 87 - Field List 

 
o Any fields that are highlighted grey are Visible but not Enabled.   

 

Figure 88 – Visible but Not Enabled 

 
o Any fields highlighted grey and the font is grey are not Visible and may or may not be 

Enabled.   

 

Figure 89 – Not Visible, May or May not be Enabled. 

 

o Some fields maybe highlighted grey and are only made visible. If a field cannot be enabled, it 
could be the field is a calculated field or a field cannot be changed.   
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Figure 90 – Calculated Fields 

o To modify a field, select the field and click the check mark button. 
o The Select Field Group dropdown will fill in and populate the Field Group with all the fields 

contained within the Group.   
o The Settings Options area will also display the options for the field selected.  See Setting 

Options

 

Figure 91 - Field List Selection 

 
 
 

o To make changes to a different field in a different field group, there are 2 options: 
▪ Navigate to the field listed under the Fields list and use the check mark button to 

populate the Settings Options.  
▪ Use the Select Field Group drop down to select the group header that the field 

belongs and click the field title. 
 

Moving Fields  

The Control File has the ability to move fields into different Field Groups. 
 

o Click on the field in the Field list.   
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o In Select Field Group select the field group to move the field to.   

o Click on the arrow button  between the Field List and Field Group or double click 
on the field and it will move the Field Group 
▪ For example: Moving the field ‘Maternal/Newborn Chart Number’ from the 

‘Submission Control Data Elements’ field group to ‘Patient/Client Demographics 
Information’ 

▪ In the Select Field Group click on the drop down menu and click on ‘Patient/Client 
Demographics Information’ 

o In the Field List Click on ‘Maternal/Newborn Chart Number’ so it is highlighted yellow and 

press the  or double click the field and it will move to the ‘Patient/Client Demographics 
Information’ group 

 

Figure 92 – Moving Fields to New Field Group 

 
 

o To move a field back to it’s original Field Group 
▪ Click on the field in the Field List 
▪ In Select Field Group choose the group the field was in 
▪ Press the arrow button to move 

 
 

o To move the field up or down, click on the field in the Field Group list 

▪ Click on the up and down arrows  to move the field up or down.  

Save  

To save the changes for a user select the save button  or press F7.   
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To save the changes for all users in the system select the Save all button . 

Cancel 

To cancel any changes made press the  or press F8. 

 

Multiple Occurrence Fields 

This options allows the ability to adjust the fields within the multi-forms of the abstract.  

o Click on the Multiple Occurrence Fields button.   A pop up screen will display: 

 

 

Figure 93 – Control File Multiple Field Entry List 

o Click down on the ‘Select Field Group’ and choose the multiform that needs adjusting, the 

list of fields for the selected multiform will populate on the left panel.   The first field will be 

highlighted by default. 

o To move the field up or down, click on the field to be moved 

▪ Click on the up and down arrows  to move the field up or down.  
o The settings options can also be set for the fields .  See Setting Options 
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Figure 94 - Control File Multiple Field Entry List Specific 

Group Headers 

The Control File has the ability to adjust the setting for a whole section within the Abstract.   

To adjust the setting of a section: 

o Click on the Group Header icon .  A pop up screen will display 

o The list of Field Group Headers for that module and the Setting Options will display.  Please 

note that the Status is not accessible.  In the example below, the [DAD] AbsCare Inpatient 

module has been selected therefore the list of headers show in the popup window apply to 

that module.   

o On this window the Header can be edited.  

 

Figure 95 – Control File Group Header Screen 
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o If the Enabled and Visible were unchecked, this whole section would not appear in the 

abstract and the group would be highlighted grey and the font would be grey 

 

Figure 96 – Enabled and Visible Unchecked 

o If the Enabled was unchecked and the Visible was checked, the whole section would appear 

in the abstract but the user would not be able to enter into the fields in that section

 

Figure 97 – Enabled Unchecked and Visible Checked 

o To move the field up or down, click on the group to be moved 

▪ Click on the up and down arrows  to move the field up or down 
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Search Fields List 

The Search Fields List is where the settings and configuration of the Search Results window are 

configured for each module. The fields and order in which the fields are to be displayed on the 

Search Results window can be configured here for each user.  

o After selecting a user and the module that needs to be modified click the Search Field List 

icon    

 

 

Figure 98 - Control File Search Fields List 

 

o The first column list of fields for the selected module in the first column (all fields including 

multiform) 

o The second column lists all the fields already selected to show in the Search Results window 

and the order they will be displayed. 

o The third column lists who and the date the Search Fields list had been modified 

o To add a field to the Search Results window, click on the field that needs to be added and 

click the add button  

o To remove a field from the Search Results window, click on the field that needs to be 

removed and click the remove button  

o To rearrange the order of the fields, select a field to be moved and click the appropriate arrow 

to move the field up  or down  
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Record Information Fields List 

This allows the user to select the fields to be displayed in the Record Information Elements 

screen.   

 

Figure 99 - Control File Record Information Fields List 

o The first column contains all the fields from the main grid and multi-forms, 

o The second column contains the fields shown in the Record Information Elements.  

o The third column lists who and the date the Record Information Fields list had been modified 

o To add a field to the Record Information Elements window, click on the field that needs to be 

added and click the add button  

o To remove a field from the Record Information Elements window, click on the field that needs 

to be removed and click the remove button  

o To rearrange the order of the fields, select a field to be moved and click the appropriate arrow 

to move the field up  or down  

User Defined Fields 

WinRecs provides 6 User Defined Fields (UD) and 25 of each.  These fields are found in all 

modules as follows: 

• User Date Fields (1-25) 

• User Time Fields (1-25) 

• User Note Fields (1-25) 

• User Look Up Fields (1-25) 

• User Text Fields (1-25) 

• User Numeric Fields (1-25) 

These fields are set up in the Control File and can be found at the end of the of all fields in the 

main grid or can be found by selecting the Select Field Group drop down menu.  User Defined 

Fields can be moved to other areas on the main grid, but cannot be included in multi-forms.   



 [T WinRecs Version 2025.01 User Guide 

© 2025 MED2020 Health Care Software Inc. All rights reserved. Page 111 

 

Figure 100 – User Defined Fields 

o On the right hand side fill in the following: 

• Header – This is the name of the user field 

• Status – the drop down allows the user to assign the following options: 

▪ Not Set – there is not status assigned to the field 
▪ Hospital Required – the abstract will not be able to be saved if the field is 

blank 
▪ Hospital Error – the field will generate an error if left blank  
▪ Hospital Warning – the field will generate a warning if left blank 

• Enabled -  when checked the user will be able to access the field in the abstract, not 

checked the user will not be able to access the field 

• Visible – when checked the user will be able to view the field in the abstract, not 

checked the user will not be able to view the field 

• Default Value – allows the user to default values into a field 

o User Look Up fields will require the user to create the Look Up Values in Look Up Code 

Maintenance.   
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3.  WinRecs Maintenance Menu 

The WinRecs Maintenance Menu consist of three modules:  Look Up Code Maintenance, 

Provider Maintenance, and Project Maintenance. 

3.1 Look Up Code Maintenance 

This feature is used to maintain the lookup tables.  These tables contain values defined by CIHI, 

other provincial authorities or specific values used by the facility.  In any WinRecs module, [F2] 

will access the look ups for any field that has an associated look up table.   

To access the Look Up Code Maintenance screen 

o Select Maintenance → Look Up Code Maintenance 

 

Figure 101 – Look Up Code Maintenance Screen 

1. Look Up Code Maintenance Modules - Click on the Look up Table that needs adjusting.  

There are 3 main sections of the Look Up Code Maintenance 

o General Maintenance – These are the look up tables that are similar in all WinRecs 

Modules 

o Chart Maintenance – These are specific look up tables that are found in the specific 

Chart Maintenance Modules 

o Abstracting – There are specific look up tables that are found in the specific 

Abstracting modules.   

2. Toolbar – see Toolbar  

3. Code Values  
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o Profile Links– The ability to link a look up code to a region if there is more than one 

region in the database or link to a hospital if there is more than hospital. (Optional) 

Leaving it blank will show for all hospitals.  

o User Display Code – The displayed value for the look up field 

o Validation Code – The displayed value for the look up field 

o User Description – The description of the code 

o Default Description – The default description of the code (same as user 

description) 

o Look Up Note – Additional description of the value if needed  

o Valid From – The date the code is valid from 

o Valid To – The date the code is valid to 

o Interface Out – Value used as region/hospital in interface populating out of 

WinRecs, populates with User Code. 

o Interface Out – Value used as region/hospital in interfaces populating out of 

WinRecs, populate with the User Code. 

4.  Interface In – add the interface in values from your Batch and HL7 interfaces. 

5. Update History – Displays the user(s) that made changes to the look up value.   

To add a new code 

1. Select, by clicking the desired code group in the Code List panel on the left hand side. 

2. Click the  on the toolbar. 

— or —  

3. Press [F5]. 

4. Enter all of the required fields in the code editing panel on the right hand side. 

5. Click the   on the toolbar to save the new record. 

— or —  

6. Press [F7]. 

 

To edit an existing code 

1. Select, by clicking the desired code group in the Code List panel (1). 

2. Click the  on the toolbar to display the search code screen. 

— or —  

3. Press [F4] to display the search code screen. 
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Figure 102 - Look Up Code Search 

4. In the list, select the code that you need to modify. 

5. Double click the desired code. 

— or —  

6. Select the desired code, then press [ENTER]. 

— or —  

7. Select the desired code, then click . 
 
  

Greyed out values cannot be changed.  These fields are found throughout the Look 

Up Code Maintenance tables and are either WinRecs default fields/descriptions or 

fields that have been submitted to CIHI.     
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ICD-10 Diagnostic and Intervention Codes 

There are limited fields that can be updated in the ICD-10 and CCI tables.  The CIHI values are 

visible but not enabled and these fields cannot be changed.  The user can only change the fields 

that are visible and enabled.   

Edits for Diagnosis and Intervention codes can be viewed in the Look Up.  For example, gender 

and age from and to.   

 

Figure 103 - Diagnostic and intervention Codes 

 
 
 
 
 
 
 
 

Once a Look Up Code has been saved, the Validation Code and Default Description 

cannot be changed.  To change these fields, the current Look Up Code must be 

deactivated by resetting the Valid To Date and creating a new entry with the new 

values. 
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The Diagnostic and Intervention windows in the Lookup Maintenance have 3 additional buttons 
that allow Diagnosis, Intervention and Projects to be linked.  Linking of more than one Diagnosis, 
Intervention or Project can be done.  
 
 

 

Project Link -when selected a popup window with the list of Projects that can be linked 

to the Diagnosis or Intervention code that is being edited  

 

Diagnosis Codes - when selected a popup window with the list of Diagnosis Codes that 

can be linked to the Diagnosis or Intervention code that is being edited 

 

Intervention Codes - when selected a popup window with the list of Intervention Codes 

that can be linked to the Diagnosis or Intervention code that is being edited 

Table 11 – Project, Diagnostic and Intervention Buttons 

• The following example will display how to link a diagnosis code to a project 

o WinRecs Maintenance – Look Up/General Maintenance/Diagnosis Codes 

o Search for ‘I64, Stroke, not specified as haemorrhage’ 

o Press Edit  

o Press the Project icon   

 

Figure 104 - Diagnostic and intervention Codes 
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o Press the new button  

o Click in the Project Number Box and Press [F2] or type in the Project number 

 

o From the list of projects double click or highlight and press Select Record 

 

Figure 105 – Linking Project to Diagnosis Code 

*Please note the button for Active Value Only, if checked it will only display active 

projects, uncheck will display all active and inactive projects.    

o Press the  Save button 

o To edit the project press the  

o To cancel any changes press the  

o To delete a project press the  
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3.2 Provider Maintenance 

The provider maintenance module is used to add or revise information for a facility’s physicians 

and other providers.   Providers may be added, modified and deactivated as required.   

To access the Provider Maintenance screen 

Select Maintenance → Provider Maintenance. 

 

Figure 106 - Provider Maintenance screen 

 

1. Provider List panel 

• Information – is the display information for the provider 

• Demographic – the demographic information for the provider 

• Services – Lists the provider service/speciality for the provider, may enter more than 

one. 

2. Toolbar – see Toolbar  

3. Provider identifier – Displays the provider being modified or entered.  If new, will display 

‘NEW’, if no provider chosen will display ‘EDIT’ 

4. Editing panel – Displays the fields that can be modified for the selected provider. 

5. Interface Value – Allows linking an interface value with a provider. 

6. Update History – Displays the user(s) and date/time who have created or updated the 

provider.   

7. Messages – displays a message of any fields that need to be entered, the fields will 

disappear as they are filled in 
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To add a new provider 

1. Click the  on the toolbar or Press [F5]. 

2. Select the Information Panel 

3. Enter all of the required fields in the Editing panel (4). 

Provider Maintenance Information Screen 

 

Figure 107 - Provider Maintenance - Information screen 

o Profile Links – the ability to assign a provider to a region from the dropdown list or from 

the available hospital(s).    (Optional) Leaving it blank will show for all regions and hospitals. 

o User Display Code – The provider number 

o Validation Code – Same as User Display Code 

o User Description – The provider name 

o Default Description – The same as User Description 

o Look Up Note – Additional Description of the value or rules for use 

o Valid From – Date when the provider became active.   

o Valid To – Date when the provider became invalid.   

o CJRR Surgeon ID – The surgeon ID as assigned by CIHI for CJRR. 
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o Interface Out – Value used as region/hospital in interface populating out of WinRecs, 

populates with User Code. 

Provider Maintenance Demographic Screen 

 

Figure 108 - Provider Maintenance – Demographic screen 

The demographic information is not mandatory and depends on the site and modules using on 

how much or little is filled in. 

o Provider First Name – The provider first name 

o Provider Surname – The provider last name 

o Language – Drop down of the language preferred 

o Preferred Mode Information Receipt – Email/Fax/Postal Mail 

o Address – The provider address 

o City – The provider city 

o Province – The provider province 

o Postal Code – The provider postal code 

o Home Phone – The provider home phone 

o Cell Phone – The provider cell phone 

o Office Phone – The provider office phone 

o Hospital Phone – The provider hospital phone 

o Email – The provider email 
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Provider Maintenance Services Screen

 

o Provider Status – Status of Provider – A (Active) or I (Inactive), populated from the 

Provider Status field in the Chart Deficiency module.  

o Current Provider Level – Provider Level is the level of deficiency the provider is at 

and what letter they will receive next.  The level is determined by the site. 

o Last Level Letter Issued – The last letter the provider received 

o Last Level Letter Date – The date last letter was sent out 

o Resident – A check mark indicates if the provider is a resident 

o Max Deficiency Level – Indicates the maximum letter level the provider will receive 

o Minimum Deficiencies – The minimum level of deficiencies that will generate a letter. 
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Provider Maintenance Services Screen 

 

Figure 109 - Provider Maintenance – Services screen 

Each provider needs a Service (Inpatient/SDS) and/or Speciality (NACRS) 

o To add, press the  to add the speciality 

o The Service will open, enter the Service/Speciality number or press [F2] to show the list of 

Service/Speciality numbers 

o Enter the Valid From Date – the date the service is valid 

o Enter the Valid To Date – the date the service is invalid 

o Once added, press the  

o If you need to delete the service/speciality, press the  

o Click the   on the toolbar to save the new record. 

— or —  

Press [F7]. 

 

 

Changes to Provider Maintenance will not appear till the user logs out and back into 

WinRecs     
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To edit an existing provider 
o Select, by clicking the desired group in the Provider List panel (1). 

o Click the  on the toolbar to display the search screen. 

— or —  

o Press [F4] to display the search screen. 

 

Figure 110 - Provider search 

o In the list, select the provider that you need to modify or type in user code or name 

o Double click on the desired provider. 

— or —  

o Select the desired provider, then press [ENTER]. 

o Select the desired provider, then click  

o Press  to edit the provider information 

o On the Services screen to edit an existing Service or Speciality, press the , this will 

open up the Service & Valid To and From Dates to make any changes.   
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Provider Maintenance Unavailability Screen 

 

If a Provider is away for a certain period of time, the Unavailability Screen would be populated.  

This will also stop the counting of deficient charts.   

To enter the Unavailability: 

1. Press the  or [F6] 

2. Type:  Choose the drop down or type the display code of the type 

• To create the type, press the and the following window will display 
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o To search for an existing Type press the  or [F4] 

o To edit an existing Type press the  or [F6] 

o To create a new Type press  or [F5] and populate the fields 

▪ User Display Code – the display code for that type 

▪ Validation Code – will populate with the User Display code (once 

saved this field cannot be edited) 

▪ User Description – the user description of the Type 

▪ Default Description – will populate with the User Description (once 

saved this field cannot be edited) 

▪ Look Up Note – can be populated if a note is preferred 

▪ Valid From – the date the Type is available 

▪ Valid To – the date the Type ends 

▪ Press or [F7] to save.   

3. Valid From – enter the start date the provider is not available 

4. Valid To – enter the end date the provider is not available.   
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3.3 Project Maintenance 

This feature is used to create and maintain Projects. 

To access the Project Maintenance screen 

Select Maintenance → Project Maintenance. 

 

Figure 111 - Project Maintenance Screen 

1. Project Information and Project Data Panel – Lists the Project Information and Project Data 

Fields for each project. 

2. Toolbar – see Toolbar 

3. Project identifier – Displays the identifier of the project being viewed, will show IDLE if no 

project shown and NEW to create a new project. 

4. Editing panel – Displays the fields that can be modified for the selected project. 

5. Interface Value – Allows linking an interface value with a project. 

6. Update History – Displays the user(s) who have made any changes to the Project. 

7. Messages – displays a message of any fields that need to be entered, the fields will 

disappear as they are filled in 

 

 

To add a new project 

o Click the  on the toolbar. 
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— or —  

o Press [F5]. 

o Click on Project Information in the Project Information panel (1). This will create the 

Project Number, Project Name and Valid From and To Date 

 

Figure 112 - Project Maintenance Screen 

o Profile Links – the ability to assign a project to a region or hospital(s).  Leaving it blank 

will show for all regions and hospitals.  (Optional) 

o Module Link – can assign the project to a specific module 

o User Display Code – The project number 

o Validation Code – The same number as the User Display Code 

o User Description – Name of the Project 

o Default Description – Same as User Description 

o Look Up Note – Additional description of the value or rules for use 

o Valid From – The date the project is valid 

o Valid To – The date the project is no longer valid 

o Interface Out– Value used as region/hospital in interface populating out of WinRecs, 

populates with User Display Code. 
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o Interface In – This will allow any Interface In values to come across the Batch Interface 

or HL7 feed. 

o Click on Project Data Field 1 in the Project Information panel. 

 

Figure 113 - Project Maintenance – Project Data Field 

o Data Field Title – The Project Field Name 

o Data Field Status: 

• X – Closed/Disabled – The project is not being collected  

• O- Open/Submitted – The project is available and is submitted to CIHI 

• W- Warning – A warning will display if the field is not filled out 

• E – Error – An error will display if the field is not filled out 

• C- Critical Error – A critical error will display if the field is not filled out and the 

abstract will not be saved 

o Data Field Default – The ability to add a default, depending on the Project Data Field, it 

will be a look up (drop down and will appear after the display code are created see below) or 

free text.   

o To add a display code or codes, press the  to enter the following: 

• User Display Code – the code for the value 

• Validation code – Same as the User Display Code 

• User Description – The description of the code 
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o Default Description – Same as the User Description. 

• Look Up Note - Additional description of the value or rules for use 

• Valid From – The date the code is valid 

• Valid To – The date the code is no longer valid 

o Click the   on the toolbar to save the new record. 

– Or —  

o Press [F7] 

o To delete the display code, press the  or [F9] 

To edit an existing project 

o Click the  on the toolbar to display the search screen. 

— or —  

o Press [F4] to display the search screen. 

 

Figure 114 - Project search 

o In the list, select the project that you need to modify. 

o Double click the desired project. 
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— or —  

o Select the desired project, then press [ENTER]. 

— or —  

o Select the desired project, then click . 

o Click on the   on the top tool bar 

o In the Project Data Field click on the  on the right-hand side tool bar to edit the display 

codes. 

 

 

 

 

3.4 Report Maintenance 

This feature allows user to setup Reports to be printed in specified modules and/or to Schedule 
automatic reports.   

To access the Report Maintenance screen 

Select Maintenance → Report Maintenance. 

 

Figure 115 – Report Maintenance Screen 
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1. Report Information and Schedule Panel – Lists the Report Information and Schedule for 

each report 

2. Toolbar – see Toolbar 

3. Report identifier – Displays the identifier of the project being viewed, will show IDLE if no 

project shown and NEW to create a new project. 

4. Editing panel – Displays the fields that can be modified for the selected scheduled report 

5. Interface Value – Allows linking an interface value with a project. 

6. Update History – Displays the user(s) who have made any changes to the Project. 

7. Messages – displays a message of any fields that need to be entered, the fields will 

disappear as they are filled in 

 

 

 

 

Information 

 

Figure 116 – Report Maintenance – Information Screen 
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o Profile Links– The ability to link a look up code to a region if there is more than one 

region in the database or link to a hospital if there is more than hospital. (Optional) 

Leaving it blank will show for all hospitals.  

o User Display Code – Displayed abbreviated name of the report 

o Validation Code – Displayed the name of the report 

o User Description – The description of the report 

o Default Description – The default description of the report  

o Look Up Note – Additional description if needed  

o Valid From – The date the report is valid from 

o Valid To – The date the report is valid to 

o Module – Select the Module from the drop-down list 

 

o Report Path – Enter the name of the Report. 

o E-Mail File Format – Select the format from the drop-down list 

 

o Auto Launch – Select Yes and when the user saves a record this will automatically 

launch the reports 

o Auto Execute (Load) – Select Yes and when the user selects a record this will 

automatically launch the reports 
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Schedule  

 

Figure 117 – Report Maintenance –Schedule Screen 
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o Hospital – Select the Hospital from the drop-down list 

o Email – Type the recipient’s email address, if required 

o Distribution printer – Specify the printer where the report will be sent 

o Number of Copies to Print - Type a number from 1-99 for the number of copies to 

be printed 

o Frequency Schedule – Select the frequency type from the drop-down list 

 
o Day of Month – Select the when in the Month it is to be printed from the drop-down list 

 
o Day of Week – Select the day from the drop-down list 

 
o Hour of Day – From the drop-down list select the frequency the report is to be printed 

 
o Schedule Time – Time in which the report will run 

o Last Schedule Run Date – Specify the last date for this report to run 

 

Schedule Toolbar 

Detailed description of each icons functionality and shortcut key. 

 
Insert Occurrence 

Allows user to insert a new occurrence  [F4] 

 
Edit Occurrence Allows user to edit the occurrence [F5] 

 
Keep Occurrence                  Saves the occurrence  [F6] 

 

Cancel 

Occurrence 

 Cancels changes made to occurrence 

since the previous save.   
 

Table 12 - Reports - Schedule Toolbar 
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To add a new report. 

o Click the  on the toolbar or press [F5]. 

o Click on Information in the Report Information panel.  

o The following fields must be entered for each report: User Display Code, Validation Code, 

User Description, Valid From and To Date, Report Path 

o To create a report for Report Manager in a specified module the following fields may be 

populated:  Module, Email File Format, Auto Launch and Auto Execute 

o To create a report for Scheduler click on Schedule in the Report Information Panel 

o Click on the in the Schedule tool bar 

 

o Populate the fields that will pertain to how the report will be scheduled. 

o Press the save button   in the Scheduler Tool Bar 
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o Press Save or Press  or  [F7] to save all changed (in upper tool bar) 

 

To edit a report. 

o Click the  on the toolbar to display the search screen or press [F4] to display the search 

screen. 
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Figure 118 - Provider search 

o Under Reports Record Search, enter the report name to pull it up or scroll through the reports 

o Double click the desired report. 

— or —  

o Select the desired report, then press [ENTER]. 

— or —  

o Select the desired provider, then click  

o Press  or [F6] to edit the report 

o On the Schedule screen to edit an existing scheduled report, click on the schedule to be 

edited and press the  on the schedule toolbar.  
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Figure 119 – Editing existing schedules 

 

o The schedule fields will be editable.   
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3.5 Auto Batch Interface   

This feature is used to automate the Batch Interface processes. Please notice that Batch 

Interfaces are custom built. If you have any questions regarding this process, contact a MED2020 

Client Services Representative. Contact information is available above in the section ‘Contact 

MED2020’. 

 

To access the Auto Batch Interface Maintenance screen 

Select Maintenance → Auto Batch Interface Maintenance 

 

Figure 120 – Auto Batch Interface 

1. Information– Lists the Information that needs to be entered for the Auto Batch to work. 

2. Toolbar – see Toolbar 

3. Editing panel – Displays the fields that can be modified for the Auto Batch. 

4. Update History – Displays the user(s) who have made any changes to the schedule entry. 

 

The Auto Batch can be set up from the workstation but the files and the folder that 

they are to be located in must reside on the network drive and not on the client 

machine. 
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o User Description – The description of the Batch to run  

o Batch Folder – The name of the directory (path) where the Batch Interface file will be 

located on the Server.  Use the button to find the path if you need. 

o  Layout Type – Indicates which Batch Interface is for.   There are mainly 2 types:  

o Standard Batch In (Fixed Length)  

o Custom Batch In 

o Layout ID – Indicates which Batch Interface is for.   This field only apply for Custom 

Batch In types.  

o Frequency Schedule – Select the frequency type from the drop-down list: Daily, 

Weekly or Monthly.  

o Daily – it will require a time to be entered  

o Weekly – it will require a Day of Week and time to be entered  

o Monthly – From the Day of the Month drop-down list select between: The First 

Day, The Last Day or the Middle Day of the month, then enter the time to be run 

it.   

o Day of Month – Select the when in the Month it is to be printed from the drop-down list 

 
o Day of Week – Select the day from the drop-down list 

 
o Schedule Time – Time in which the report will run 

 

 

 

Auto Batch Service will pick up any changes made to the schedule in real-time. There 

is no need to re-start the service.  Notice that there is no limit to the amount of jobs 

that can be created and maintained. 
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4. Tools Menu 

The Tool Menu consists of the following modules:  File Management, Batch Grouper, 

Batch Interface, Purge/Recover, Edits Engine, Abstract Profile, Database 

Update History.   

4.1 File Management 

The File Management allows the user to submit Submission, Correction and Institution/Facility file 

information to CIHI.  Each of these features are designed to meet current CIHI specifications for 

data validation and submission file creation.  Depending on the type of abstract being completed 

the applicable file format will be used.  The type of abstracts and relevant edits are determined by 

the Institution Profile (Care Type).   

To access File Management 

Click the menu Tools → File Management.  The following options will be displayed: 

 

Figure 121 - File Management 

 

4.1.1 CIHI Institution File – DAD and SDS 

Institution Files are used to identify the facility to CIHI and provide specific information 

such as demographics, contact and the vendor.  A separation file is set up for each institution 

number, even if they belong to the same facility.   

 

The Institution File must be sent to CIHI before submitting records and must be updated 

and resent if there are changes to the information: 

o At the start of each fiscal year 

o Resend if there is a change in facility information (ie:  Primary Contact or Facility merger) 

after the fiscal year facility file has been sent.   

o Resend if there is a change in vendor after the fiscal year facility file has been sent.   
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CIHI Institution File – DAD/SDS 

Entering all the information is required to send in the CIHI Institution File at the beginning of each 

fiscal year or when there is change in contact information..  This information will retain once 

saved. 

To find the CIHI Institution File go to the following path: 

Tools → File Management →DAD → CIHI Institution File 

Or 

Tools →File Management →SDS → CIHI Institution File 

 

The header will let you know if you are in the correct Institution File: 

 

 

Figure 122 – CIHI Institution File – Identity File Type 

 

At the start of each fiscal year, a new WinRecs update will be issued that allows the 

creation of the new fiscal year’s file format.  Users must be on the new version to 

create the Institution/Facility Information File for the new fiscal year.  
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Figure 123 – CIHI Institution File – DAD/SDS 

 

o Institution Number – Select the Institution Number 

o Reporting Facility Province/Territory – Select the province  

o Fiscal Year – Enter the current fiscal year 

o Site Street Address 1 – The address of the site  

o Site Street Address 2 – Extra line for the site address 
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o Site City – The City of the site  

o Site Province – Select the province.  

o Site Postal Code – Enter the Postal Code 

o Mailing Street Address 1 – Enter the mailing address  

o Mailing Street Address 2 – Extra line for the mailing address 

o Mailing City– Enter City name  

o Mailing Province– Select the province 

o Mailing Postal Code - The Postal Code of the site  

o Primary Contact Name – The primary contact name of site  

o Primary Contact Phone Number – The primary contact phone number  

o Primary Contact Phone Extension – The primary contact extension 

o Primary Contact Email Address – The primary contact email address 

o Secondary Contact Name - The secondary contact name 

o Secondary Contact Phone Number – The secondary contact phone number 

o Secondary Contact Phone Extension - The secondary contact phone extension 

o Secondary Contact Email Address - The secondary contact email address 

o Bed Size – Number of beds in site, must be numeric  

o French Edit Flag – Click if French edits are required 

o eCHAP Peer Group – drop down value of peer group beds 

o eCHAP SDS Institution Number - enter Day Surgery Institution if applicable 

o NACRS DS Indicator – check if Day Surgery is captured using NACRS  

 

Tools: 

 Verify [F11] – Verifies all the entries for the selected parameters 

Create File [F12] – Create the File based on parameters selected 

 - Save [F7] – Save the file 

 - Reports [F10] – Displays Select Report 

 

Creating DAD/SDS CIHI Institution File 

o Enter all mandatory criteria – users will not be able to create a file with missing mandatory 

fields. There will be messages listed in the message box of any missing criteria.  
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o Click  -Verify or F11 - To ensure all mandatory criteria is complete, errors will display in 

the box below. 

o Click  - Save or F7 to save the file.  These criteria will maintain after it is saved once 

the Institution File is accessed again.  

o Click  Create File or F12 to create the Institution File. 

o When complete the file path will be displayed here: 
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4.1.2 CIHI Facility Information File – NACRS 

To find the CIHI Facility Information File go to the following path: 

Tools → File Management →NACRS → CIHI Facility Information File 

 

Figure 124 – Facility Information File –NACRS 
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o Institution Number – Select the Institution Number 

o Reporting Facility Province/Territory – Select the province/territory 

o Fiscal Year - Enter the current fiscal year 

o Acute Care Number – Enter the Acute Institution number     

o Facility Name – The name of the facility  

o Facility Site Name – The name of the site  

o Street – The address of the site  

o Site City – The City of the site  

o Postal Code – The Postal Code of the site  

o Ambulatory 1st Contact Name – The primary contact name of site  

o Ambulatory 1st Contact Number – The primary contact phone number  

o Ambulatory 1st Contact Extension – The primary contact extension 

o Ambulatory 1st Contact Email – The primary contact email  

o Ambulatory 2nd Contact Name - The secondary contact name 

o Ambulatory 2nd Contact Number – The secondary contact phone number 

o Ambulatory 2nd Contact Extension - The secondary contact phone extension 

o Ambulatory 2nd Contact Email - The secondary contact email address 

o Ambulatory Care Fax Number – Fax number for site  

o Emergency Flag – Check this box if submitting ER records 

o Surgical Day/Night Care Flag – Check this box if submitting Surgical Day or Night 

Care records 

o Oncology Flag – Check this box if submitting Oncology records 

o Renal Dialysis Flag – Check this box if submitting Renal Dialysis records 

o Cardiac Catheterization Flag - Check this box if submitting Cardiac Catheterization 

records 

o Reporting Level Code – The NACRS Submitting Level your facility is submitting to CIHI  

 

o Other Ambulatory Care Flag – Check this box if submitting other ambulatory care 

records not shown above 

 

File creation toolbar. 
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 - Save [F7] – saves the data entered in the Facility Information File 

 Verify [F11] – all the entries for the selected parameters 

Create File [F12] – Create the File based on parameters selected 

 Reports [F10] – Displays Select Reports 

 

Creating NACRS Facility Information File 

o Enter all mandatory criteria – users will not be able to create a file with missing mandatory 

fields. There will be messages listed in the message box of any missing criteria.  

o Click  -Verify or F11 - To ensure all mandatory criteria is complete, errors will display in 

the box below. 

o Click  - Save or F7 to save the file.  These criteria will maintain after it is saved once 

the Institution File is accessed again.  

o Click  Create File or F12 to create the Institution File. 

o When complete the file path will be displayed here: 
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4.1.3 MDS(CCRS) CIHI Contact Information File 

Tools → File Management →MDS (CCRS) → CIHI Contact Information File 

 

Figure 125 – MDS(CCRS) CIHI Contact Information File 

o Institution Number – Select the Institution Number 

o Fiscal Year - Enter the current fiscal year 

o Internal Data Submission Contact 1 – Enter the Contact 1 Name     

o Internal Data Submission Contact 1 Telephone – Enter the phone number 

o Internal Data Submission Contact 1 Extension - Enter the extension 

o Internal Data Submission Contact 1 Email Address - Enter the email 

o Internal Data Submission Contact 1 Auto-Notification – Enter a check 

mark if auto-notification is needed 

o Internal Data Submission Contact 2 – Enter the Contact 2 Name     
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o Internal Data Submission Contact 2 Telephone – Enter the phone number 

o Internal Data Submission Contact 2 Extension - Enter the extension 

o Internal Data Submission Contact 2 Email Address - Enter the email 

o Internal Data Submission Contact 2 Auto-Notification – Enter a check 

mark if auto-notification is needed 

o External Data Submission Contact 1 – Enter the Contact 1 Name     

o External Data Submission Contact 1 Phone Number – Enter the phone number 

o External Data Submission Contact 1 Extension - Enter the extension 

o External Data Submission Contact 1 Email Address - Enter the email 

o External Data Submission Contact 1 Org ID – Enter the Org ID 

o External Data Submission Contact 1 Auto-Notification – Enter a check 

mark if auto-notification is needed 

o External Data Submission Contact 2 – Enter the Contact 2 Name     

o External Data Submission Contact 2 Phone Number – Enter the phone number 

o External Data Submission Contact 2 Extension - Enter the extension 

o External Data Submission Contact 2 Email Address - Enter the email 

o External Data Submission Contact 2 Auto-Notification – Enter a check 

mark if auto-notification is needed 

o External Data Submission Contact 2 Org ID – Enter the Org ID 

o RAI Coordinator 1 – Enter the RAI Coordinator 1 Name     

o RAI Coordinator 1 Phone Number – Enter the phone number 

o RAI Coordinator 1 Extension - Enter the extension 

o RAI Coordinator 1 Email Address - Enter the email 

o RAI Coordinator 1 Auto-Notification – Enter a check mark if auto-notification is 

needed 

o RAI Coordinator 2 – Enter the RAI Coordinator 2 Name     

o RAI Coordinator 2 Phone Number – Enter the phone number 

o RAI Coordinator 2 Extension - Enter the extension 

o RAI Coordinator 2 Email Address - Enter the email 

o RAI Coordinator 2 Auto-Notification – Enter a check mark if auto-notification is 

needed 

o Administrator – Enter the Administrator Name     

o Administrator Phone Number – Enter the phone number 

o Administrator Extension - Enter the extension 

o Administrator Email Address - Enter the email 
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o Administrator Auto-Notification – Enter a check mark if auto-notification is 

needed 

o File creation toolbar: 

 - Save [F7] – saves the data entered in the Facility Information File 

 Verify [F11] – all the entries for the selected parameters 

Create File [F12] – Create the File based on parameters selected 

 Reports [F10] – Displays Select Reports 

 

Creating MDS (CCRS) CIHI Contact Information File 

o Enter all mandatory criteria – users will not be able to create a file with missing mandatory 

fields. There will be messages listed in the message box of any missing criteria.  

o Click  -Verify or F11 - To ensure all mandatory criteria is complete, errors will display in 

the box below. 

o Click  - Save or F7 to save the file.  These criteria will maintain after it is saved once 

the Institution File is accessed again.  

o Click  Create File or F12 to create the Institution File. 

o When complete the file path will be displayed here: 
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4.1.4 NRS CIHI Contact Information File 

Tools → File Management →NRS → CIHI Contact Information File 

 

Figure 126 – NRS CIHI Contact Information File 

o Institution Number – Select the Institution Number 

o Fiscal Year - Enter the current fiscal year 

o Type of Facility - Enter the Type of Facility from the drop-down menu 

 

o Facility/Site Name – Enter the Facility/Site name 

o Facility/Site CEO/Administrator Name - Enter name 
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o Corporation/Region Name (if applicable) - Enter name 

o Corporation/Region CEO Name (if applicable) - Enter name 

o Facility Size (Approved Beds) – Enter bed number  

o Facility Size (Operating Beds) – Enter bed number  

o Facility/Site Street Address – Enter address 

o Facility/Site City – Enter the City   

o Facility/Site Province – Enter the province from the drop down menu 

o Facility/Site Postal Code - Enter the postal code 

o Facility/Site Phone Number - Enter the phone number 

o Facility/Site Extension – Enter phone extension 

o Facility/Site Fax Number – Enter fax number    

o Site Coordinator Contact – Enter Site Coordinator name 

o Site Coordinator Phone Number – Enter the phone number 

o Site Coordinator Extension – Enter the extension 

o Site Coordinator Fax Number – Enter Fax number 

o Site Coordinator Email Address – Enter Email Address 

o Primary Data Submission Contact Name - Enter name 

o Primary Data Submission Contact Phone Number - Enter the phone # 

o Primary Data Submission Contact Extension - Enter the extension 

o Primary Data Submission Contact Fax Number – Enter the fax number 

o Primary Data Submission Contact Email Address - Enter the email 

o Secondary Data Submission Contact Name - Enter name 

o Secondary Data Submission Contact Phone Number - Enter the phone # 

o Secondary Data Submission Contact Extension - Enter the extension 

o Secondary Data Submission Contact Fax Number – Enter the fax number 

o Secondary Data Submission Contact Email Address - Enter the email 

o File creation toolbar: 

 - Save [F7] – saves the data entered in the Facility Information File 

 Verify [F11] – all the entries for the selected parameters 

Create File [F12] – Create the File based on parameters selected 

 Reports [F10] – Displays Select Reports 
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Creating NRS CIHI Contact Information File 

o Enter all mandatory criteria – users will not be able to create a file with missing mandatory 

fields. There will be messages listed in the message box of any missing criteria.  

o Click  -Verify or F11 - To ensure all mandatory criteria is complete, errors will display in 

the box below. 

o Click  - Save or F7 to save the file.  These criteria will maintain after it is saved once 

the Institution File is accessed again.  

o Click  Create File or F12 to create the Institution File. 

o When complete the file path will be displayed here: 
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4.1.5  OMHRS CIHI Contact Information File 

Tools → File Management →OMHRS → CIHI Contact Information File 

 

Figure 127 – OMHRS CIHI Contact Information File 
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o Institution Number – Select the Institution Number from drop down 

o Reporting Facility Province/Territory – Select Province/Territory from drop 

down  

o Fiscal Year - Enter the current fiscal year 

o Facility Name - Enter the Facility Name 

o Site Name – Enter the Site name 

o Facility Address Line 1 - Enter Facility address 

o Facility Address Line 2 - Enter address (if needed) 

o City – Enter the City   

o Province – Enter the province from the drop down menu 

o Postal Code - Enter the postal code 

o Designated Number of MOH Beds - Enter number of designated beds 

o Ownership – Select from drop down 

o Facility Administrator – Enter Facility Administrator name 

o Administrator Phone Number – Enter the phone number 

o Administrator Phone Extension – Enter the extension 

o Administrator Fax Number – Enter Fax number 

o Administrator Email Address – Enter Email Address 

o Site Coordinator Contact - Enter name 

o Site Coordinator Phone Number - Enter the phone # 

o Site Coordinator Extension - Enter the extension number 

o Site Coordinator Fax Number – Enter the fax number 

o Site Coordinator Email - Enter the email 

o Database Contact - Enter name 

o Database Phone Number - Enter the phone # 

o Database Phone Extension - Enter the extension 

o Database Fax Number – Enter the fax number 

o Database Email Address - Enter the email 

o Preferred Language of Correspondence - Enter preferred language from drop 

down  

o Facility Type - Enter facility type from drop down  

o File creation toolbar: 

 - Save [F7] – saves the data entered in the Facility Information File 

 Verify [F11] – all the entries for the selected parameters 



 [T WinRecs Version 2025.01 User Guide 

© 2025 MED2020 Health Care Software Inc. All rights reserved. Page 157 

Create File [F12] – Create the File based on parameters selected 

 Reports [F10] – Displays Select Reports 

 

Creating MHRS CIHI Contact Information File 

o Enter all mandatory criteria – users will not be able to create a file with missing mandatory 

fields. There will be messages listed in the message box of any missing criteria.  

o Click  -Verify or F11 - To ensure all mandatory criteria is complete, errors will display in 

the box below. 

o Click  - Save or F7 to save the file.  These criteria will maintain after it is saved once 

the Institution File is accessed again.  

o Click  Create File or F12 to create the Institution File. 

o When complete the file path will be displayed here: 
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4.2.1 CIHI Submission File – DAD & NACRS 

There are four basic processes involved in the submission of data to CIHI: 

1. Month end balances – ensure the number of abstracts in WinRecs balances with Finance or 

Registration. 

2. Create and send Facility Information File (at the start of the Fiscal Year or if information 

needs to be updated) 

3. Create and submit monthly (or quarterly) data files. 

4. Receive and import rejection files for correction and/or resubmission of abstracts.   

 

The submission process will: 

1. Verify options 

2. Verify all records are complete 

3. Verify all records are error free 

4. Assign CIHI Record Types, Batch Numbers and CIHI Abstract Number to each record 

5. Create the CIHI file so that it conforms to CIHI specifications 

6. Save the file to a predetermined location as set in the Institution Profile →File Path → CIHI 

Directory 

 

If an update to any of the groupers (ie CMG, DPG and CACS) has been applied after the records 

have been coded, The Batch Grouper (see Batch Grouper)  will need to be run prior to 

Submission.  This ensures that the most up to date calculation will be submitted with the records.   

When an abstract has been submitted to CIHI the field Is File Create (Submitted) in the 

Abstract Status section will be filled in with a ‘Y’ – Yes.   

 

Figure 128 – Is File Created(Submitted) 

Submission Setup Requirements 

Ensure the Institution Profile/File Path/CIHI Directory is completed with the path to where the 

CIHI files will be saved.  (Submission & Facility Profile). 

If the CIHI Directory is left blank, then the file will automatically go to C:\Users 

Access File Creation 

To access the file creation screen, click the menu Tools → File Management.   The following will 

display: 
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Figure 129 – File Management Screen 

DAD/SDS CIHI Submission & CJRR CIHI Insert/Update Data Submission File 

• DAD → CIHI Submission File – or –  

          SDS → CIHI Submission File 

           

 

 

Figure 130 – File Management DAD/SDS Submission File Screen 
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o  - Batch Verify (Shift+F11) – This will reverify all abstracts in the selected Batch 

o  - Create File (F12) – This will create the file, if the Batch Verify is run just click on 

Create File and the file wil will be created.   

o  - Batch Reports(Shift+F10) – This will display the reports function 

o  - Checked Record Locks– checks for locked records 

o  - Reset File Settings – This will reset the file setting below.  The following 

message will display when clicked: 

 

 

• Yes will clear the below settings, No will retain the current settings.  

o Complete Re-verify – checking this box will re-verify every record, not checking the box 

will not re-verify.   

o Include Submitted – Only used to verify submitted EMT edits.   Can only be used 

checking this box will also automatically check the Complete Re-verify and Create File is 

disabled.  Only C- Only Custom Edits can be used in the Select Edit Library.   

o Care Type – Drop down menu – A-All Cases defaults 

 

o Select Edit Library – Allow user to run the submission using: 
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Custom Edits are EMT edits and only used for EMT clients.   

System Edits are edits required for submission to CIHI.   

o Institution Number – enter the institution number or click on the down arrow and choose 

the institution (only the institutions for the module selected will display) 

o Batch Year – this will be blank the first time it is used, entering the fiscal year that is being 

submitted 

o Batch Period – this will default if previous periods have been submitted/enter the period/or 

choose from the drop down list 

o Date from – will populate based on the Batch Period, can be modified if required 

o Date to – will populate based on the Batch Period, can be modified if required 

o Current Batch – will populate how many records are in the Current Batch Period 

o Already Sent (In Previous File) – will populate the number of records that have 

been previously submitted 

o Full Batch Count - Total records in the Batch 

o Require Grouper Calculation - This feature will populate the number of records that 

do not have grouper information.  A message will also populate while running verify that will 

state the following: 

 

o Invalid (Is Valid E or N) – This displays the number of abstracts that have “N” or 

“E” in the is ‘Is Valid’ field on the abstract.  During the File Create process a message will 

display asking the following: 
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• “Yes” will display the error messages and give the ability to fix the errors 

• “No” will not display the errors and the file will be created without the errors. 

o Verified (Is Valid W or Y) – This displays the number of abstracts that have “W” 

or “Y” in the is ‘Is Valid’ field on the abstract 

o  - Abstract menu – used when fixing abstracts with Errors 

and Warnings  

•  - Save (F7) – Saves the record 

•  - Undo – Undoes any changes to the record 

•  - Record Verify (F11) – Verifies the Record 

• - Report Manager(F10) – Opens Select Report 

•  - Tools– Click on the different options to change the view at the bottom of the 

abstract  
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NACRS Level 0, 1, 2, 3 Submission 

To access NACRS Submissions 

Tools → File Management → NACRS → 

NACRS Level 0 (Clinic Lite) → CIHI Submission File  

NACRS Level 1 → CIHI Submission File 

NACRS Level 2 → CIHI Submission File 

NACRS Level 3 → CIHI Submission File 

 

The Level that is being submitted is displayed along the top Submission Screen: 

 

          Figure 131 – File Management NACRS CIHI Submission File Identification 

 

Figure 132 – File Management NACRS CIHI Submission File Screen 
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o  - Batch Verify (Shift+F11) – This will reverify all abstracts in the selected Batch 

o  - Create File (F12) – This will create the file, if the Batch Verify is run just click on 

Create File and the file wil will be created.   

o  - Batch Reports(Shift+F10) – This will display the reports function 

o  - Checked Record Locks– checks for locked records 

o  - Reset File Settings – This will reset the file setting below.  The following 

message will display when clicked: 

 

• Yes will clear the below settings, No will retain the current settings 

o Complete Re-verify – checking this box will re-verify every record, not checking the box 

will not 

o Include Submitted – Only used to verify submitted EMT edits.   Can only be used 

checking this box will also automatically check the Complete Re-verify and Create File is 

disabled.  Only C- Only Custom Edits can be used in the Select Edit Library 

o Care Type -  allows the user the option(not included in Level 0): 

o B All Cases – will validate for all Care Types (Level 3 only) 

o B-C Clinic – will validate for all MIS codes with a ‘Clinic’ Care Types (Level 3 only) 

o B-D Day Surgery – will validate for all MIS codes with a Day Surgery Care Type 

(Level 3 only) 

o B-E Emergency – will validate for all MIS codes with an Emergency Care Type 

(Level 1, 2, 3) 

o B-E-O ED Opioid Cases – will validate for all Opioid Cases only (Level 1, 2, 3) 

o Select Edit Library – Allow user to run the submission using: 

o B-Both System and Custom Edits 
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o S- Only System Edits (For NACRS Level 0 this is the only option) 

o C- Only Custom Edits 

o Institution Number – enter the institution number that is to be sent or click on the down 

arrow and choose the institution (only the institutions for the module selected will display) 

o Batch Year – this will be blank the first time it is used, entering the fiscal year that is being 

submitted 

o Batch Period – this will default if previous periods have been submitted/enter the period/or 

choose from the drop down list 

o Date from – will populate based on the Batch Period, NACRS submission has the 

option to submit specified dates in a period 

o Date to – will populated based on the Batch Period, NACRS submission has the option 

to submit specified dates in a period  

o Current Batch – will populate how many records are in the Current Batch Period 

o Already Sent(In Previous File) – will populate the number of records that have 

been previously submitted 

o Full Batch Count - Total records in the Batch 

o Require Grouper Calculation - This feature will populate the number of records that 

do not have grouper information.  A message will also populate while running verify that will 

state the following: 

 

o Invalid (Is Valid E or N) – This displays the number of abstracts that have “N” or 

“E” in the is ‘Is Valid’ field on the abstract.   

• “Yes” will display the error messages and give the ability to fix the errors 

• “No” will not display the errors and the file will be created without the errors. 

o Verified (Is Valid W or Y) – This displays the number of abstracts that have “W” 

or “Y” in the is ‘Is Valid’ field on the abstract.  During the File Create process a message will 

display asking the following: 

o CIHI File Location – Displays the file location, clicking on the link will open the 

location the file is located. 

o Current Batch – number of CJRR records in this Batch Period (Level 3 CJRR only) 

o Invalid – CJRR – number of records that are invalid in this Batch Period (Level 3 CJRR 

only) 
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o Verified – CJRR – number of records that are verified and included in the file for this 

Batch Period (Level 3 CJRR only) 

o CJRR File Location – Location of the CIHI CJRR file, clicking on link open CIHI CJRR 

file location. (Level 3 CJRR only) 

4.2.2 Running the Submission 

Verification Only 

o To run a verification only, enter the following fields: 

• Care Type 

• Select Edit Library 

• Institution Number 

• Batch Year 

• Batch Period 

• Date From – can be adjusted but not necessary. 

• Date to – can be adjusted but not necessary. 

• Press  Batch Verify or Shift+{F11} 

• The following message will display:   

 

• Click “Yes” to continue verification, “No” to end the process. 

• The submission will continue if there are errors or warnings the following message 

will appear: 
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• Click “Yes” to review the error messages and ‘No” to continue the submission without 

the errors.   

o If there are only warnings the following will display: 

 

• Click “Yes” to review the warning messages. 

• Click ‘No” to continue the verification without the errors.   
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Fixing Errors/Warnings 

 

Figure 133 – File Management NACRS CIHI Submission Fixing Errors/Warnings 

• Click on the plus sign beside the abstract information 

• Click on the plus sign beside the error message 

• Double click on the field that is causing the error to open up the abstract on the right-

hand side. 
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• Fix the error and it will disappear from the middle. 

• Press  Save or [F7] 

• If you want to create a submission after doing a verification, press   Create 

File or [F12] to create the file.   

 

Create Submission 

o Select the following fields: 

• Complete Re-Verify – check this if a re-verification is needed.  

• Care Type 

• Select Edit Library 

• Institution Number 

• Batch Year 

• Batch Period 

• Date From – can be adjusted but not necessary. 

• Date to – can be adjusted but not necessary. 

• Press   Create File or [F12] 

 

o The following message will display:   
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• Click “Yes” to continue verification, “No” to end the process. 

o The submission will continue if there are errors and/or warnings the following message will 

appear see: Fixing Errors/Warnings 

o Once errors are reviewed/fixed, click the  Create File or (F12) 

• The following message will display: 

 

• “Yes” will remove the Complete Re-Verify and the Submission File will be created 

• “No, the Re-Verify process will run again and then Submission File will be created.  

 

 

 

• Once the submission process is complete, the following message will display and the 

file path will display on the bottom left hand side.  : 
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4.2.3 CIHI Correction File – DAD & NACRS 

The CIHI Correction module tracks, stores, and submits correction for abstracts that have been 

previously submitted to CIHI.  The Correction module is only used with the: 

o [DAD] AbsCare Inpatient module  

o [SDS] Abscare Day Surgery module 

o [NACRS] 1, 2, 3 Amcare Ambulatory module 

 

DAD & SDS are submitted cumulatively over the fiscal year (i.e.: correction files are not period 

specific but fiscal year specific) 

NACRS are submitted period by period and are not cumulative.   

All other WinRecs modules submit corrections with their submissions file.   

 

Abstracts that have been sent for correction will have the field ‘Is File Corrected’ in the 

Abstract Status section of the abstract. 

 

Figure 134 - CIHI Correction Status in the Abstract 
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The following will display in the Is File Corrected field: 

o N = No there is not correction pending 

o P = Correction pending in DAD/SDS module 

o P1 = NACRS Level 1 pending 

o P2 = NACRS Level 2 pending 

o P3 = NACRS Level 3 pending 

 

Creating a Correction File 

When accessing a submitted record, the following warning message will display: 

 

Figure 135 – Message for Accessing a Record Submitted to CIHI 

When any changes are made or the abstract is saved, the ‘Is File Corrected field’ will 

change to Pending as explained above.   

 
  



 [T WinRecs Version 2025.01 User Guide 

© 2025 MED2020 Health Care Software Inc. All rights reserved. Page 173 

Inpatient/SDS Correction 

 

 

Figure 136 – File Management – DAD/SDS CIHI Correction File Screen 

o  - Batch Verify (Shift+F11) – This will reverify all abstracts in the selected Batch 

o  - Create File (F12) – This will create the file, if the Batch Verify is run just click on 

Create File and the file wil will be created.   

o  - Batch Reports(Shift+F10) – This will display the reports function 

o  - Checked Record Locks– checks for locked records 

o  - Reset File Settings – This will reset the file setting below.  The following 

message will display when clicked: 

o Complete Re-verify – checking this box will re-verify every record, 
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o Institution Number – enter the institution number that is to be sent or click on the down 

arrow and choose the institution (only the institutions for the module selected will display) 

o Batch Year – this will be blank the first time it is used, entering the fiscal year that is being 

submitted 

o Batch Period – this will default if previous periods have been submitted/enter the period/or 

choose from the drop down list 

o Date from – will populate April 1 for DAD/SDS and will populate with the beginning of the 

Batch Period (cannot enter into this field) 

o Date to – will populated the last date based on the Batch Period (cannot enter into this 

field) 

o Care Type – Drop down menu – A-All Cases defaults 

 

• A-C19 – Covid-19 Cases – if you choose this option the date from and date to fields 

will open and dates can be entered 

o Correction in Batch – Total corrections in batch 

o Corrections Remaining – Any corrections not included in correction file 

o Total Corrections In Period – Total Corrections in Period 

o Invalid (Is Valid E or N) – This displays the number of abstracts that have “N” or 

“E” in the is ‘Is Valid’ field on the abstract.   
o Verified (Is Valid W or Y) – This displays the number of abstracts that have “W” 

or “Y” in the is ‘Is Valid’ field on the abstract 

o CIHI File Location – Identifies where the file is located, can click on the link and will 

take you to the correction/deletion file. 

o  - Abstract menu – used when fixing abstracts with Errors 

and Warnings  

•  - Save (F7) – Saves the record 

•  - Undo – Undoes any changes to the record 

•  - Record Verify (F11) – Verifies the Record 

• - Report Manager(F10) – Opens Select Report 
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•  - Tools– Click on the different options to change the view at the bottom of the 

abstract  

 

o CIHI File Location – Displays the file location, clicking on the link will open the 

location the file is located. 
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NACRS Level 0/1/2/3 Correction/Deletion 

 

Figure 137 – File Management – NACRS Level 0/1/2/3 CIHI Correction File 
Screen 

o  - Batch Verify (Shift+F11) – This will reverify all abstracts in the selected Batch 

o  - Create File (F12) – This will create the file, if the Batch Verify is run just click on 

Create File and the file wil will be created.   

o  - Batch Reports(Shift+F10) – This will display the reports function 

o  - Checked Record Locks– checks for locked records 

o  - Reset File Settings – This will reset the file setting below.  The following 

message will display when clicked: 

o Complete Re-verify – checking this box will re-verify every record. 

o Care Type -  allows the user the option(not included in Level 0): 

o B All Cases – will validate for all Care Types (Level 3 only) 
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o B-C Clinic – will validate for all MIS codes with a ‘Clinic’ Care Types (Level 3 only) 

o B-D Day Surgery – will validate for all MIS codes with a Day Surgery Care Type 

(Level 3 only) 

o B-E Emergency – will validate for all MIS codes with an Emergency Care Type 

(Level 1, 2, 3) 

o B-E-O ED Opioid Cases – will validate for all Opioid Cases only (Level 1, 2, 3) 

o Institution Number – enter the institution number that is to be sent or click on the down 

arrow and choose the institution (only the institutions for the module selected will display) 

o Batch Year – this will be blank the first time it is used, entering the fiscal year that is being 

submitted 

o Batch Period – this will default if previous periods have been submitted/enter the period/or 

choose from the drop down list 

o Date from – this will populate with the beginning of the Batch Period (cannot enter into 

this field) 

o Date to – will populated the last date based on the Batch Period (cannot enter into this 

field) 

o Total Correction/Delete – Total Corrections/Deletions for this Batch Period 

o Corrections – Total Corrections in the Batch Period 

o Deletes – Total Deletions in the Batch Period 

o Invalid (is Valid is E or N) – Total records that have errors or not processed in 

the Batch Period 

o Verified (Is Valid W or Y) – Total records that have warnings or are verified in the 

Batch Period.  

o CIHI File Location – Identifies where the file is located, can click on the link and will 

take you to the correction/deletion file. 

o  - Abstract menu – used when fixing abstracts with Errors 

and Warnings  

•  - Save (F7) – Saves the record 

•  - Undo – Undoes any changes to the record 

•  - Record Verify (F11) – Verifies the Record 

• - Report Manager(F10) – Opens Select Report 
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•  - Tools– Click on the different options to change the view at the bottom of the 

abstract  

 

 

Create Correction 

To create the correction file is the same as the submission file process but the file naming will be 

for a correction and will be sent to CIHI as a correction. Click here:  Creating a Correction File 

 

4.2.4 No Separations File – DAD  

If an institution has no discharges for a specific period, CIHI requires that a “No Separation File” 

be submitted to advice that no abstracts to that reporting period. 

Run the Create Submission the following message will appear: 

  

Figure 138 – File Management – Zero discharges in the selected batch period 
message 

Clicking YES – will create a No Separation File  

Clicking NO – will go back to the File Management screen 
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4.2.5 CIHI Deletion File – DAD & NACRS 

A deleted record that has previously been submitted to CIHI will remain in the Purge/Recover 

module until a deletion file or submission/correction file (depending on the module) is run.   The 

file can be deleted via the Abstracting module or via the Modify Chart module.   

 

In the Abstracting module, the following messages will appear when a submitted chart is deleted: 

 

Figure 139 – File Management – Deletion Confirmation Message 

Click YES will continue with the process 

Click NO it will go back to the abstract 

 

Figure 140 – File Management – Deletion Confirmation Message 

Click OK and the abstract will be sent to the purge file.   
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DAD/SDS Deletion File 

The file will be created as a deletion file.   

Tools → File Management → DAD → CIHI Deletion File 

Tools → File Management → SDS → CIHI Deletion File 

 

 

Figure 141 – File Management – DAD/SDS Deletion 

o  - Create File (F12) – This will create the file  

o  - Batch Reports(Shift+F10) – This will display the reports function 

o  - Checked Record Locks– checks for locked records 
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o  - Reset File Settings – This will reset the file setting below.  The following 

message will display when clicked: 

o Care Type -  allows the user the option: 

o A All Cases – will validate for all Cases 

o A-C19-Covid-19 Cases – will send in COVID 19 deletions.  

o Institution Number – enter the institution number that is to be sent or click on the down 

arrow and choose the institution (only the institutions for the module selected will display) 

o Batch Year –enter the batch year of the deletions being submitted 

o Batch Period Last Submitted – will enter the last period that has been submitted to 

CIHI, it will pull all deletions from April 1 to end of that Batch period for the Batch year chosen 

o Date from – this will populate with the beginning of the Batch Year 

o Date to – will populated the last date based on the Batch Period  

o Deletions in Batch – Total deletions in this Batch  

o Deletions Remaining – Total deletions not included in the file for this Batch Period 

o Total Deletions in Period – Total Deletions in the Batch Period 

CIHI File Location – Identifies where the file is located, can click on the link and will take 

you to the correction/deletion file. 

 

Create DAD/SDS Deletion File  

o Select the following fields: 

• Care Type 

• Institution Number 

• Batch Year 

• Batch Period – this will auto populate the last period submitted to CIHI 

• Date From – can be adjusted but not necessary. 

• Date to – can be adjusted but not necessary. 

• Press   Create File or [F12] 

 

• Once the submission process is complete, the following message will display: 
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NACRS Level 1/2/3 Deletion File  

The file is created and sent as part of the correction file.   

Tools → File Management → NACRS Level 1/2/3 → CIHI Correction/Deletion File 

Go to:  Create Submission on how to create the file. 

4.2.6 CIHI Detailed Error File – DAD 

The function is used to flag CIHI submitted records as pending corrections.  Importing the DAD 

error file allows user to print the errors for corrections. 

1. Save the CIHI Detailed Error File received from CIHI on the computer where it is 

designated for the facility. 

2. Tools → File Management → DAD → CIHI Detailed Error File 
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Figure 142 – File Management – CIHI Detailed Error File 

 

3. Press the  to search for the CIHI file and the file directory will display. 

4. Once the file has been located press OK and the file name will display in the top.  Press 

the  to process the report and DAD CIHI Errors are imported.   

5.  - Displays the file path of the file you are processing. 

6. The following message will display: 

 

7. Once the file is finished processing the errors will display.  
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4.2.7 CIHI Electronic Rejection/Data Quality Warning File - NACRS 

This file flags the NACRS files that have been rejected due to errors by CIHI.   Once the file is 

imported it will reset the submission status of rejected records.  After the files have been 

corrected and saved the records will be submitted to CIHI.   

1. Save the CIHI Electronic Rejection/Data Quality Warning file from CIHI onto a shared drive 

(as per hospital decision).  

2. Tools → File Management → NACRS → CIHI Electronic Rejection/Data Quality Warning 

File 

 

Figure 143 - File Management – CIHI Electronic Rejection Data Quality Warning 

3. Press the  to search for the CIHI file and the file directory will display. 

4. Once the file has been located press OK and the file name will display in the top.  Press the 

 to process the report.   

5.  - Displays the file path of the file you are processing. 

6. The following message will display when done and the error messages will display and the 

visits will have the submission status reset: 
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4.2.8 Manual Reset of Submission Status - NACRS 

When correcting a rejected NACRS record without having imported the NACRS Rejection file 

from CIHI, the user will have to reset the submission status on each abstract as they are 

corrected.   

To Manually Reset the Submission Status: 

o Open the rejected record 

o Correct the error(s) 

o Select File Settings/Re-Set File Create Status  

 

Figure 144 – Re-set File Create Status 

o The following message will appear: 

 

Figure 145 – Re-set File Create Status Message 

 

o Clicking ‘Yes’ will reset the submission status to a ‘N’ 

o Click ‘No’ will take you back to the abstract 

The ‘Is Abstract Submitted’ flag will now change to ‘N’ and the record can be resubmitted via 

Create Submission 
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4.2.9 NACRS CJRR Submission/Corrections/Deletions 

NACRS CJRR Visit is submitted as a separate Level 3 Submission. The Level 3 submission file 

must be accepted by CIHI prior to submitting the NACRS CJRR file. 

o Run the Level 3 Submission file and the NACRS CJRR file will be created at the same time.   

o Click on Create File: 

o The following will display the number of NACRS L3 abstracts and the number of NACRS-

CJRR L3 abstracts.   

 

Figure 146 – NACRS CJRR Submission 

 

o When the file is created, 2 files will be created the first will be the Level 3 submission file, 

the second is the NACRS CJRR submission file.   
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Figure 147 – NACRS CJRR Submission Files Created 

o Current Batch – number of CJRR records in this Batch Period 

o Invalid – CJRR – number of records that are invalid in this Batch Period 

o Verified – CJRR – number of records that are verified and included in the file for this 

Batch Period 

o CJRR File Location – Location of the  CIHI CJRR file, clicking on link open CIHI 

CJRR file location.  

  

Please Note:  The level 3 file with the Amcare Visits (lowest sequence number) must be 

submitted and accepted by CIHI prior to sending the NACRS CJRR File.  The Record Type for 

the new CJRR visit is 5.   

Note:  The level 3 file with the Amcare visits (lowest sequence number) must be 
submitted and accepted by CIHI prior to sending the NACARS CJRR file.  The 
Record Type for new CJRR records is 5. 
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NACRS CJRR Corrections 

• Any changes to the NACRS CJRR submitted cases will also update the Level 3 visit 

when saved.   

• When a NACRS Level 3 correction file (Record Type 4) is created and submitted to CIHI 

this will in turn delete the associated CJRR file.  The NACRS CJRR file will need to send 

as a Record Type 5 new.  When the correction file is run, there will be 2 files created: 

o NACRS Level 3 Correction File 

o NACRS CJRR file – with Record type 5 (new) 

These files will need to be submitted as above, the Level 3 correction file first and 

once accepted by CIHI the NACRS CJRR file. 

 

NACRS CJRR Deletion 

• When a NACRS Level 3 abstract and it’s associated CJRR file is deleted and is 

submitted as a Correction file.  The deleted visit will be picked up as a Record Type 2.  

The Record Type 2 will delete both the Level 3 Amcare visit and the associated NACRS 

CJRR visit.   

• If the NACRS CJRR visit is only deleted and the Level 3 Amcare remains.  The correction 

file will create a Record Type 4.  This will correct the Level 3 Amcare and delete the 

NACRS CJRR visit.   

 

4.2.10 File Management – Other Messages 

The following messages that may occur at different times of the File Management process. 

 

1. No File Path for CIHI Files - If the user tries to save the verification result file to a location 

that does not exist, WinRecs will prompt the user to create the folder.  This means there is no 

File Path in the CIHI Directory in the Institution Profile  

 

Figure 148 – File Management – Default user Location does not Exist Message 



 [T WinRecs Version 2025.01 User Guide 

© 2025 MED2020 Health Care Software Inc. All rights reserved. Page 189 

Clicking YES – will create a folder for you in the Default user folder location. 

Clicking NO – will take you back to the File Management screen 

 

2. Record Being Accessed – Charts of the submitted period are being accessed, the process 

cannot be completed till the abstracts are closed.   

 

Figure 149 – File Management – Record from this period being accessed 

3. Date Range Includes Future Date - A message will be displayed to inform you that records 
outside of the date range will be rejected.   

 

Figure 150 - Confirmation records outside the date range not in submission file 

o Click Yes to continue submission process 

o Click No to go back to the File Management screen. 

 

4. Required Parameters Missing - If the user forgets to fill in some of the required parameters, 

the following error message will be displayed. 
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Figure 151 - File creation parameter error 

To return to the file creation screen and correct the error 

o Click “Ok” or Press  [ENTER]. 

o Highlight No using the [TAB] key, then press [ENTER] to cancel the verification. 

 

5. No Data Found - If there are no records found for the selected parameters, the following 

screen will be displayed. 

 

Figure 152 - File creation: No data found 

To return to the file creation screen and correct the error: 

o Click “Ok” or press [ENTER]. 

 

6. No Records Found - If there are no records found for the selected parameters, the following 

screen will be displayed. 
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Figure 153 - File creation: No records to submit 

o Click Yes to create the closure file. 

o Click No to cancel the process. 
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4.2.11 CIHI MDS (CCRS) - Submission/Correction/Deletion File 

MDS(CCRS) CIHI Insert/Update Data Submission File 

 

Figure 154 – File Management CIHI Insert/Update Data Submission File 

o  - Batch Verify (Shift+F11) – This will reverify all abstracts in the selected Batch 

o  - Create File (F12) – This will create the file, if the Batch Verify is run just click on 

Create File and the file wil will be created.   

o  - Batch Reports(Shift+F10) – This will display the reports function 

o  - Checked Record Locks– checks for locked records 

o  - Reset File Settings – This will reset the file setting below.  The following 

message will display when clicked: 

o Complete Re-verify – checking this box will re-verify every record. 
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o Institution Number – enter the institution number that is to be sent or click on the down 

arrow and choose the institution (only the institutions for the module selected will display) 

o Clinic Year – this is the year the edits will be triggered, this field cannot be changed. 

o Batch Year – this will be blank the first time it is used, entering the fiscal year that is being 

submitted 

o Batch Period – this will default if previous periods have been submitted/enter the period/or 

choose from the drop down list 

o Date from – this will populate with the beginning of the Batch Period (cannot enter into 

this field) 

o Date to – will populated the last date based on the Batch Period (cannot enter into this 

field) 

o Current Batch – the number of assessments that are contained with in the Batch Period 

o Current Batch- Admission – the number of Admission assessments that are contained 

with in the Batch Period 

o Current Batch - Update – the number of Update assessments that are contained with 

in the Batch Period 

o Current Batch - Quarterly – the number of Quarterly assessments that are 

contained with in the Batch Period 

o Current Batch - Full – the number of Full assessments that are contained with in the 

Batch Period 

o Current Batch - Medications – the number of Medication assessments that are 

contained with in the Batch Period 

o Current Batch – Discharge – the number of Discharge assessments that are 

contained with in the Batch Period 

o Total Inserts – number of new assessments included in the file 

o Total Corrections – number of assessments that are being sent as corrections 

o Total Deletes -  number of assessments that are being sent as deletions 

o Total Deletes Medications – number of medication assessments that are being sent 

as deletions 

o Already Sent (In Previous File) – number of assessments that have been 

previously submitted 

o Full Batch Count – total # assessments in the CIHI file 

o Invalid (Is Valid E or N) – This displays the number of assessments that have “N” 

or “E” in the is ‘Is Valid’ field on the abstract.  During the File Create process a message will 

display asking the following: 
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• “Yes” will display the error messages and give the ability to fix the errors 

• “No” will not display the errors and the file will be created without the errors. 

o Verified (Is Valid W or Y) – This displays the number of asessments that have 

“W” or “Y” in the is ‘Is Valid’ field  

o CIHI File Location:  - displays the file location of the CIHI file.  

o  - Abstract menu – used when fixing assessments with 

Errors and Warnings  

•  - Save (F7) – Saves the record 

•  - Undo – Undoes any changes to the record 

•  - Record Verify (F11) – Verifies the Record 

• - Report Manager(F10) – Opens Select Report 

•  - Tools– Click on the different options to change the view at the bottom of the 

abstract  

 

To verify the records to check for errors without creating the file ensure the Complete Re-

verify button is checked and press  or [F11] 

To verify the records to check for errors and create the submission file press  or [F12].  If 

there are errors in the file, the submission file will not create.   

Please see Verifying Records for more information. 
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MDS(CCRS) Reset Submission Status  

When an assessment has been sent to CIHI and has an error, CIHI will send the record back as a 

rejection.  These assessments will need to be corrected and sent in as a new submission.  In 

order, to send it in as a new submission the assessments will need to be reset. 

 

 

To Manually Reset the Submission Status: 

o Open the rejected assessment 

o Correct the error(s) 

o Select File Settings/Re-Set File Create Status  

 

Figure 155 – Re-set File Create Status 

o The following message will appear: 

 

Figure 156 – Re-set File Create Status Message 

 

o Clicking ‘Yes’ will reset the submission status to a ‘N’ 

Please note:  The CIHI Re-set File Create Status needs to be set the User 

Profile/Module Settings/MDS 
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o Click ‘No’ will take you back to the assessment 

o Press [F6]/[F7] to save the assessment. 

o The ‘Is Abstract Submitted’ flag will now change to ‘N’ and the record can be resubmitted via 

a CIHI Submission File – MDS (CCRS) 

MDS(CCRS) Re-set Record Update Status  

When an assessment is saved or created/saved, using this feature allows the user to reset the 
Record Update Status so the interface can still populate the abstract.  This option will only be 
available if the assessment has NOT been submitted to CIHI.   

To Manually Reset Record Update Status : 

o Open the assessment 

o Enter values and save the assessment 

o Select Action/Re-Set Record Update Status  

 

Figure 157 – Re-set Record Update Status 

o The following message will appear: 

 

o Clicking ‘Yes’ will re-set the record update status to a ‘N’ 

o Click ‘No’ will take you back to the assessment 

o Press [F6]/[F7] to save the assessment. 

o If an assessment is submitted then the following message will display: 
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MDS(CCRS) Re-set File Correct Staus 

When a submitted assessment is saved the assessment is flagged as a correction.  Ising this 
feature allows the user to reset the ‘Is File Corrected’ flag from a “P” waiting to be set as a 
correction to a “N” – No correction so the corrected assessment is not sent to CIHI as a 
correction.   

To Manually Re-set File Correct Status : 

o Open the submitted assessment 

o Make changes to the assessment and save the assessment 

o Select Action/Re-Set File Correct Status  

 

Figure 158 – Re-set File Correct Status 

o The following message will appear: 

 

o Clicking ‘Yes’ will re-set the ‘Is File Corrected” = ‘N’ 

o Click ‘No’ will take you back to the assessment and leave the ‘Is File Corrected” = P 

o Press [F6]/[F7] to save the assessment. 

o If an assessment already has a “Is File Corrected” = ‘N” then the following message will 

display: 
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MDS(CCRS) CIHI Corrected Submitted Assessment File  

An assessment that has been submitted and a change is made will trigger the assessment as a 

correction. The correction is submitted via a CIHI Submission File – MDS (CCRS) and the record 

is flagged within the submission file as a correction.   

 

MDS(CCRS) CIHI Deleted Submitted Assessment   

An assessment that has been submitted and is deleted, the deletion will be put into the 

Purge/Recover module is submitted via a CIHI Submission File – MDS (CCRS)  and the record 

is flagged within the submission file as a deletion.     

 

To delete a submitted MDS (CCRS) Assessment: 

• Open the record that needs deletion and Press  or [F9] and the following message 

will display: 

 

Figure 159 – Deleting an Assessment Message 

Yes - will send the record to the Purge/Recover module 

No - will not delete the record.   

 

• The following message will appear when the record has been submitted: 
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Figure 160 – Deleting an MDS Submitted Assessment Message 

• Please note that submitted assessments mut be deleted in reverse order of submission 

(Discharge before Quarterly, Quarterly before Admission etc.)  If you try to delete a 

submitted assessment and the assessment following it has been submitted the following 

message will display: 

 

Figure 161 – Deleting an MDS Submitted Assessment Message 

 

Once a Submission File is run, the deleted record will automatically purge from the 

Purge/Recover Module.   
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4.2.12 CIHI Rehabilitation (NRS) Submissions/Corrections/Deletions 

NRS - CIHI Insert/Update Data Submission File 

 

 

 

Figure 162 – Rehabilitation (NRS) CIHI Submission Screen 

o  - Batch Verify (Shift+F11) – This will reverify all abstracts in the selected Batch 

o  - Create File (F12) – This will create the file, if the Batch Verify is run just click on 

Create File and the file wil will be created.   

o  - Batch Reports(Shift+F10) – This will display the reports function 

o  - Checked Record Locks– checks for locked records 

o  - Reset File Settings – This will reset the file setting below.  The following 

message will display when clicked: 
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o Complete Re-verify – checking this box will re-verify every record, not checking the box 

will not 

o Institution Number – enter the institution number that is to be sent or click on the down 

arrow and choose the institution (only the institutions for the module selected will display) 

o Clinic Year – this is the year the edits will be triggered, this field cannot be changed. 

o Batch Year – this will be blank the first time it is used, entering the fiscal year that is being 

submitted 

o Batch Period – this will default if previous quarters have been submitted/enter the 

quarter/or choose from the drop-down list  

o Date From  – this will default the dates of the Batch Period and can be changed 

o Date To – this will default the dates of the Batch Period and can be changed. 

o Current Batch – the number of assessments that are contained with in the Batch Period 

o Current Batch- Admission – the number of Admission assessments that are contained 

with in the Batch Period 

o Current Batch - Discharge – the number of Discharge assessments that are 

contained with in the Batch Period 

o Current Batch – Follow Up – the number of Follow-Up assessments that are 

contained with in the Batch Period 

o Total Inserts – number of new assessments included in the file 

o Total Corrections – number of assessments that are being sent as corrections 

o Total Deletes -  number of assessments that are being sent as deletions 

o Already Sent (In Previous File) – number of assessments that have been 

previously submitted 

o Full Batch Count – total # assessments in the CIHI file 

o Invalid (Is Valid E or N) – This displays the number of assessments that have “N” 

or “E” in the is ‘Is Valid’ field on the abstract.  During the File Create process a message will 

display asking the following: 

 

• “Yes” will display the error messages and give the ability to fix the errors 

• “No” will not display the errors and the file will be created without the errors. 
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o Verified (Is Valid W or Y) – This displays the number of asessments that have 

“W” or “Y” in the is ‘Is Valid’ field  

o CIHI File Location:  - displays the file location of the CIHI file.  

o  - Abstract menu – used when fixing assessments with 

Errors and Warnings  

•  - Save (F7) – Saves the record 

•  - Undo – Undoes any changes to the record 

•  - Record Verify (F11) – Verifies the Record 

• - Report Manager(F10) – Opens Select Report 

•  - Tools– Click on the different options to change the view at the bottom of the 

abstract  

 

NRS – Data Process Rules 

• An admission assessment must be submitted before a discharge assessment. 

• An admission and discharge assessment must be submitted before a follow-up 
assessment (optional to record). 

• If an encounter requires deletion, the assessments must be deleted in the reverse order 
(ie: follow-up, discharge, admission). 

 

NRS – Record Validation and Submission Date 

• This date will be updated annually by MED2020 via the annual fiscal year update. 

• All assessments submitted after the record validation date must follow the new fiscal year 

edits. 
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• Any submission file created after the Record Validation and Submission Date, regardless 

of the fiscal year being processed, will have the current fiscal year file specifications 

applied. 

NRS – Verification and Submission of Assessments 

• For Verification go to Verification Only 

• For Submission go to Create Submission 

 

 

NRS – Process NRS Admit/Discharge Together 

Go to Options/Institution Profile/Submission/Process NRS Admit/Discharge Together 

• A checkmark allows the admission assessment and the related discharge assessment to 
be processed at the same time for submission. 

Note:  If the value is blank the assessments will be included in the quarterly 
submission. 

 

Note: If the Process Together option is chosen this may result in more than one 
submission file.  The naming convention will reflect the fiscal year and quarter 
applicable to that assessment. 

 

Note: After clicking OK on the Information dialog, the first file listed is displayed at the top 
of the WinRecs CIHI Submission window. It is important to note the files created on 
the Information dialog, so you are aware of which files have been saved to you 
REHAB folder. 

 

NRS - Reset Submission Status  

CIHI does not provide an electronic file of rejected records for the NRS database. However, if 

after submission of data you receive a report of assessments that were rejected, they will not 

have to be corrected and resubmitted. 

Once a record has been successfully validated in WinRecs, and included in a submission file, the 

“Is Abstract Submitted” flag is set to “Y”. For a rejected record, the user will need to set this field 

manually. 

 

 

To Manually Reset the Submission Status: 

o Open the rejected record 

o Correct the error(s) 

Please note:  The CIHI Re-set File Create Status needs to be set in the User 

Profile/[OMHRS] Ontario Mental Health Reporting System 



 [T WinRecs Version 2025.01 User Guide 

© 2025 MED2020 Health Care Software Inc. All rights reserved. Page 204 

o Select File Settings/Re-Set File Create Status  

 

Figure 163 – Re-set File Create Status 

o The following message will appear: 

 

Figure 164 – Re-set File Create Status Message 

 

o Clicking ‘Yes’ will reset the submission status to a ‘N’ 

o Click ‘No’ will take you back to the abstract 

o Press [F6]/[F7] to save the abstract. 

o The ‘Is Abstract Submitted’ flag will now change to ‘N’ and the record can be resubmitted via 

a CIHI Submission File - Rehabilitation (NRS) Submissions  

NRS -  Re-set Record Update Status  

When an assessment is saved or created/saved, using this feature allows the user to reset the 
Record Update Status so the interface can still populate the abstract.  This option will only be 
available if the assessment has NOT been submitted to CIHI.   

To Manually Reset Record Update Status : 

o Open the assessment 

o Enter values and save the assessment 

o Select Action/Re-Set Record Update Status  
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Figure 165 – Re-set Record Update Status 

o The following message will appear: 

 

o Clicking ‘Yes’ will re-set the record update status to a ‘N’ 

o Click ‘No’ will take you back to the assessment 

o Press [F6]/[F7] to save the assessment. 

o If an assessment is submitted then the following message will display: 

 

NRS - Re-set File Correct Status 

When a submitted assessment is saved the assessment is flagged as a correction.  Ising this 
feature allows the user to reset the ‘Is File Corrected’ flag from a “P” waiting to be set as a 
correction to a “N” – No correction so the corrected assessment is not sent to CIHI as a 
correction.   

To Manually Re-set File Correct Status : 

o Open the submitted assessment 

o Make changes to the assessment and save the assessment 

o Select Action/Re-Set File Correct Status  

 

Figure 166 – Re-set File Correct Status 
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o The following message will appear: 

 

o Clicking ‘Yes’ will re-set the ‘Is File Corrected” = ‘N’ 

o Click ‘No’ will take you back to the assessment and leave the ‘Is File Corrected” = P 

o Press [F6]/[F7] to save the assessment. 

o If an assessment already has a “Is File Corrected” = ‘N” then the following message will 

display: 

 

NRS - CIHI Corrected Submitted Assessment File  

 

An assessment that has been submitted and a change is made will trigger the assessment as a 

correction. The correction is submitted via  a CIHI Submission File - Rehabilitation (NRS) 

Submissions) and the record is flagged within the submission file as a correction.   

 

NRS - CIHI Deleted Submitted Assessment   

 

An assessment that has been submitted and is deleted, the deletion will be put into the 

Purge/Recover module is submitted via  a CIHI Submission File - Rehabilitation (NRS) 

Submissions and the record is flagged within the submission file as a deletion.     

 

To delete a submitted MDS (CCRS) Assessment: 

• Open the record that needs deletion and Press  or [F9] and the following message 

will display: 
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Figure 167 – Deleting an Assessment Message 

Yes - will send the record to the Purge/Recover module 

No - will not delete the record.   

 

• The following message will appear when the record has been submitted: 

 

Figure 168 – Deleting an NRS Submitted Assessment Message 

• Please note that submitted assessments mut be deleted in reverse order of submission 

(Discharge before Admission)  If you try to delete a submitted assessment and the 

assessment following it has been submitted the following message will display: 
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Figure 169 – Deleting an NRS Submitted Assessment Message 

 

Once a Submission File is run, the deleted record will automatically purge from the 

Purge/Recover Module.   
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4.2.13 CIHI Ontario Mental Health Reporting System (OMHRS) Submissions/ Corrections/ 

Deletions 

• Go to Tools → File Management → MHRS → CIHI Insert/Update Data Submission 

File 

 

 

Figure 170 OMHRS Submission Screen 

 

o  - Batch Verify (Shift+F11) – This will reverify all abstracts in the selected Batch 

o  - Create File (F12) – This will create the file, if the Batch Verify is run just click on 

Create File and the file wil will be created.   
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o  - Batch Reports(Shift+F10) – This will display the reports function 

o  - Checked Record Locks– checks for locked records 

o  - Reset File Settings – This will reset the file setting below.  The following 

message will display when clicked: 

 

o Complete Re-verify – checking this box will re-verify every record, not checking the box 

will not 

o Institution Number – enter the institution number that is to be sent or click on the down 

arrow and choose the institution (only the institutions for the module selected will display) 

o Clinic Year – this is the year the edits will be triggered, this field cannot be changed. 

o Batch Year – this will be blank the first time it is used, entering the fiscal year that is being 

submitted 

o Batch Period – this will default if previous quarters have been submitted/enter the 

quarter/or choose from the drop-down list  

o Date From  – this will default the dates of the Batch Period and can be changed 

o Date To – this will default the dates of the Batch Period and can be changed. 

o Current Batch – the number of assessments that are contained with in the Batch Period 

o Current Batch- Short – the number of Short Stay assessments that are contained with 

in the Batch Period 

o Current Batch - Change – the number of Change Status assessments that are 

contained with in the Batch Period 

o Current Batch - Quarterly – the number of Quarterly assessments that are 

contained with in the Batch Period 

o Current Batch - Full – the number of Full assessments that are contained with in the 

Batch Period 

o Current Batch - Medications – the number of Medication assessments that are 

contained with in the Batch Period 

o Current Batch – Discharge – the number of Discharge assessments that are 

contained with in the Batch Period 

o Total Inserts – number of new assessments included in the file 

o Total Corrections – number of assessments that are being sent as corrections 

o Total Deletes -  number of assessments that are being sent as deletions 

o Total Deletes Medications – number of medication assessments that are being sent 

as deletions 
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o Already Sent (In Previous File) – number of assessments that have been 

previously submitted 

o Full Batch Count – total # assessments in the CIHI file 

o Invalid (Is Valid E or N) – This displays the number of assessments that have “N” 

or “E” in the is ‘Is Valid’ field on the abstract.  During the File Create process a message will 

display asking the following: 

 

• “Yes” will display the error messages and give the ability to fix the errors 

• “No” will not display the errors and the file will be created without the errors. 

o Verified (Is Valid W or Y) – This displays the number of asessments that have 

“W” or “Y” in the is ‘Is Valid’ field  

o CIHI File Location:  - displays the file location of the CIHI file.  

o  - Abstract menu – used when fixing assessments with 

Errors and Warnings  

•  - Save (F7) – Saves the record 

•  - Undo – Undoes any changes to the record 

•  - Record Verify (F11) – Verifies the Record 

• - Report Manager(F10) – Opens Select Report 

•  - Tools– Click on the different options to change the view at the bottom of the 

abstract  
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OMHRS – Data Processing Rules 

• All record types must be submitted chronologically and in order of occurrence for each 
patient per episode. This avoids possible errors and rejections (ie: an admission 
assessment must be submitted prior to a quarterly or discharge assessment for the same 
patient encounter. 

• The Case Record Number and Chart Number are key identifiers in linking the various 
assessment types during an episode of care. 

• If assessments must be deleted, they must be done so in the reverse order of submission 
(ie: a discharge assessment deleted prior to an admission assessment. 

• For subsequent admissions for the same patient, the first episode must have the 
discharge assessment submitted prior to a next admission assessment being submitted 
(ie: a patient cannot have multiple “open episodes” of care. 

 

OMHRS – Record Validation and Submission Date 

• CIHI mandates that as of their annually specified date, any assessments not already 
submitted that fall in the previous fiscal year, must be submitted under the new fiscal year 
edits/requirements. This date is communicated by CIHI to both their facility clients and 
the licensed vendors. 

• When an assessment is being completed in WinRecs, if it belongs to the previous fiscal 
year’s data, and the current system date is after the Record Validation and Submission 
Date, the most current fiscal year edits/requirements will be applied to the assessment. 

• Further, any submission file created after the Record Validation and Submission Date, 
regardless of the fiscal year being processed, will have the current fiscal year file 
specifications applied. 

• This date will be updated annually by MED2020 via the annual fiscal year update, usually 
released around April 1. 

 

OMHRS – Verification and Submission of Assessments 

For Verification go to Verification Only 

For Submission go to Create Submission 
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OMHRS - Reset Submission Status  

When a record has been sent to CIHI and has an error, CIHI will send the record back as a 

rejection.  These records will need to be corrected and sent in as a new submission.  In order, to 

send it in as a new submission the records will need to be reset. 

 

 

To Manually Reset the Submission Status: 

o Open the rejected record 

o Correct the error(s) 

o Select File Settings/Re-Set File Create Status  

 

Figure 171 – Re-set File Create Status 

o The following message will appear: 

 

Figure 172 – Re-set File Create Status Message 

 

o Clicking ‘Yes’ will reset the submission status to a ‘N’ 

o Click ‘No’ will take you back to the abstract 

o Press [F6]/[F7] to save the abstract. 

Please note:  The CIHI Re-set File Create Status needs to be set in the User 

Profile/[NRS] National Rehabilitation Reporting System 
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o The ‘Is Abstract Submitted’ flag will now change to ‘N’ and the record can be resubmitted via 

a CIHI Submission File - OMHRS Submissions  

 

OMHRS - Re-set Record Update Status  

When an assessment is saved or created/saved, using this feature allows the user to reset the 
Record Update Status so the interface can still populate the abstract.  This option will only be 
available if the assessment has NOT been submitted to CIHI.   

To Manually Reset Record Update Status : 

o Open the assessment 

o Enter values and save the assessment 

o Select Action/Re-Set Record Update Status  

 

Figure 173 – Re-set Record Update Status 

o The following message will appear: 

 

o Clicking ‘Yes’ will re-set the record update status to a ‘N’ 

o Click ‘No’ will take you back to the assessment 

o Press [F6]/[F7] to save the assessment. 

o If an assessment is submitted then the following message will display: 
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OMHRS - Re-set File Correct Status 

When a submitted assessment is saved the assessment is flagged as a correction.  Ising this 
feature allows the user to reset the ‘Is File Corrected’ flag from a “P” waiting to be set as a 
correction to a “N” – No correction so the corrected assessment is not sent to CIHI as a 
correction.   

To Manually Re-set File Correct Status : 

o Open the submitted assessment 

o Make changes to the assessment and save the assessment 

o Select Action/Re-Set File Correct Status  

 

Figure 174 – Re-set File Correct Status 

o The following message will appear: 

 

o Clicking ‘Yes’ will re-set the ‘Is File Corrected” = ‘N’ 

o Click ‘No’ will take you back to the assessment and leave the ‘Is File Corrected” = P 

o Press [F6]/[F7] to save the assessment. 

o If an assessment already has a “Is File Corrected” = ‘N” then the following message will 

display: 
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OMHRS - CIHI Corrected Submitted Assessment File  

An assessment that has been submitted and a change is made will trigger the assessment as a 

correction. The correction is submitted via  a CIHI Submission File - OMHRS Submissions and 

the record is flagged within the submission file as a correction.   

Note: If any of the elements used to identify a unique record require correction after the 
record has been accepted into the CIHI database, the record must be deleted and 
resubmitted. The applicable data elements are: 

Z1: Record Type 
X1: Record ID 
X30: Chart Number 
AA3: Case Record Number 
A1: Assessment Reference Date 

 

• If a Medication Record needs to be added after the assessment has already been 

submitted: 

 Open the assessment that requires the medication record(s). 

 Enter the medication record(s). 

 Exit the Medication Records multiform and save the assessment. 

• A submission file for the fiscal quarter applicable to the assessment the medication 

record(s) were recorded in will then need to be created if the medication records are to 

be submitted to CIHI. A correction record type will process for “parent” assessment and a 

new record type specific to the medication information will be included in the file. 

OMHRS - CIHI Deleted Submitted Assessment   

 

An assessment that has been submitted and is deleted, the deletion will be put into the 

Purge/Recover module is submitted via  a CIHI Submission File - OMHRS Submissions and the 

record is flagged within the submission file as a deletion.     

 

To delete a submitted MDS (CCRS) Assessment: 

• Open the record that needs deletion and Press  or [F9] and the following message 

will display: 
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Figure 175 – Deleting an Assessment Message 

Yes - will send the record to the Purge/Recover module 

No - will not delete the record.   

 

• The following message will appear when the record has been submitted: 

 

Figure 176 – Deleting an OMHRS Submitted Assessment Message 

• Please note that submitted assessments mut be deleted in reverse order of submission 

(Discharge before Quarterly, Quarterly before Admission etc.)  If you try to delete a 

submitted assessment and the assessment following it has been submitted the following 

message will display: 
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Figure 177 – Deleting an OMHRS Submitted Assessment Message 

 

Once a Submission File is run, the deleted record will automatically purge from the 

Purge/Recover Module.   

 

• Medication Records: Medication records that have been submitted along with the 

assessment and then the required deletion can be processed as follows: 

 Open the assessment that contains the erroneous medication record. 

 Select the medication occurrence that requires deletion. 

 Click Delete. 
- or – Press F9. 

 Exit the Medication Records multiform and save the assessment. 

 Repeat this function until the appropriate assessments have been deleted. 

 A submission file for the fiscal quarter applicable to the deleted medication record(s) will 
then need to be created if the deletions are to be submitted to CIHI. The specific 
Medication Records deleted will be flagged appropriately in the submission file. See 
Create a CIHI Submission File for details. 
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4.2.14 Summary Table of Submission Functions 

Function DAD NACRS NRS OMHRS MDS 2.0 CJRR 

Facility 

Information 

File 

Create 

electronically in 

WinRecs 

Create 

electronically in 

WinRecs 

Create 

electronically in 

WinRecs 

Create electronically 

in WinRecs  

Create 

electronically in 

WinRecs 

Uses DAD/ 

NACRS 

institution 

number 

New 

Records 

Submit using 

CIHI 

Submission 

module – 

submit by 

batch period. 

Submit using CIHI 

Submission 

module submit by 

batch period 

CIHI Submission 

module – submit by 

quarter 

Submit using CIHI 

Submission module 

submit by quarter 

IAR- Set “Is this a IAR 

Submission File to “Y” 

Submit using CIHI 

Submission 

module submit by 

quarter 

Submit using 

CIHI 

Submission 

module 

submit by 

batch period. 

Records 

with errors  

Accepted to 

the CIHI 

database, DAD 

error file sent 

to client 

Rejected by CIHI, 

NACRS Rejection 

file sent to client 

Rejected by CIHI, 

rejected records 

report sent to client 

Rejected by CIHI, 

OMHRS Rejection file 

sent to client 

IAR- CCIM notifies 

rejected records 

Rejected by CIHI, 

rejected records 

report sent to 

client 

Rejected by 

CIHI, 

rejected 

records 

report sent 

to client 

Error file Can be 

imported to 

WinRecs via 

Modules/Utilitie

s/Import DAD 

CIHI Errors 

option 

Can be imported 

via the Incoming 

Batch Interface 

module, select the 

NACRS Error 

Import structure 

file 

No electronic error 

file provided 

Can be imported to 

WinRecs via 

Modules/Utilities/Impo

rt OMHRS CIHI Errors 

option 

IAR- N/A 

No electronic error 

file provided 

No electronic 

error file 

provided 

Corrections Update records 

with correct 

information and 

save – record 

flags as 

‘pending’ for 

inclusion in 

next 

Corrections 

file. 

-Rejected records 

are corrected and 

saved in 

WinRecs.   If 

NACRS rejection 

file is not 

imported, use the 

“Reset 

Submission 

Status” function 

for each corrected 

abstract. 

-Importing the 

NACRS rejection 

file re-sets submit 

status to “not 

submitted” 

-Process 

‘corrected’ 

records initially 

rejected, as a 

regular 

submission (CIHI 

Submission 

module) 

-Submitted and 

accepted records 

in NACRS can be 

Rejected records 

are corrected and 

saved in WinRecs. 

Use ‘Reset 

Submission Status’ 

function for each 

rejected abstract. 

Submitted and 

accepted records in 

NRS can be 

corrected.  Open, 

edit and save the 

record.  

Process CIHI 

Submission file for 

the applicable 

quarter. 

Rejected records are 

corrected and saved 

in WinRecs.   If 

OMHRS rejection file 

is not imported, use 

the “Reset 

Submission Status” 

function for each 

corrected abstract. 

-Importing the 

OMHRS rejection file 

re-sets submit status 

to “not submitted” 

-Process ‘corrected’ 

records initially 

rejected, as a regular 

submission (CIHI 

Submission module) 

-Submitted and 

accepted records in 

OMHRS can be 

corrected.  Open, edit 

and save record.  

-Process CIHI 

Submission file. 

-IAR Corrections and 

deletions processed 

the same way. 

Rejected records 

are corrected and 

saved in WinRecs. 

Use ‘Reset 

Submission 

Status’ function for 

each rejected 

abstract. 

Submitted and 

accepted records 

in MDS 2.0 are 

updated using 

specific 

Change/Correction 

assessment types. 

Rejected 

records are 

corrected 

and saved in 

WinRecs 

and re-sent 

as an insert.  

Use the 

“Reset 

Submission 

Status” 

function for 

each 

corrected 

abstract. 

Submitted 

and 

accepted 

records can 

be corrected.  

Open, edit 

and save 

record and it 

will be sent 

as an 

update. 

Both inserts 
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corrected.  Open, 

edit and save 

record.  

-Process CIHI 

Correction file for 

the applicable 

period. 

Rejected records 

must be reset 

manually. 

and updates 

are sent 

through the 

submission 

module.  

 

Deletions When 

submitted 

abstract is 

deleted, it is 

flagged in the 

Purge/Undelete 

area and will be 

included in a 

deletion file 

next time the 

CIHI 

Corrections are 

processed. 

When submitted, 

accepted, record 

is deleted, it is 

flagged in the 

Purge/Undelete 

module and will 

be processed 

using the CIHI 

Correction 

module.   

Submitted, 

accepted, record is 

deleted, it is 

flagged in the 

Purge/Undelete 

module and will be 

processed using 

the CIHI 

Submission 

module.   

When submitted, 

accepted, record is 

deleted, it is flagged 

in the Purge/Undelete 

module and will be 

processed using the 

CIHI Submission 

module.  Same 

Process for IAR 

Deleted 

assessments that 

have been 

submitted to CIHI 

are flagged in the 

Purge/Undelete 

module and will be 

picked up as a 

record type 

deletion when a 

submission file for 

that quarter is 

created. 

Email CIHI 

Liason and 

include 

Record ID, 

Surgeon ID, 

Patient’s 

Name, Joint 

Type, Date 

of Surgery 

and 

Procedure 

for deletion. 
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4.3 Batch Grouper  
The Batch Grouper ensures that the correct grouper values are assigned to the visit.  The Batch 

Grouper should be run prior to creating Submission Files.  

Using the Batch Grouper 

Tools → Batch Grouper 

Choose the module you would like to regroup: 

 

Figure 178 – Batch Grouper 

o Institution Number – Enter the number or click on the drop-down arrow 

o Date From – The start date of the batch 

o Date To – The end date of the batch 

o Batch Year – This will default depending on the dates chosen above.  

o Only Valid Abstracts – if checked it will only Batch Group valid records where the ‘Is 

Validated’ in the abstract is ‘Yes’, if not checked Batch Group all records.   

o Flag Changed Records for Correction - This is an optional function when checked any 

records that have been submitted will be flagged for Correction (sent as a correction file).    

Only records found to have changed grouper data would be flagged. 

o Store Optimized Data - Defines if the Batch Grouper will store grouper data for other 

diagnoses. See below section on Store Optimizing Data. 
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o Clear Optimized Data After - If Store Optimizing Data is selected, optimizing data will 

automatically be purged after the specified period. Select the dropdown menu to see a 

list of the available options. See below section on Store Optimizing Data. 

 

o Check Locks – checks for locked records 

o Clear Locks – clears locked records 

o Press the  to start the process 

o The green bar will move while processing the records 

o Once the prosses is complete the following will display. 

 

Figure 179 – Batch Grouper – Finished Processing 

 

o The process is now complete.  
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4.4 Batch Interface 

A Batch Interface is used to import text files that contain specifically formatted patient data, into 

WinRecs. This data is produced by an external patient records system, such as an ADT system. 

The Interface allows HIMs to bring across patient record data to WinRecs without the need for 

data re-entry.  

 

Note: Batch Interfaces are custom built. If you have any questions regarding this process, contact 
a MED2020 Client Services Representative. Contact information is available above in the 
section ‘Contact MED2020’. 

 

Importing with Batch Interface 

 

Note: Installation/ Updates files and instructions must be supplied by MED2020.  Instructions 
are not provided in this guide as they vary from customer to customer.  Do not proceed 
with the following instructions until you have contacted a Client Services representative 
for assistance. 

 

The following steps require access to WinRecs and can be performed by a Health Information 

Management professional in your facility. If a member of IT Services will be performing these 

steps a login to WinRecs will be required. 

 

The following screen opens when you select Tools → Batch Interface 

  

Figure 180 - Batch Interface window 

o Click the Search button  in the window. 
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— or — 

o Press [F4]. 

o Search for the Batch Interface text file on your computer network. Select the filename and 

click Open. 

Note: Contact your WinRecs administrator to learn where the import files are located in your 
particular environment. 

 

o The name of the file being imported is shown on the Batch Interface window. 

o Click the Execute button  in the window.  

— or — 

o Press [F11]. 

o A processing bar will show as the records are imported.  

o Error messages will be displayed on the same screen if there is any.  

o Once the import is finished, close the window by clicking the icon . The records are 

now in the CPI MODULE and appropriate modules.  
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4.5 Purge/Recover 

This module is to completely recover or purge deleted abstracts or CPI MODULE entries.  

To access Purge/Recover 

Tools →Purge/Recover 

 

Figure 181 – Purge/Recover Screen 

 

To Purge an Abstract 

o Click on the module the abstract was deleted from. 

o A list of all the deleted records will display 

o Put a checkmark beside the record that needs to be purged 

o Click on any column header to sort by that column.   

If a deleted record has been sent to CIHI, a Deletion File must be created first.  See 

CIHI Deletion File.  Once the file has been created the deleted abstract will purge from 

Purge/Recover file.  Abstracts should also be purged for a period before running CIHI 

Submissions, CIHI Corrections or reports.  
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Figure 182 – Purging a Record 

o Click on the  or [F9] to purge the abstract.  This will remove it from all reports and 

the database. 

o The following message will display: 

 

Figure 183 – Purge Message Prompt 

Clicking ‘YES’ will purge the record 

Clicking ‘NO’ will go back to the Purge/Recover Screen.   
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o If a record that is being purged has been submitted to CIHI, the following message will 

appear: 

 

Figure 184 – Purging Abstract Already Submitted to CIHI 

o Clicking ‘YES’ will purge the record and the record will not be sent to CIHI as a deletion. 

o Clicking ‘NO’ will go back to the Purge/Recover Screen and send the record to CIHI via, the 

CIHI Deletion File.   

o If a record has been merged and has been flagged as a sending the record as a deletion to 

CIHI, the following message will appear 
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To Recover an Abstract 

o Click on the module the abstract was deleted from. 

o A list of all the deleted records will display 

o Put a checkmark beside the record that needs to be recovered: 

 

Figure 185 – Recovering an Abstract after Deletion 

o Click on the  or [F8] – Recover to recover the record.  

o The following message will display: 

 

Figure 186 – Recover Abstract Prompt 

o Clicking ‘YES’ will recover the record 

o Clicking ‘NO’ will go back to the Purge/Recover Screen.   

4.6 Database Update History 

This gives the user to run patches in WinRecs.   

o Download the patch to a directory (as per site policy) 

o If the file has .zip, unzip it in the directory you have downloaded to 

o Log in WinRecs 
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o Tools →Database Update History 

 

Figure 187 – Database Update History 

 

o Press the  and look for the patch in the file directory it was saved in. 

o Press the to process the file.   

o The green bar will run and tell you when completed 

o For the patch changes to be seen, users must log out and back in.  
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4.7 Edits Management Tool (EMT) 

User Profile 

There is a field in User Profile that needs to be modified.   

Access Edits Management-Yes 

 

 

Tools>Edit Management 

 

 

 

EMT Editor window will display 

 

What is an Operator? 

An operator are special symbols or words that describe an operator or an action 

to take place between two or more values. 
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Operators 

Any Value/Blank (no value) 

Equal To/Not Equal  

Like/Not Like 

Start With/Not Starts With 

Less/Less or Equal 

Greater /Greater or Equal 

And/Or 

 

 

What is a Condition? 

Sometimes referred to as a conditional expression and conditional processing, a 

conditional statement is a set of rules performed if a certain condition is met. 

Field Condition- A Field Condition is a when a field refers to value(s) or a field 

that refers to another field. 

Logical Condition- Logical Condition is a combination of field conditions or field 

conditions and other Logical Conditions.  A statement that combines the results 

of two component conditions to produce a single result. 
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Condition Editors 

 

Two icons in tool bar 
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Field Condition Editor 

 

Select Module in drop down 

 

New Condition 
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Field Condition Name 

Name the Field Condition you are creating.   

Suggestion: For your Field Conditions, establish a naming convention .  If the field condition is 

referring to Diagnosis, name the Field Condition Diag, Dx, Intervention, Intv l  The list of 

conditions will sort in alphabetical order based on the name. 

Fields 

Use the green arrow   to display the module fields available. 

Type field name to select from list 
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Use occurrence 

First 

• For fields in main grid, first occurrence will always be selected   

• In a multiform this first occurrence refers to the MAIN occurrence 

All 

• In a multiform this refers to all occurrences from fist occurrence and greater 

Last 

• In a multiform this refers to the last/maximum occurrence number 

Occurrences (>1) 

• In a multiform this refers to other occurrences in a multi form EXCEPT firs occurrence   

 

Field condition operators 

• Any Value/Blank (no value)- When selecting a field, this operator refers to 

a value or no value. 

 

• Equal To/Not Equal- When selecting a field, this operator refers to an 

EXACT value or NOT EXACT value.  The value in condition can be more 

than one value.   

Example: 
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Admit Category = L 

Admit Category = L, E, N 

  

• Like/Not Like- When selecting a field, this operator refers to a field that 

contains the value or not like the value. 

 

• Start With/Not Starts With- When selecting a field, this operator refers to a 

field that begins not not begins with this value. 

Example: 

Diagnosis Code starts with K29 

 

• Less/Less or Equal- When selecting a field, this operator refers to a 

NUMBER data type field.   

Example: 

LOS Days <20, LOS <=20 

 

• Greater /Greater or Equal- When selecting a field, this operator refers to a 

NUMBER data type field 

Example: 

LOS Days >20, LOS>=20 

 

• Between/Not Between - When selecting a field, this operator refers to a 

NUMBER data type or a STRING data type field 

Example: 

LOS Days is Between 10 to 25 

Diagnosis Code is Between I60 to I68.9 

 

Comparison type 

• Compare Field- A specific field and it’s value compared to another specific field and it’s  

value. Example:   

Admission Date = Discharge Date 

Triage Date > Registration Date 

 

• Compare Values(s)- A specific field that refers to values 

Example: 

Admit Category = L 

Diagnosis Code like K29 

Patient Service =10 
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Logical Condition Editor 

 

Select the module 

 

 
New Condition 

 
 

 

Logical Condition Name 

• Name the Logical Condition you are creating. 

Logical condition operators 

FIELD condition AND FIELD condition 

LOGICAL condition AND  FIELD condition 
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LOGICAL condition And FIELD condition OR FIELD condition 

LOGICAL condition AND LOGICAL condition 

LOGICAL condition OR LOGICAL condition 

 

• And/Or- used to connect field conditions or to connect field conditions with 

Logical Conditions. 

 
 

• Click the  to select the Conditions 

• Click F2 to see a list of Conditions 
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Save F7 

 
 

Same Occurrence (Multiforms) 

When combining two or more conditions (Field and/or Logical Condition) together, it is possible to 

create a Logical Condition that refers to fields in a multiform.  The edit may refer to fields from the 

SAME Occurrence. 

When click on Same Multiple Occurrence Group, a drop down list will display all the multiform 

sections. 
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To select a conditions click the  to enable the Condition field. 

 

Click F2 to display the list of Conditions to select from. 
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When select the Field and/or Logical Conditons, they will display in a list. 
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Save F7 

 
 

 

Delete Condition 

If the Logical Condition is not for the Same Occurrence, click the Del. Condition button. 

F9 Delete 
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Click Yes to delete this logical condition. 
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Create Edit Message 

Tools>Edits Management Tool (EMT) 

 

Select Module 
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Click  

Areas of the Edits Management Tool Editor 
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1. Select Module 

In order to enable the editor, must first select the module. The edit will only display in the 

module you select. 

 

2. Edit Name 

The name usually reflects the fields and conditions involved. 

 

3. Edit Rule Severity Level 

In the abstract in the message list box, the content is represented by a severity level.  All 

EMT edit icons will have a turquoise frame.   

Dark Red Critical 

Red  Error 

Yellow  Warning 

Blue  Information 

  

4. Message Content 

The content that will display in the abstract. 

1 

2 

3 

4 

5 
6 
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5. Condition Types 

Must create and select the Field and Logical Conditions that will be used in the Edit. 

 

6. Valid From and To date 

Edit must have a Valid From and Valid To date in order to generate.  The edit will 

generate based on the key date of the abstract.   

 

7. F4 to search for existing edits 

 

Search F4 for existing edits 
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Creating an Edit 

Scenario 

When the ER visit has a Death Disposition Code and the Triage Level is not 

Resuscitation generate a message. 

MESSAGE:  

“Death Disposition must have a Triage Level 1” 

 

Step 1: Create Field Condition(s) 

 

Click on Field Condition Editor 

 

 
 

 

1. Select Module 

2. Click NEW 

3. Name Field Condition 
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4. Select Field 

5. Select Occurrence if necessary 

6. Select Operator 

7. Select Comparison Type 

8 Click PLUS sign and select values 

 

 

2 

3 

1 

4 

6 

7 

8 

5 
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Click Save Icon  to save value(s)  
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Field Condition #1 

MIS Code =713102000 

Condition type to evaluate edit 

 Field Condition 

New [F5] 

Field Condition Name 

 FLD ER MIS Code 713102000 

Select Field in Drop Down 

 Visit MIS Code 

User Field Occurrence 

 First Occurrence 

Field Condition Operator 

 Equal To 

Comparison type 

 Compare value 713102000 

Click Plus Icon    to add value(s) 

Click Save Icon  to save value(s)  

Save Condition 



 [T WinRecs Version 2025.01 User Guide 

© 2025 MED2020 Health Care Software Inc. All rights reserved. Page 253 

 
 

Field Condition #2 

Death Disposition = 10 or 11 

Condition type to evaluate edit 

 Field Condition 

New [F5] 

Field Condition Name 

FLD Death Disposition Code 10 or 11 

Select Field in Drop Down 

 Visit Disposition Code 

User Field Occurrence 

 First Occurrence 

Field Condition Operator 

 Equal To 

Comparison type 

 Compare value 10, 11 
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Click Plus Icon    to add value(s) 

Click Save Icon  to save value(s)  

Save [F7] 

 

 

Field Condition #3 

Triage Level not 1-Resusitation 

Condition type to evaluate edit 

 Field Condition 

New [F5] 

Field Condition Name 

FLD Triage Level not 1-Resusitation  

Select Field in Drop Down 

 Triage Level 

User Field Occurrence 
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 First Occurrence 

Field Condition Operator 

 Not Equal To 

Comparison type 

 Compare value 1 

Click Plus Icon    to add value(s) 

Click Save Icon  to save value(s)  

Save [F7] 

 

 

 

Step 2: Create Logical Condition(s) 

Click on Logical Condition Editor 
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1. Select Module 

2. Click NEW 

3. Logical Condition Name 

4. Select Operator 

5. Select PLUS sign to add conditions 

6. Click save to save conditions involved 

7. Click save in Tool Bar  
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1 

7 

3 

4 

6 

2 

5 
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Step 3: Create Edit 

1. Select the Module 

2. Click New 

3. Edit Name 

4. Select Severity level 

5. Input Message 

6. Select Condition Type 

7. Enter Valid From and Valid To date 

8. Click on Logical Condition icon and select Logical Condition 

9. Click save icon to save Edit.   

 

 

 

 

1 

2 

3 

4 

5 

6 7 

8 

8 
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Deleting an Edit 

In order to delete an edit so it no longer displays in the abstract, click F9 Delete 

Delete Logical Condition 

In order to delete a Logical Condition, it cannot be used in another edit or another 

Logical Condition.  To delete a Logical Condition click  F9 Delete 

If a Logical Condition is used in another edit, a prompt will display. 

 

 

 

Delete Field Condition 

Field Conditions can only be deleted if not used in a Logical Condition or another 

edit.  In order to delete a Field Condition click F9 Delete 

If a Field Condition is used in another edit, a prompt will display. 
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Access visit and verify abstract 

Amcare Abstract 

Message should generate in message list box.  If message does not generate 

upon load, F11 Verfiy. 

 

 

Is Custom Validated field 

In the abstract there is a field called ‘Is Custom Validated’.  The Valid Values are: 

Yes  

When there are no EMT messages generated when abstract is verified, the field will populate a Y. 

 

Custom Errors Found 

When there are EMT messages that contain errors, the field will populate an E. 

 

Custom Warnings Found 

When there are EMT messages that contain warnings, the field will populate a W. 

 

Custom Information Found 

When there are EMT message that contains information, the field will populate an I. 
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No 

When EMT message are not yet verified in the abstract, this field will populate an N. 
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Batch Verify 

An option to verify all visits to see if EMT edits apply.   

Tools>File Management>Submission File 
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Select Edit Library 

 

Both System and Custom Edits 

This will perform the verify on the CIHI or provincial edits along with EMT edits at the same time. 

 

Only Custom Edits 

This will perform the verify on the EMT edits only. 

 

Only System Edits 

This will perform the verify on the CIHI and provincial edits only. 

 

When click Verify 

 



 [T WinRecs Version 2025.01 User Guide 

© 2025 MED2020 Health Care Software Inc. All rights reserved. Page 264 
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Report Generator 

Existing views have been modified 

AbstractingErrorsWarnings_VR 

Message Level: Custom Errors 

  Custom Warnings 

  Custom Information 

I10 views 

The ‘Is Custom Validated’ field has been added to all the I10 views. 

 

A report called EMT Incomplete Abstract List has been developed.   
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Access Visit and Verify Abstract 

Amcare Abstract 

Message should generate in message list box.  If message does not generate upon load, F11 

Verify. 

 

 

Is Custom Validated field 

In the abstract, there is a field called ‘Is Custom Validated’. The Valid Values are: 

Yes  

When there are no EMT messages generated when abstract is verified, the field will populate 

a Y. 

 

Custom Errors Found 

When there are EMT messages that contain errors, the field will populate an E. 

 

Custom Warnings Found 

When there are EMT messages that contain warnings, the field will populate a W. 
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Custom Information Found 

When there are EMT message that contains information, the field will populate an I. 

 

No 

When EMT message are not yet verified in the abstract, this field will populate an N. 

 
 

Batch Verify 

An option to verify all visits to see if EMT edits apply.   

Tools>File Management>DAD>CIHI File Submission 

 
 

Please Note: For Amare select Tools>File Management>NACRS Level 3>CIHI File 

Submission 
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Select Edit Library 

 

 

Both System and Custom Edits 

This will perform the verify on the CIHI or provincial edits along with EMT edits at the same 

time. 

 

Only Custom Edits 

This will perform the verify on the EMT edits only. 

 

Only System Edits 

This will perform the verify on the CIHI and provincial edits only. 

 

When click [F11] Verify 
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Report Generator 

Existing views have been modified:  

AbstractingErrorsWarnings_VR 

Message Level:  

Custom Errors 

  Custom Warnings 

  Custom Information 

 

I10 views - The ‘Is Custom Validated’ field has been added to all the I10 views. 

 

A report called EMT Incomplete Abstract List has been developed.   
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5. Using WinRecs 

WinRecs uses common features throughout the application. This section will explain how to use 

these features.  

5.1 Searching for a Record 

The Search feature allows you to look for a record in WinRecs.  Most facilities that have a batch 

or HL7 interface transferring records into WinRecs will use this to locate records. 

The Record Search window 

 

Figure 188 - Record Search Window 

1. Search Options menu – Allows you to toggle to the “View Deleted Records” option. 

2. Search module title – This displays the records types that will be searched. In our examples 

the [DAD] AbsCare Inpatient records will be searched. 

3. Search module menu – This panel allows the user to select the module that will be searched. 

4. Select Search Field – These ten (10) buttons allow the user to select which field(s) will be 

queried, e.g. “Last name”. These fields give you the ability to refine your search. 

5. Search criteria textbox – In the textbox the user will enter the search criteria, e.g. “Smith”. 

6. Field Search option – These checkboxes allow the user to tailor the search for each field 

selected. Details of these options are discussed in the section, Field Search Options 
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7. Find Record – When pressed, this button will start the search. If results are found they will be 

displayed in the Search Result window. If no records are found, the criteria textbox 

background will be displayed in red, indicating that no records were found. 

To Search 

o Press [F4]. 

— or — 

o Select the menu option Actions → Find. 

— or — 

o Click the Search button on the toolbar . 

 

Step 1 – Select the module on which you would like to perform the search.  

 

Figure 189 - Search Step 1 
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Step 2 – Click the Select Search Field. 

Step 3 – Select the first field on which you would like to search. 

To quickly move through the list you can type the first letter of the field name, e.g. to 

move near “Last Name”; type “L”.  (Pressing a letter repeatedly will move you 

alphabetically through the choices beginning with that letter). 

 

Figure 190 - Search Steps 2 & 3 

 

 

Good Practice – When searching for a birth date you should always use 

exact match. 

When searching a date field only the year and the month entered will be used. E.g. 

searching “Date of Visit” with “2013/04/00” will yield all admissions from the month 

of April 2013. To locate a specific date, select the Exact Match checkbox which will 

then match on the day field as well as the year and month. 
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Step 4 – Enter the criteria for your search and select your search option for this field. 

 

Figure 191 - Search Step 4 

This example will search for all patients that have “Testing” in their last name. 

 

Field Search Options 

Exact Match – When this check box is selected  it will force the search to look for the exact 

value entered, excluding case sensitivity. “Last” and “last” will return the same result. This option 

should be used to restrain the size of the results list when the exact value is known, e.g. Chart 

Number. 

 

 

Show Results – When this check box is selected   the field searched will be displayed in the 

Search Results window.  

A good use of exact match is looking for a specific chart number. 

The Search is interactive. When the Search window is open you cannot interact with 

any other portion of the application until the Search window is closed.  
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Search Results 

The Search Results window will be displayed if records matching the criteria are found. 

 

Figure 192 - Search Results 

1. The grid displays the search results.  

2. The records found indicator. In our example 5 records were found.  

3. Select Record button – To select the desired record 

Double click the record you want to open. 

— or — 

a. Select the record you want to open. 

b. Click the Select Record button. 

 

 

The search result grid can be tailored as described in the section Grid Manipulation. 

If too many records are found, refine your search by adding criteria. 
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5.2 Creating a New Record 

Creating a new record in a module will create a module specific record, but the steps to create a 

new record in the WinRecs modules are common to all of them. This section will describe the 

steps to create a new record in the WinRecs modules. CPI MODULE will be used as the 

example; the steps are similar for the abstracting modules. The difference between CPI MODULE 

and the abstracting modules will also be depicted.  

To create a new record not in the CPI MODULE 

o Press [F5]. 

— or — 

o Select the menu option Actions → New. 

— or — 

o Click the New button on the toolbar  . 

To select the module in which the new record will be created 

If no module is selected the Select module window will be displayed; select the module in which 

you would like to create the new record.  
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Figure 193 - Select Module 

If the CPI MODULE module is selected, a new CPI MODULE record is created and the focus is 

automatically placed on the first field where data can be entered.  

 

If an abstracting module is selected and the patient is not in the CPI MODULE: 

A record search window will pop up, enter the chart number, patient name or whatever you are 

searching by: 

 

Figure 194 – Record Search Window 

o Press Find Record or press Enter 

o WinRecs will search for the chart number in the CPI MODULE, if the chart number has never 

been entered into WinRecs the following will happen: 
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Figure 195 – Create a new chart message 

o Pressing No, will take you back to the search record screen 

o Pressing Yes, will take you to the CPI MODULE to create the record.  The Chart Number 

field will populate with the new chart number entered on the search screen. 

 

Figure 196 – Create New Chart in CPI MODULE 

o Enter the following fields Last Name, First Name, Birth Date and Gender in the CPI 

MODULE and any other fields required.   

o Press F6/F7.   



 [T WinRecs Version 2025.01 User Guide 

© 2025 MED2020 Health Care Software Inc. All rights reserved. Page 280 

o Click on the [DAD] AbsCare Inpatient tab

 

Figure 197 – [DAD] AbsCare Inpatient 

o Press [F5]  

— or — 

o Select the menu option Actions → New. 

— or — 

o Click the New button on the toolbar   

o The information you had entered should populate in this case the chart number: 

 

Figure 198 – Record Search Window 

o Press Find Record and the Search Results screen will appear.   
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Figure 199 – Create new record selection 
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To select the desired record: 

o Double click the record you want to open. 

— or — 

o Select the record you want to open and click the Select Record button 

o A new record will display a status of “New” in the header. 

 

Figure 200 - Record in New Module 

The information entered in the CPI MODULE and any default information will populate the record.  

Enter the abstract as per your usual data collection as per your Hospital Policy and CIHI 

guidelines. 

 

 

 

 

Create a new abstract already in the CPI MODULE 

o Press [F5]. 

— or — 

o Select the menu option Actions → New. 

— or — 

o Click the New button on the toolbar   

 

When saving the abstract, please ensure the key fields are entered into the Abstract, 

they include Institution Number, Discharge Date and Discharge Time (for DAD) and 

Registration Date & Time (NACRS).  If any of these three fields are not entered, a 

critical message will occur and the record will not be saved.   

The feature of creating a new record should not happen often as an abstract will be 

brought over by your HL7 or Batch Interface.   
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A record search window will pop up, enter the chart number:

 

Figure 201 - Create New Abstract Search Window 

WinRecs will search for the chart number in the CPI MODULE, if the chart number has been 

entered into WinRecs the following will happen 

o Press Find Record. 

— or — 

o Press enter. 



 [T WinRecs Version 2025.01 User Guide 

© 2025 MED2020 Health Care Software Inc. All rights reserved. Page 284 

 

Figure 202 – Create New Abstract Search Results 

o To select the desired record: 

• Double click the record you want to open. 

— or — 

• Select the record you want to open and click the Select Record button 

o A new record will display a status of “New” in the header. 

 

Figure 203 - Record in New Module 

The information entered in the CPI MODULE and any default information will populate the record.  

Enter the abstract as per your usual data collection as per your Hospital Policy and CIHI 

guidelines. 

5.3 Editing an Existing Record 

A record will always open in READ-ONLY mode, you can enter information in Read-Only mode, 

but will need to put the record into Edit mode to save the record.    
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Figure 204 - Record in Read-Only mode 

In order to save the modification of a Read-Only record you must set it to Edit mode. 

To edit a read-only record 

o Press [F6]. 

— or — 

o Select the menu option Actions → Edit. 

— or — 

o Click the Edit button on the toolbar  . 

 

Figure 205 - Record in edit mode 

 

Once the record it saved, it will revert back to Read-Only.  

 

 

You can enter data in the READ ONLY mode, when you are ready to save it is 

suggested to press Edit then Save (F6/F7). 
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When you make changes to a record and Save [F7] in ‘Read-Only’ mode will result in the 

following question prompt:

 

Figure 206 – Message when chart is in Read-Only Mode 

o Click Yes to save the record. 

o Click No to discard the changes. 

— or — 

o Highlight Yes using the [TAB] key, then press [ENTER] to save the record. 

o Highlight No using the [TAB] key, then press [ENTER] to discard the changes. 

 

5.4 Adding Notes to the Abstract 

 
To make notes to an abstract the following icon will display when the abstract is open: 

 

Figure 207 – Notes Icon 

o When there are no notes for the record the icon will have a Plus sign.  

o When there are notes for the record the icon will have no Plus sign.  

 

Notes Window 

o Open an abstract in any module 

 



 [T WinRecs Version 2025.01 User Guide 

© 2025 MED2020 Health Care Software Inc. All rights reserved. Page 287 

 

o Select the Module Notes  or use the shortcut key to access the notes window is [Alt 

+ F3] and the Notes Window will open. 

 

 

Figure 208 – Notes Window 

o The Notes Window has a toolbar with the following icons: 

•  to create a new note  [F5],  

• undo changes  [F8],  

• delete changes  [F9]  

• to return the home page  [F10].  

o There is a Date Logged panel which displays the list of dates which notes were logged.  

o When selecting a date, the note entered will populate on the screen, by default the last note 
will be populated.  

To create a note: 

o Press the  or [F5] 

o The date, time and coder who logged the note will populate.  

o Click on the second column and type your note 

 

o Press  to go back to the screen and your note is saved 

 

 

To delete a note: 
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o With an abstract open click on the note icon  

o Highlight the Date Logged (there can be more than one date, highlight the one to be 
deleted) 

o Press  or [F9] 

o A message will display 

 

o Click Yes to delete or Click No to not delete.   

5.5 Verifying a Record 

Before saving a record, the user should always verify the data that has been entered. The result 

of the verification will be displayed in the Message List window. The error messages are 

displayed as the data is entered and removed as the errors are corrected. In some instances, 

some messages are related to multiple fields; modifying one field may modify the message of the 

other field.  

o Press [F11]. 

— or — 

o Select the menu option Actions → Verify. 

— or — 

o Click the Verify button on the toolbar .   
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When a record is verified the messages or edits for the record will be displayed in the Message 

List. 

 

Figure 209 - Message List showing verification results 

5.6 Saving a Record 

New or modified records should be saved before closing the window in which the record is 

displayed.  To save a new or modified record: 

o Press [F7]. 

— or — 

o Select the menu option Actions → Save. 

— or — 

o Click the Save button on the toolbar . 
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When a user tries to close a new or modified record before saving it, WinRecs will display a 

message asking the user to save or discard the changes. The message box will be as follows. 

 

Figure 210 - Saving a Record 

o Click Yes to save the record. 

o Click No to discard the changes. 

— or — 

o Highlight Yes using the [TAB] key, then press [ENTER] to save the record. 

o Highlight No using the [TAB] key, then press [ENTER] to discard the changes. 

 
 

o Click the “Show Changed Fields List” button to display all fields that have been changed. 
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5.7 Undoing a Record 

In some instances, changes may need to be undone. In this case, you can undo all the changes 

done since the last time the record was saved or since the record was opened.  To undo 

changes: 

o Press [F8]. 

— or — 

o Select the menu option Actions → Undo. 

— or — 

o Click the Undo button on the toolbar  . 

 

After activating the Undo feature the system will prompt you to confirm the action. 

 

Figure 211 - Undo confirmation 

 

 

o Click Yes to undo the changes. 

o Click No to keep the modified data. 

— or — 

o Highlight Yes using the [TAB] key, then press [ENTER] to undo the changes. 

o Highlight No using the [TAB] key, then press [ENTER] to keep the modified data. 

  

All unsaved changes will be lost after confirming the undo action. 
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5.8 Deleting a Record 

This function deletes the entire abstract, occurrence or item in the module the program is focused 

on.  If the entire abstract or CPI MODULE entry is deleted it will be stored in the Purge module 

until it is completely purged from the system.   To delete a record: 

o Press [F9]. 

— or — 

o Select the menu option Actions → Delete. 

— or — 

o Click the Delete button on the toolbar  . 

 

After selecting the Delete action, the system will generate a prompt to confirm the action.  

 

Figure 212 - Deletion confirmation 

 

 

o Click Yes to delete the record. 

o Click No to keep the record. 

— or — 

o Highlight Yes using the [TAB] key, then press [ENTER] to delete the record. 

o Highlight No using the [TAB] key, then press [ENTER] to keep the record. 

 

Deleted abstracts or CPI entries are moved to the purge module and will show up 

on reports as they are still in the database.  Users will need to create a Purge 

procedure with the deletions to ensure reports are accurate.  See 

PURGE/RECOVER 

Deleted records are moved to the purge module and are only removed from the 

system if a purge is performed. 
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5.9 Message List Window 

The Message List window is used to display warnings, errors and information. 

The following statements may be seen in the Message List window. 

 
Critical: displays when there’s a critical error on a specific field. The record will not be 

saved and submission will fail. 

 
Error: displays when there’s an error on a specific field. The record will be saved, but 

submission will fail. 

 
Warning: displays when there’s a warning on a specific field. The record will be saved and 

submitted. 

 
Exception: displays when an exception occurred on a field. 

 
Question: displays when a question requires an answer from the user. 

 
Information: displays when more information is available for the user. 

Table 13 - Message List Icons with Descriptions 

An example of the Message List window showing various types of warnings and errors is as 

follows: 

 

Figure 213 - Message List example 

Clicking a specific field in a message will automatically set the focus of the application to that 

field. For example, clicking on Gender will set the focus of the application on the Gender field in 
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the abstract, allowing you to select a gender. If the field with the error is part of a multi-form the 

multi-form will be opened. 

The icon can be clicked to collapse a specific message. The message will still be displayed but 

the field details will no longer be visible. 

 

Figure 214 - Message List example with messages collapsed 

5.10 Patient Visit History 

The Patient Visit History displays abstracted and non-abstracted visits.   

 

Figure 215 – Patient Visit History 

 

The color graphic represents the status of the abstract in the visit history as follows: 

 Abstract is saved and complete 

Abstract is saved with errors 

Abstract is saved with warnings 

Abstract is not complete and has not been saved  
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5.11 WinRecs Navigation 

Moving from fields to fields can be done by: 

o Pressing [ENTER] – to move to the next field 

— or —  

o Click on the desired field 

— or —  

o Using the keyboard arrows to move up or down 

Field background description 

 

Read-only field 

 
Edited field 

Table 14 - Field Background Description 

Footer 

The footer displays information about the currently selected field on the field grid. 

 

Figure 216 - Module footer 

The following information’s are displayed in the footer: 

108 CIHI Field ID – this field displays the identification number of the CIHI field 

Complete Record User defined description – same as on the grid. 

2 Field length – this is the maximum length of the field 

Look Up Field type – this is the type of field. The possible values are look up, date, time, 

numeric or text. Each field type will dictate the information you are allowed to 

enter in the field. The format are described below in Table 15 - Footer Field 

Information 

 

 

 

Field type format 

Complete Record CIHI Field description – this field displays the description of the CIHI field  

Table 15 - Footer Field Information 
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Field type format 

The field types determine the formats and valid values that can be entered in the field. 

Look up This type of field only accepts values for a redefined list. E.g. the Gender field 

can only accept the values F, M, O, or U. To view or select the value from the 

list of valid values press [F2] 

Date This type of field only accepts date values. The format is YYYY/MM/DD 

Time This type of field only accepts time values. The format is HH:MM 

Numeric This type of field only accepts numeric values; 0-9. 

Text This type of field only accepts text values. A-z, A-Z. 0-9 

Table 16 - Field Type Format 

Group Field List 

The group field list allows the user to quickly navigate through the list of fields of a record. When 

a group is expanded the list of fields for that group will be displayed. 

 

Figure 217 - Group field list 
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Expanding/Collapsing a group 

o To expand a group click  

— or —  

o To collapse a group click  

To select a field in a group 

Selecting a field in a group will navigate to that field in the grid. 

o Expand the desired group by click the  

o Click the desired field in the group. 

 

Figure 218 - Group field list selection 

 

 

 

  

Selecting a field that is part of a multi-form will open the multi-form window. 
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Fields grid parts 

 

Figure 219 - Fields grid parts 

 

1. Required fields – system mandatory fields each symbol has a different meaning.   

 

System Required: WinRecs required field.  Must have data entered to save. 

 

CIHI Required: Mandatory data element for submission to CIHI. 

 

CIHI Submitted: Data entered in field submitted to CIHI. 

 

Provincial or Module Required.  Mandatory data element for Provincial or Module 

 

Hospital Required: Required field.  Must have data entered to save. 

 

Hospital Error:  Mandatory data element for submission to CIHI. 

 

Hospital Warning:  Hospital warning.  Record will save and submit. 

Table 17 - Entry Grid Icon Description 
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2. Field usage - Field usage icon meaning varies based on the module that is open. Here’s the 

description of the icon by module. 

CPI MODULE: 

 The valued is copied from CPI MODULE to DAD abstract  

 The valued is copied from CPI MODULE to NACRS abstract 

 The valued is copied from CPI MODULE to both DAD and NACRS abstract 

Table 18 - CPI MODULE Field Usage Icons 

DAD: 

 This field is used for grouper 

 Not Used 

 Not Used 

Table 19 - DAD Field Usage Icons 

NACRS: 

 This field is used for grouper 

 Not Used 

 Not Used 

Table 20 - NACRS Field Usage Icons 

3.  Field – This is name of the field that needs to be entered. 

4. Value – This is where the value is entered. 

5. Description – This is the description of the value. 
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Group fields section expand/collapse 

Group field section can be expanded or collapsed. This will allow the user to view more of a 

specific section. 

To collapse a group field section 

o Click the  icon to collapse the section header   

 

Figure 220 - Group field section expanded 

To expand a group field section 

o Click the  icon to open the section header  

 

Figure 221 - Group field section collapsed 
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Fields grid quick search [F3] 

Use the fields grid quick search to quickly navigate to a field. 

To access the fields, grid quick search 

o Press [F3]. 

 

Figure 222 - Fields grid quick search 

The section that has the focus will not collapse. E.g. In the Figure above the section 

“Patient/Client Demographics Information” can NOT be collapsed. 
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To navigate on the fields, grid quick search 

o Click on the field you want to navigate to. 

— or — 

o To quickly move through the list, you can type the first letter of the field name. E.g. to move 

near “First Name”; type “f”.  (Pressing a letter repeatedly will move you through choices 

beginning with that letter). 

 

Figure 223 - Fields grid quick search result 
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Fields grid multi-form sections 

Multi occurrence section, like “Provider Data” cannot be expanded. Double-clicking the header of 

a multi-occurrence section will open the multi-form associated with the section. 

To open a multi-form from the Section header 

o Double-click the section header.  

 

Figure 224 - Multi-form form section header 
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5.12 Multi-forms 

Multi-Forms are embedded in a module’s main grid and allows multiple occurrences, for example, 

the Diagnosis, Intervention, Providers.   Since more than one diagnosis, intervention, provider 

may be entered for an abstract the multi-form is used. 

 

Figure 225 - Multi-form 

The following are images of the different toolbars for the multi-forms. The generic toolbar image 

shows what most of the multi-form tools look like. The intervention and diagnosis multi-forms 

have different tool available to them.  

 

Figure 226 - Generic Multi-Form Toolbar 

 

Figure 227 - Diagnosis Data Multi - Form Toolbar 
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Figure 228 - Intervention Data Multi-Form Toolbar 

 

 

 

Chart outlining the Multi-form toolbar icons, shortcut keys and description of the functionalities.  

 or [F5] 
Adds an entry row to the grid allowing the user to enter a new set of fields. 

 or [F9] 
Deletes the current row. 

 

Copy feature - Intervention multi-form only – Ability to copy the intervention information 

from the previous occurrence.   

 or [F7] 

Opens another linked encoder application (only available in Diagnosis and Intervention 

multi-forms) and if encoder information is filled in Hospital Profile 

 

Opens the CIHI Folio (only available in Diagnosis and Intervention multi-forms). The 

File/Folder Paths/Folio paths need to be entered in the User Profile.   

 

Import Folio File feature - Opens a Dialog window to allow user to import a Folio Code 

Basket File into WinRecs Diagnosis or Intervention multi-forms. 

 or [F6] 

Quick Hint – Intervention Data Multi-Form only – Displays the most recent common 

Intervention codes that have been used. 

 

Opens the PDF File Viewer 

 or [F10] 

Closes the multi-form and places the focus back on the main grid of abstract. 

 or [F11] 

Opens the previous field that uses a multi-form. 

 or [F12] 

Opens the next field that uses a multi-form. 

Table 21 - Multi-Form Toolbar 
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To access the multi-forms 

o When entering data in an abstract or the CPI MODULE grid, pressing the [ENTER] key to 

move to the next field will open the multi-form if the next field can have multiple occurrences. 

— or — 

o Click a specific multi-occurrence field in the field navigation list. 

 

Figure 229 - Accessing a multi-form 

To enter data in a multi-form 

When a multi-form is open, the focus is on the first field of the first row. Enter the data required in 

the first field. Pressing [ENTER] will move the focus to the next field to the right.  

 

 

Figure 230 - Entering data in a multi-form 

To add a new row of data 

o To enter another row of data, press the  icon on the toolbar.  

o The focus will be set to the first field of the new row.  
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Figure 231 - Multi-form multiple rows 

 

 

Figure 232 - Multi-form row selected for undo 

To delete the data entered and the row 

o Click on the header of the row (as shown by the arrow on the figure below) 

o Click on the Delete icon  on the toolbar 
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Figure 233 - Multi-form row selected for delete 

To close the multi-form and navigate back to the Main window 

When the entry is complete navigate back to the Main window. 

o Press [F10]. 

— or — 

o Click the Home  icon on the toolbar.  

 

 

To navigate automatically to the next field 

When the entry is completed, navigate to the next field. If the next field is a multi-occurrence field 

the multi-form will stay open and the next multi-occurrence field will be displayed by the multi-

form; otherwise the multi-form will be closed and the next field of the main grid will have the 

focus. 

 

o Press [F12]. 

— or — 

o Click the Next   icon on the toolbar.  

 

To navigate automatically to the previous field 

Once the entry is completed, navigate to the previous field. If the previous field is a multi-

occurrence field the multi-form will stay open and the previous multi-occurrence field will be 

displayed in the multi-form; otherwise the multi-form will be closed and the previous field of the 

main grid will have the focus. 

Using the Home function will set the focus to the first field of the entry grid on the 

Main window. 
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o Press [F11]. 

— or — 

o Click the Previous  icon on the toolbar.  

Diagnosis Code 

In the Diagnosis Code field, the search function are as follows: 

• By partial Diagnosis Code eg:  I50 and a search screen with all codes with I50 will display 

• By Full Diagnosis Code eg:  I500 or I50.0 will fill in the diagnosis code 

• By partial/full diagnosis code and partial description eg:  I50 Congestive – will populate 

the code or a search screen of all codes with search will display.  

 

Copy Function – Intervention Multi-Form 

Gives the user the ability to copy Intervention information from the previous occurrence in 

Inpatient and Amcare records. 

o Fill in occurrence 1 with the required information 

o Create occurrence 2, click on the Copy Function  

o Pressing this will populate all fields from the previous occurrence except the Intervention 

Code.  Any changes can be done manually 

o If needed, the user may copy data for occurrence 3 and this will populate from occurrence 2.   

 

 

Descriptions – Multi-Forms 

Descriptions are now displayed in the same cell as the selected item for the given field. All multi-

forms with fields that have a description associated with the field will appears as follows; Field 

Value – Value Description.  

The following example shows each column for the Provider Data Multi-Form. User will see the 

value of each selected field followed by the description.  

 

Figure 234 - Provider Data Multi-Form 
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Figure 235 - Close up View 

When the user selects a field on a multi-form the status bar will show the description of the 

selected item, while the cell shows the selected value.  

 

Figure 236 - Provider Data - Provider Service and Description 

 

Figure 237 - Close up View of the Selected Field 

5.13 Look up 

Field of type Look Up can only accept values from a predefined list of values. This list can be 

maintained via the Maintenance → Look Up Code Maintenance menu.  

When you are on a field that is of type Look Up you can access the list of valid code by pressing 

[F2] 

To enter a valid value from the Look Up List 

o Type in the value. E.g. for a male gender you can just type in the field m 

To access the Look Up list 

o Press [F2] – this will only display the look up list if the currently selected field is of type Look 

Up 

To select a value from the Look Up List 

o Click on the desired value on the list, then click the “Select Record” button 
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— or —   

o Double-click the desired value on the list. 

To close the Look Up List without selecting a value 

o Click the  in the window title bar. 

— or —  

o Press [ESC] twice in a row 

 

Look up lists size 

Look up list will only display the first 100 results. The look up window will display the message: 

“There may be more results. Consider refining your search”, as shown below. 

 

Figure 238 - Look up list size 

In this case you should filter your list 

To filter the Look Up List 

Some look up lists are very long, filter the list by: 

o In the field enter your filter criteria, the press [ENTER]. E.g. for the language field you can 

type en 
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Figure 239 - Look up list pre-filtered 

— or — 

o Open the Look up list by pressing [F2]. 

o In the search text box, on the upper left corner of the window, type in your filter criteria. 

o Press [ENTER]. 

 

Figure 240 - Look up list filtering step 1 
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Figure 241 - Look up list filtering step 2 

Look Up Maintenance Report 

The Look Up Maintenance Report is a report that will list all the look up values available for a 

field.  The report will need to be set up in the Report Maintenance module see Reports 

To run the report: 

o Click on the Look Up Field 

o Press the  or [F4] and search for the value 
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Figure 242 – Look Up Vale 

 

o Press  or [F10] 

o Click on the Report Name for Look Up Maintenance Report 

o Enter the Parameters 

 

Figure 243 – Report Print Parameters 
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o Press Ok and the list of look up values for the specified fields will display 

 

Figure 244 – Look Up Values Report 

 

 

 

5.14 Reports 

Reports are set up through the Maintenance/Report Maintenance 

To open the Report Manager 

o Press [F10]. 

— or — 

o Select the menu option Actions → Report Manager. 

— or — 

o Click the Report Manager button on the toolbar .   

o The Select Report window will open with the reports available for this module 

2. or     - 
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o Go to ‘Report File:’ – press [F2] and a directory window will pop up for you to go to the list of 

reports  

 

Figure 245  - Select Report Screen 

 

o Press Show Report  
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o The report can also be emailed which is set up in Report Maintenance 

o The report can also be printed  

o Report Manager will open depending on the report parameters may be needed or if no 

parameters the report will open.   

 

Figure 246 – Parameter Screen 
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Figure 247 – Opened Report 

 

 

Figure 248 – Report Manager Window 
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5.15 Interfacing with Folio Views Code Basket  

WinRecs has incorporated the ability to interface with the Folio Views application software 

through the Code basket functionality.  

 

Note:    For information of how to use Code Basket functionality please contact CIHI.    

 

To configure 

o Go to Options → User Profile → File/Folder Paths → Find User → Edit 

 

Figure 249 -  Configure Code Basket 

Skeleton File Paths 

ICD10-CA: 

C:\CIHI\CIHI_PUB_2015\CIHI32\Views.exe -L1033 -

cSoftware\CIHI\2015\ICD10_CodeBasket\English -

i"C:\CIHI\CIHI_PUB_2015\SDW\icd_2015_eng.sdw" -r"C:\CIHI\CIHI_PUB_2015\cb_en.txt" 

 

CCI: 

C:\CIHI\CIHI_PUB_2015\CIHI32\Views.exe -L1033 -

cSoftware\CIHI\2015\ICD10_CodeBasket\English -

i"C:\CIHI\CIHI_PUB_2015\SDW\cci_2015_eng.sdw" -r"C:\CIHI\CIHI_PUB_2015\cb_en.txt" 
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Note:    These file paths may need to be modified, depending on location of software.  

 

A temporary file is created when importing the codes, and where it’s written to is determined by 

the last part of each file path (in bold below). You can determine a location that you have write 

access to that you’d like to have the temporary files write to and update the path to reflect that. 

These are temporary files, that will delete once the codes are imported into WinRecs. 

 

C:\CIHI\CIHI_PUB_2015\CIHI32\Views.exe -L1033 -

cSoftware\CIHI\2015\ICD10_CodeBasket\English -i"X:\SHADOWFILES2015\ICD2015-

Merged.sdw" -r"C:\CIHI\CIHI_PUB_2015\cb_en.txt" 

 

 

 

 

 

Importing from Folio Code Basket into WinRecs 

 

o From within the Diagnosis or Intervention screen select the Folio button on the tool bar. 

 

 

Folio Paths can also be set up at the Regional Profile / Hospital Profile Level for all 

users. 
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Note:    User doesn’t need to be on the Diagnosis Code or Intervention Code fields when launching 
Folio.    

 

o When Folio launches, WinRecs displays a dialog that the Coder will use to indicate the 

Folio session is complete, allowing WinRecs to pull the selected codes from the Code Basket. 

Do not close (‘OK’, ‘Cancel’, or ‘X’) this dialog box until the codes have been added to the Code 

Basket – this is what triggers the import into WinRecs, if it is closed prior to adding the codes, 

there will be nothing to trigger the import once they have been added, and you will need to launch 

a new Folio to prompt the dialog box again. 

 

 

 

 

 

o In Folio, load codes into Folio Code Basket, as per instructions from CIHI. 

o When the code basket has the codes needed, you can close Folio. 

o Then you can click on OK, to trigger the import of the codes into WinRecs 
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Note:    If you no longer want to import the codes and want to leave the abstract as it was prior to 
opening Code Basket, you can select Cancel. 

 

o All codes that were in the code basket will now display in the abstract: 

 

 

It’s also possible to remove previously selected codes from WinRecs, via Folio, if they are no 

longer deemed relevant.  

o Go to Code basket as you would to import a code.  

o Delete code from Folio Code Basket (as per instructions from CIHI). Once you’ve deleted any 

codes you’d like to, you can close folio. 

o Once back in WinRecs, select OK on the dialog box. 

 

When the dialog is closed, WinRecs imports the 2 selected codes and removes the 2 deleted 

codes: 
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Importing a Folio Code Basket File 

The file(s) will need to be created from Folio Views before following the instructions below. Please 

consult CIHI for instructions about saving files from Folio Code Basket. 

 

o From the Diagnosis or Intervention screen, select the import icon: 
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o Select the File (WinRecs will remember the last location) 

 

 

o The contents from the saved file will load into WinRecs 
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6.  WinRecs Modules 

WinRecs module windows are displayed in the main area of the application. To allow maximum 

flexibility and better navigation, you can open multiple records from different modules at the same 

time. This will allow the user to quickly toggle between records. 

The text on the tab helps to identify the record that is open. The information displayed on the tab 

is configurable in the Control File. 

 

 

6.1 Chart Maintenance 

The Chart Maintenance Module Consists of the CPI MODULE, Chart Volumes, Visit History, 

Chart Locator, Chart Deficiency and Release of Information modules.   

 

Figure 250 – Chart Maintenance Modules 

6.1.1 Central Patient Index [CPI MODULE] Module 

The Central Patient Index [CPI MODULE] stores patient demographic information such as record 

key, patient demographics and user field information.  Included in the CPI MODULE is the Chart 

Management features which modifies chart information. 
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To open the CPI MODULE 

o Select the menu option Module → Chart Maintenance → [CPI MODULE] Central Patient 

Index 

— or —  

o Select WinRecs Module Menu → Chart Maintenance→ [CPI MODULE] Central Patient 

Index 

Module Header

 

Figure 251 - CPI MODULE Header 

Chart Management 

o Click on the chart management menu item on the CPI MODULE header. 

 

Figure 252 - Chart management menu 

o Click the Modify item 
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Figure 253 - Chart management menu open 

- 
The WinRecs Chart Management - Modify screen has 4 options to choose from: 
 
1. Change Chart Number 
2. Merge Charts 
3. Unmerge Chart 
4. Relocate Visits 

 

 

Figure 254 - Chart management window  
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  - Verify or Press [F11] 

 - Execute or Press [F12] 

Source Chart Number – the chart number that is changing or no longer using (child) 

Target Chart Number – the chart number that is being kept (parent) 

 

 

Change Chart Number 

This is used to change one chart number to another chart number, the target chart number 

CANNOT exist in the CPI MODULE.    

o In the CPI MODULE, do a chart search on the Source Chart Number (the number not being 

kept) 

o Click on Chart Management/Modify 

o Click on Change Chart Number 

o The Source Chart Number will populate with the CPI MODULE number and all the visits 

will populate below the chart numbers  

o Enter the Target Chart Number – this number should NOT be in the CPI MODULE, if the 

chart number already exists, you will get a pop up message stating: 

  

Figure 255 – Change Chart Number Message  

 

o Press  or [F12] to execute.  (If there are charts that have been submitted to CIHI see 

Submitted Records at the end of this section.)  

If Modify a Chart is not displayed in the CPI module, the user may not have the 

necessary permissions.  Contact your WinRecs system administrator.   
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o A pop up message will state, pressing Yes will continue, No will take you back to the main 

screen: 

 

Figure 256 – Change Chart message  

o A message will pop up stating: 

 

Figure 257 – Change Chart Successful Message 

The example below displays chart #1234 (Source) to chart #4567 (Destination).  All visits will be 

moved to chart #4567. 

 

Figure 258 – Change Chart Example 
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Merge Charts 

Used to move all visits from the Source Chart Number to the Target Chart Number.  The 

Target Chart Number will already be in the CPI MODULE.   

o In the CPI MODULE, do a chart search on the Source Chart Number (the number not being 

kept) 

o Click on Chart Management/Modify 

o Click on Merge Charts 

o The Source Chart Number will populate with the CPI MODULE number and all the visits 

will populate below the chart numbers  

o Enter the Target Chart Number – this number has to be in the CPI MODULE 

o Press  or [F12] to execute.  (If there are charts that have been submitted to CIHI see 

Submitted Records at the end of this section.)  

o A pop up message will state, pressing Yes will continue, No will take you back to the main 

screen: 

 

Figure 259 – Merge Chart Message 

 

o A message will pop up stating: 

 

Figure 260 – Merge Chart Successful Message 

The example below displays chart #T5679 (Source) merge to chart #CF12345678 (Target).  All 

visits will be moved to chart #CF12345678. 
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Figure 261 – Change Merge Example 

Unmerge Charts 
This option will unmerge previously merged charts.   

If the following error appears when trying to unmerge charts and the “Chart Number Can be Re-

Issued?” in the Hospital Profile needs to be unchecked: 

 

Figure 262 – Un-Merge Charts Error message 

 

Chart Number Can be Re-Issued? – Unchecked: 

The Hospital and Regional Profile both have settings for the Module Options, [CPI MODULE] 

Central Patient Index called “Chart Number Can be Re-Issued?” If this option is checked the 

unmerge function will not work. 
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Figure 263 - Options - Regional Profile Setup 

In the CPI MODULE, do a chart search on the Target Chart (the number kept) 

o In the CPI MODULE, do a chart search on the Source Chart Number (the number not being 

kept)  

o Click on Chart Management/Modify 

o Click on Unmerge Charts 

o The Chart Number will populate with the CPI MODULE number and all chart or charts will 

populate in the Merge List 

o Highlight the chart number that you want to unmerge 

o Press  or [F12] to execute.   

o A pop up message will state, pressing Yes will continue, No will go back to the unmerge 

screen: 

 

Figure 264 – Change Un-Merge Message 

o A message will pop up with the following message. 
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Figure 265 – Chart Un-merge Successful message 

 

In the example below, the chart number that was merged to is CF12345678(Target Chart), in 

the Merge List the chart number (Source Chart) is the chart that merged into the Target Chart.  

Executing this will unmerge these two charts.  

 

Figure 266 – Chart Un-Merge Example 

 

Relocate Visits 

Used to move only selected visits from one chart to another.  The Source Chart Number will 

display all visits for the chart.  Select the Target Chart Number and the selected visits will 

move to this chart number.  This cannot be undone.   

o In the CPI MODULE, do a chart search on the Source Chart Number (the number you 

want to move the visit(s) from) 

o Click on Chart Management/Modify 

o Click on Relocate Visits 
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o The Source Chart Number will populate with the CPI MODULE number and all visits 

related to that chart number will populate below. 

o Enter the Target Chart Number 

o Put a check mark by the visits that need to be moved from the Source Chart to the Target 

Chart.   

o Press  or [F12] to execute.  (If there are charts that have been submitted to CIHI see 

Submitted Records at the end of this section.)  

o A pop up message will state, pressing Yes will continue, No will go back to the unmerge 

screen: 

 

Figure 267 – Relocate Visits Message 

o A message will pop up with the following message.

 

Figure 268 – Relocate Visits Successful Message 

 

In the example, below the Source chart is 165557, the visit from 2015/04/10 is check marked and 

will be moved to the Target Chart Number 99165. 
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Figure 269 – Relocate Visits Example 

CPI Lock 

 

CPI Lock clears any locks that may be caused by merge/unmerge functions 

To Activate Clear CPI Lock functions: 

o Options/User Profile/Module Settings/CPI/Clear CPI Lock  

 

To clear a locked record in the CPI Module: 

o Chart Management in the CPI Module 

o Click on “Clear CPI Lock” option. (To activate this option, go to Options/User 

Profile/Module Settings/CPI/Clear CPI Lock) 

 

Figure 270 - Chart Management Menu 
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o The following message will appear 

 

Figure 271 - Chart Clear CPI MODULE Lock message  

o Select yes to continue or no cancel the request.  

o If user selects yes, the following message appears: 

 

Figure 272 - Chart Clear CPI MODULE Lock Completed message 
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6.1.2 [VOL] Chart Volumes Module 

The Chart Volumes module records and displays all the volumes of a specific chart. 

 

Figure 273 – Chart Volumes Module 

The Chart Volume Module is broken up into 3 sections: 

1. Chart Volume Record Information – Describes the volume of the record and what visit 

dates are included in the volume 

2. Volume Management Information – Describes where the volume is located 

3. Volume Content Information – Describes what is contained within in each volume 
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Creating a new Volume 

• Go to WinRecs Module Menu or on the Menu Bar go to Module/Chart Maintenance/[VOL] 

Chart Volume 

• Press  or [F5] to create a new volume 

• Record Search window will pop up – enter the chart you would like to create a volume 

and press Find Chart or press Enter and select your chart.  

 

Figure 274 – Chart Volumes Record Search for New Volume 

 

• Chart Volume Record Information enter the information pertaining to your volume 

o Regional Link – Enter or will populate if using a regional system 

o Hospital Link – Enter or will populate if using a regional system 

o Chart Number – automatically populates 

o Is Sub-Volume – ‘Y’ or ‘N’ field – Yes if there are sub-volumes of this volume, 

N or leave blank if there are no sub-volumes 

o Volume Link –  

o Volume Type – Press [F2] for the options:  1.  Temporary or 2.  Permanent 



 [T WinRecs Version 2025.01 User Guide 

© 2025 MED2020 Health Care Software Inc. All rights reserved. Page 339 

o Volume Number – This is a mandatory field and need to be entered.   

o Barcode Volume Number –  

o Valid Date From – The date the volume starts (visit date or admission date) 

o Valid Date To – The date the volume ends (visit date or discharge date of last 

visit) For current charts – leave blank or future date (2099/03/31) 

• Volume Management Information 

o Label Printed – Y – Yes, N- No, P-Pending 

o Permanent Location – This is mandatory field – Press [F2] for look up or type 

in location.  Look Up Fields can be added via Look Up Maintenance/Chart 

Locator/Loan Locator 

o Previous Location – Linked to Chart Locator, displays the previous location 

the chart was signed out to 

o Current Location – Linked to Chart Locator, displays were the chart is 

currently signed out to. 

o Current Transaction Type – Linked to Chart Locator – displays the most 

current transaction type as displayed in Chart Locator.   

• Volume Content Information – additional information if required but not mandatory 

o Box Number –  

o Contains Microfilm/Fiche Data – Y or N  

o Microfile/Fiche Number – the number associated with the Microfile/Fiche 

o Contains Digital Data – Y or N 

o Contains DAD (Inpatient) Data – Y or N 

o Contains SDS Data – Y or N 

o Contains NACRS Data – Y or N 

o Contains NRS Data – Y or N 

o Contains MDS (CCRS) Data – Y or N 

o Contains MHRS Data – Y or N 

o Contains CJRR Data – Y or N 

o Contains Cancer Care Data – Y or N 

o Contains Outpatient Data – Y or N 

o Volume Note – Ability to collet any note by clicking on the .  A pop up 

screen will display type the note, press Select.  To edit the note double click on 

the field.  

• Once the required fields are completed, press [F6]/[F7] to save.  
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Editing a Volume 

• Press  or [F4] to bring up the Record Search Box 

• Enter your search parameters in the box and press Enter or Find Record 

• A Search Result Box will display, highlight the record you want to pick and press Select 

Record and the record will populate the Chart Volumes module. 

• Edit as required and press [F6]/[F7] to save.  

 

Volume Visit Link 

This feature gives the user the ability to link visits to the volume.  When a user is looking for a 

chart, a report can be run and it will display which volume the visit is in and were the chart is 

located.   

• Go to Chart Volumes module 

• Search for the chart number and volume 

• Go to Actions/Set Volume Visit Link 

 

• The following will populate: 

Chart Volume Visit Link  - add when tested by QA 
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6.1.3  [LOC] Chart Locator 

The chart locator module is used for tracking and locating the paper copy of the patient record.  

Using the key identifier fields entered into the patient record in other modules the chart location 

can provide an up to date report on the chart’s location within the facility.   

Chart Locator Set up 

The following setup must be completed or reviewed before using the Chart Locator module: 

• Regional/Hospital Profile – Check the Module Options/[LOC] Chart Locator fields for 

configuration 

o Module Options→[LOC] Chart Locator 

o Pull List ID Format-When a Pull List is created, have an options to configure the 

format as: 

 

• Manual Default Return Location-When the box is checked and chart is returned to Health 

Records, user can manually select from a list of Health Records locations 

• Look Up Code Maintenance – Look up fields under the [LOC] Chart Locator are 

configured 

o Loan Hospital 

o Loan Location 

o Loan Location Type 

o Request Priority 

• User Profile – Check Module Settings/[LOC] Chart Locator – set the permissions for 

Chart Locator 

• Control File – set the appropriate default setting, as well as disable, enable fields as 

required 
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Accessing Chart Locator 

    WinRecs Module Menu → Chart Maintenance → [LOC] Chart Locator  

- Or   - 

Modules → Chart Maintenance → [LOC] Chart Locator 

 

Figure 275 – Chart Locator Module 

 

1. Tool Bar – see Tool Bars 
2. Transaction Information – The Section included in this area are: 

• Transaction Type – there are 6 transaction types and depending on the type you 
choose will determine which sections will display 

o Loan Transaction Information  
o Pull List Transaction Information – fields in this section are only be 

available if Transaction Type – Pull List is chosen 
o Return Transaction Information – fields in this section are only available if 

Transaction Type – Return is chosen 
o Mass Move Transaction Information – fields in this section are only 

available if Transaction Type – Mass Move is chosen 
o Request Header Information  

3. Notes and Reason for Loan – free text field for user to enter notes 
4. Select Chart & Volumes 

• Select Chart [F11] – Clicking on this or pressing [F11] will give you the following 
options to search for a record: 
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5. Chart Information – This represents the charts that have been signed out: 

• Chart number in Blue indicates there is an outstanding request for this chart 

• Chart number in Red indicates the chart is out on loan 

• Chart number in Purple indicates the chart is already signed out to the location 
chosen 

6. Tool Buttons 
 

Chart Request Transaction 

Ability to request a chart that is currently out on loan.  On the chart’s return a notice will be create 

to notify of the user of the new location. 

• To create a new Chart Request, press the  or [F5] 

• Enter Transaction Type C- Chart Request – the Request Header Information 

field will be displayed 
o Request Location – Press [F2] to choose the location the chart is going - 

mandatory 
o Request Location Type – is linked to the Request Location 

o Request Borrower – identifies the borrower (a specific person) for the 

Request Location 
o Request Date – The date auto populates – mandatory 

o Request Time – The time auto populates - mandatory 

o Request Priority – Press [F2] to chose - Request priorities are set up in 

Maintenance/Look Up/[LOC] Chart Locator/Request Priority 

• Under Select Chart – Choose chart number (or whatever search that is chosen) 

• Enter the chart number being requested, if the chart only has one volume press enter and 
the chart will display in the information box.  If there is more than one volume a pop up 
screen will populate with the chart and volumes: 

 

Figure 276 – Chart Locator Volume Screen 



 [T WinRecs Version 2025.01 User Guide 

© 2025 MED2020 Health Care Software Inc. All rights reserved. Page 344 

 
 

• Put a check mark in the chart you would like to select and press Enter 

• This will populate in Chart Information Box 

 

Figure 277 – Chart Locator Chart Information Box 

 

• Press  or [F7] to save. 

• When the chart if returned from the current location the following message will prompt 
when you return it: 

 

Figure 278 – Chart Locator – Outstanding Request 

 

• Select Yes to view and the following window pops up: 



 [T WinRecs Version 2025.01 User Guide 

© 2025 MED2020 Health Care Software Inc. All rights reserved. Page 345 

 

Figure 279 – Chart Locator – Chart Requests 

 

• To move it to the Request Location, enter the check mark and press Select and the 

chart will be moved to the requested location. 

• To remove the request, enter the check mark and press Purge 

Loan Transaction 

Ability to loan charts out to different areas within the department or facility. 

• To create a new Loan Transaction, press the  or [F5] 

• Enter Transaction Type L- Loan  - the Loan Transaction Information header will be 

displayed 
o Loan Location – press [F2] to choose the location the chart is going – 

mandatory 
o Loan Location Type – is linked to Loan Location 

o Borrower – the person that is linked to that location 

o Loan date – The date the loan -automatically populated – mandatory 

o Loan time – the time of the loan – automatically populated – mandatory 

o Expected Return Date – The date the chart is expected to return.  This is 

determined in the Look-up for Loan Location.   

• Under Select Chart – Choose chart number (or whatever search that is chosen) 

• Enter the chart number being requested, if the chart only has one volume press enter and 
the chart will display in the information box.  If there is more than one volume a pop up 
screen will populate with the chart and volumes: 
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Figure 280 – Chart Locator Volume Screen 

 
 

• Put a check mark in the chart you would like to select and press Enter 

• This will populate in Chart Information Box 

 

Figure 281 – Chart Locator Chart Information Box 

 

• Press  or [F7] to save. 
 

Mass Move Transaction 

Used to move a large number of charts to a new location 

• To create a new Mass Move, press the  or [F5] 

• Enter Transaction Type M- Mass Move - the Mass Move Transaction Information 

header will be displayed 
o Move Location – press [F2] to choose the location the chart is currently at – 

mandatory 
o Move date – Auto populates the date – mandatory 

o Loan time – Auto populated the time – mandatory 

o New Perm Location – press [F2] to choose the new location - mandatory 

o Box Number – enter the box number if the chart is in the box 

 



 [T WinRecs Version 2025.01 User Guide 

© 2025 MED2020 Health Care Software Inc. All rights reserved. Page 347 

• Under Select Chart – Choose chart number (or whatever search that is chosen) 

• Enter the chart number being requested, if the chart only has one volume press enter and 
the chart will display in the information box.  If there is more than one volume a pop up 
screen will populate with the chart and volumes: 

 

Figure 282 – Chart Locator Volume Screen 

 
 

• Put a check mark in the chart you would like to select and press Enter 

• This will populate in Chart Information Box 

 

Figure 283 – Chart Locator Chart Information Box 

 

• Press  or [F7] to save. 
 
 
 
 

Pull List Transaction 

Used to create pull lists for clinics, etc. Can be created manually or a Batch Interface.  

• To create a new Pull List, press the  or [F5] 

• Enter Transaction Type P- Pull List – the Pull List Transaction Information 

header will be displayed 
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o Pull List Number –auto populates with a Pull List Number – mandatory 

o Request Location – Press [F2] to choose the location – mandatory 

o Request Location Type – is linked to the Request Location and will populate 

o Borrower – the person who is borrowing the charts (if known) 

o Request Date – Auto populates the date – mandatory 

o Request Time – Auto populated the time – mandatory 

o Request Priority – Press [F2] to chose the priority if desired 

o Pull Date – Auto populates the date but can be changed if date is different 

o Pull Time – Auto populated the time but can be changed it time is different 

o Expect Return Date – The date auto populated the expected return based 

on request location 
 

• Under Select Chart – Choose Chart Number  

• Enter the chart number being requested, if the chart only has one volume press enter and 
the chart will display in the information box.  If there is more than one volume a pop up 
screen will populate with the chart and volumes: 

 

Figure 284 – Chart Locator Volume Screen 

• Put a check mark in the chart you would like to select and press Enter 

• This will populate in Chart Information Box 

 

Figure 285 – Chart Locator Chart Information Box 

 

• Press  or [F7] to save. 
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Return Transaction 

Used to return loaned charts to either the previous location or the chart’s designated permanent 

location. 

• To create a new Return, press the  or [F5] 

• Enter Transaction Type R-Return - the Return Transaction Information header will be 

displayed 
o Return Location – press [F2] to choose the location the chart is being returned to  
o Cursor will jump to Return Location to select from a list of 

internal locations.  

• If Return Location is blank, user can select the charts to be returned and locator will 
determine if chart will be returned to Previous Location or Permanent Location. If chart was 
in a previous location that was NOT permanent, a prompt will display. 

 

 
• Under Select Chart – Choose chart number (or whatever search that is chosen) 

• Enter the chart number being requested, if the chart only has one volume press enter and 
the chart will display in the information box.  If there is more than one volume a pop up 
screen will populate with the chart and volumes: 

 

Figure 286 – Chart Locator Volume Screen 
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• Put a check mark in the chart you would like to select and press Enter 

• This will populate in Chart Information Box 

 

Figure 287 – Chart Locator Volume Screen 

 

• Press  or [F7] to save. 
 

Cancel Transaction 

The ability to cancel transaction created in error and return the chart to the previous location.   

• To create a new Return, press the  or [F5] 

• Enter Transaction Type X-Cancel  

• Under Select Chart – Choose chart number (or whatever search that is chosen) 

• Enter the chart number being requested, if the chart only has one volume press enter and 
the chart will display in the information box.  If there is more than one volume a pop up 
screen will populate with the chart and volumes: 

 

Figure 288 – Chart Locator Volume Screen 

• Put a check mark in the chart you would like to select and press Enter 

• This will populate in Chart Information Box 
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Figure 289 – Chart Locator Chart Information Box 

 

• Press  or [F7] to save. 

Updating Pull List Transactions 

• To add records or update a Pull List transaction, press the  or [F4] 

• The record search window will display and the list of search options are displayed in the 

window: 

 

Figure 290 – Chart Locator Record Search 
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• Choose the search option and enter the required information.   

• Depending on the search option, if there is more than one option a search results page 

will display with the pull lists associated with that search.  Highlight the search and press 

Select Record.   

 

Figure 291 – Chart Locator Search Results 

• Press  or [F7] to save. 
 

 

 

6.1.4 [DEF] Chart Deficiency 

 

Overview 

The Chart Deficiency module provides Health Information Management (HIM) departments the 

ability to track all activity required to complete a patient’s chart. 

Once a chart is returned to the HIM department, it is collated, sorted and analyzed to determine if 

any deficiencies exist.  These can be entered quickly and easily via the Chart Deficiency module 

– either manually or using bar code technology.  WinRecs generates a deficiency letter per 

delinquent visit. 

As the physician(s) completes the deficient items, the chart can be updated in one of several 

ways: 

• If only some deficiencies are complete, those individual items can be entered and new 

deficiency letter printed, showing only the outstanding deficiencies 

• If all deficiencies are completed by a physician, the physician number can be entered, 

and all charts will be updated to a status of “C” (Complete).  If the physician has 

completed all items, only one reference number must be entered.   

 

Main Features 

• Deficiency codes are profile driven (Please refer to Look Up Code Maintenance). 
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• Bar Code Technology allows for quick and accurate entry of key information, as well as 

quick removal of completed deficiencies. 

• Delinquent count is done electronically. 

• Printing the Deficiency Letter by Provider/Visit Date once the entry has been completed 

and saved. 

• Deficiency Color code tabs can be assigned to each provider for easy identification of 

where deficiencies are noted within the chart.  The colors can be printed on the 

deficiency letter.  Each provider will have a different colored table to denote their 

deficiencies.   

 

Chart Deficiency Set Up 

The following set up must be completed before using the Chart Deficiency module: 

• Regional/Hospital Profile:  Completion of Module Options/[DEF] Chart Deficiency fields 

o Deficiency Add Days-When deficiency are created, to determine when to start 

counting the deficiency days.  Example: 1 means to start counting deficiency 

days tomorrow 

o Minimum Deficiency Count-minimum number of deficiencies for a letter to be 

generated 

• Control File:  Enabling, Disabling, making fields Visible moving of fields around the 

Chart Deficiency module 

• Provider Maintenance:  Check Chart Deficiency area and ensure appropriate fields are 

completed such as language and address fields 

o Provider Status 

o Current Provider Level 

o Last Level Letter Issue 

o Last Level Letter Date 

o Resident 

o Max Deficiency Level 

o Minimum Deficiencies 

• Look Up Code Maintenance: Look up fields under the [DEF] Chart Deficiency are 

configured 

o Colour Code 

o Deficiency Code 

o Deficiency Code Type 

o Header Status (Level) 

o Message Box 

o Resident 
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• Deficiency Letters:  Letters are created using the Report Generator module.   

 

Accessing Chart Deficiency 

    WinRecs Module Menu → Chart Maintenance → [DEF] Chart Deficiency  

- Or   - 

Modules → Chart Maintenance → [DEF] Chart Deficiency 

 

Figure 292 – Chart Deficiency Module 

 

1. Tool Bar – see Tool Bars 
2. Actions –  

• Deficiency Letters 

• Calculate Deficiency Days 

• Batch Complete 

• Transfer – transfer the deficiency to a different provider 

• Incomplete 

• New Provider [F8] 
3. Bookmarks – Quick links to the Section Headers 

•  - Deficiency Header Information – main grid 

•  - Deficiency Detail Information - multiform 

•  - Deficiency Calculations 
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4. Transaction Information – The Sections included in this area are: 

• Deficiency Header Information -  

• Patient/Chart Demographics Information 

• Provider Information 

• Deficiency Detail Information 

• Deficiency Calculations 
5. Deficiency Complete – this area displays the deficiencies that have been created and 

where you go to complete them.  Can also access the Provider Maintenance module by 
clicking on Provider Detail.   

6. Messages – displays a message of any fields that need to be entered, the fields will 

disappear as they are filled in 

 

Creating a Chart Deficiency 

• Open up Chart Deficiency module and the Record Search window pop up, enter the chart 

number (or whatever type of search) 

• To create a new Chart Deficiency, press the  or [F5] 

• Deficiency Header Information 

o Regional Link – will populate if user is assigned to Regional Link, can press 

[F2] to look up 

o Hospital Link – will populate if user is assigned to Hospital Link, can press 

[F2] to look up 

o Header Reference ID Number – mandatory - a unique identifier for each 

deficiency.  This is automatically entered. 

• Patient/Client Demographics Information 

o Chart Number – mandatory - enter the Chart Number or press [F2] to search 

for the chart 

o Last Name – populates the patient last name 

o First Name – populate the patient first name 

o Birth Date – populates the patient birthdate 

o Visit Date – this will be the date of the visit that is deficient, will populate with 

most recent visit.  Press [F2] to look up other visits and double click on the visit. 

o Volume Number – provides a link to all charts for a patient.  The volume 

indicates the hospital where the patient has a chart, where the chart is currently 

located at each hospital, the volume type, and the date the chart starts and ends.  

To select a different volume, press [F2] to display the volume look up and select 

a volume.  If a volume is not displaying, update the chart in the Chart Volumes 

module.   

o Institution Number – the Institution Number associated with Visit Date 

• Provider Information 
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o Provider Number – mandatory – a unique identifier for each provider, press 

[F2] to display the list of providers.  If the first few letters of the provider name or 

number is entered, press [F2] will display only those providers matching what 

was entered.  

o Provider Service – will populate the service of the provider can press [F2] to 

change if provider has more than one service 

o Provider Status – will populate the status from Provider Maintenance, 

Unavailability multiform.   

• Deficiency Detail Information – this multiform allows the user to assign one or more 

deficiencies to the provider  

 

Figure 293 – Chart Deficiency – Deficiency Detail Information 

o Deficiency Detail Occurrence – automatically populates with the 

occurrence number 
o Deficiency Detail Number – automatically populates the number  

o Deficiency Code – mandatory – enter the deficiency code or press [F2] to 

look up the code.   
o Deficiency Code Type – automatically populate the code type attached to 

the Deficiency Code 
o Deficiency Start Date – automatically populates today’s date 

o Deficiency End Date – automatically populates when the deficiency is 

complete 
o Deficiency Detail Days – calculated fields of the number of day the 

deficiency has been deficient 
o Message Box – any comments 

o Resident – populated if the provider is a resident populated from Provider 

Maintenance 
o Completed By – the user who completed the deficiency 

o Detail Status – the status of the deficiency.   

o Job Number – can enter the job number 

o Detail Comments – free text field to enter comments 
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o To create a new deficiency, press  to add a new occurrence. 

o To delete an exciting deficiency that was created in error press  

o To go back to Home press the  or [F10] to go back to main grid 

o Press  or [F11] to go back to previous field or mutliform 

o Press  or [F12] to go forward to the next field or multiform  
 

 

• Deficiency Calculations 

o Color Code – press [F2] to choose a color to assign the deficiency to a provider, 

optional 

o Header Status (Level) – the level is the type of letter the provider will receive 

for the deficiency 

o Deficiency Start Date – populates with todays days 

o Deficiency End Date – populates the end date when the deficiency is complete 

o Total Deficiency Days – the number of days the chart has been deficient 

(calculated) 

o Active/Available Deficiency Days – (calculated) 

o Hold Start Date 

o Hold End Date 

o Hold Days 

o Manual Days 

o Unavailable Days – the number of days the provider has been unavailable 

o Header Notes – free text field to add additional notes 

• Press [F6] & [F7] to save 

 

New Provider  

If a chart has more than one provider that has a deficiency, go to: 

o Actions/New Provider [F8] or press [F8] 

This will create a new chart deficiency screen and the deficiency may be entered for the new 

provider 
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Printing or Emailing a Chart Deficiency 

The user has the ability to print out a chart deficiency to put on the chart or email the deficiency to 

a provider 

• With the record open in the chart deficiency module Press [F10] or the button  

 

Figure 294 – Chart Deficiency – Printing/Emailing  

 

• There are 3 options to printing the report: 

o Selecting the report from the file directory by double clicking in box next to Report 

File:.  This will open the file directory to look for the Chart Deficiency report that 

needs to be printed.   

▪ Press the  to open the report and print from there 

o Highlighting the list of reports that are displayed in the middle of the screen (this 

is set up in Maintenance/Report Maintenance 
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Figure 295 – Chart Deficiency – Printing/Emailing 

 

o Press   to display the report and print from there OR 

o Press  

• To Email the report, press  

Completing a Chart Deficiency 

WinRecs allows for single deficiencies to be completed, one at time or in batches.   

• Open up Chart Deficiency module and the Record Search window pop up, enter the chart 

number (or whatever type of search) 

• If the chart number has more than one provider the search results will show each 

provider that has an outstanding deficiency. Choose the provider you wish to complete 

the deficiency. 
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Figure 296 – Chart Deficiency – Deficiency Detail Information 

 

• The Deficiency Complete tab will display the deficiencies  

 

Figure 297 – Chart Deficiency – Deficiency Complete 

• To complete one deficiency, click on the deficiency, a black arrow will appear.   then 

press  

o If there is only one deficiency to be completed, the Deficiency End Date in the 

Deficiency Calculation will be populated with date the deficiency was completed, 

as well as the Deficiency Detail End Date will populate in the deficiency Detail 

Information.   

o If there are two deficiencies on the chart and only one is completed, only the 

Deficiency Detail End Date will populate for the completed deficiency.   

• To complete all deficiencies for one chart press  

o When all deficiencies are completed using complete All, the Deficiency End Date 

in the Deficiency Calculation will be populated with date the deficiency was 
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completed, as well as the Deficiency Detail End Date will populate in the 

deficiency Detail Information.   

• To complete all deficiencies in a batch, a provider has completed many charts at one 

time. 

• Actions/Batch Complete – a list of all physicians with deficiencies will display 

 

Figure 298 – Chart Deficiency – Deficiency Batch Complete 

 

o Enter Provider Number in the box provided and it will only bring up that provider or 

double click on the provider in the list below 

o A Screen will display all the charts with deficiencies for that provider 
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Figure 299 – Chart Deficiency – Batch Complete Provider Deficiencies 

 

o Either click on the box to choose the deficiencies you would like to batch complete or 

Click on Select All to check them all.   

o If you would like to clear the check marks press Clear 

o Press Complete to finish the deficiencies with a check mark. 

o Actions/Batch Complete – a list of all physicians with deficiencies will display 

• Action/Incomplete – If you complete a provider deficiency in error, you can go to 

Action/Incomplete and will make the deficiency(deficiencies) incomplete.   

Transfer Deficiency to Another Provider 

Deficiencies may be transferred to another provider as required.  A new start date for the 

deficiency may be entered.   

• From the chart deficiency that needs to be transferred, go to Actions/Transfer and the 

Deficiency Transfer will display with the list of providers who have active deficiencies.  
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Figure 300 – Chart Deficiency – Deficiency Transfer 

 

• To choose the Provider From – enter the provider or number or double click from the 

list below 

• To choose Provider To – enter the provider number the deficiency is being transferred 

to 

• A screen will show all the deficiencies that can be transferred from one provider to the 

other Provider 

 

Figure 301 – Chart Deficiency – Deficiency Transfer – Charts to be Transferred 
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• Either click on the box to choose the deficiencies you would like to transfer or Click on 

Select All to check them all.   

• If you would like to clear the check marks press Clear 

• New Start Date – if you would like the deficiency to start counting on a new date, put 

a check mark in the New Start Date and add the date you would like it to start.   

• Press Transfer to transfer the deficiencies with a check mark 

 

Deficiency Letters 

The Chart Deficiency module can auto-generate deficiency letters to providers to notify them for 

chart completion.  The can be up to five deficiency levels which are defined by the site, each level 

represents the number of days the chart is deficient.  

 

6.1.5 [ROI] Release of Information 

The Release of Information module is used to maintain and store all Release of Information 

requests received by a facility.  I t can be used to track turn-around time, authorizations, workload 

measurement as well as invoicing and payments, if desired.   

The requests are chart-based, so a request must relate to an existing record in the Central 

Patient Index. 

 

Release of Information Setup 

The following setup must be completed before using the Release of Information module. 

• Regional/Hospital Profile:  Completion of Module Options/[ROI] Release of 

Information fields 

o GST Number 

o Tax Rate 1 

o Tax Rate 2 

• Control File:  Enabling, Disabling, making fields Visible moving of fields around the 

Release of Information module 

• Look Up Code Maintenance: The [ROI] Release of Information has the following fields 

that must be populated (all other fields are optional) 

o Action Type 

o Age Code 

o Authorization Received 

o Authorization Required 

o Authorization Signed by 

o Authorization Type 
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o Chargeable  

o Confidential 

o Contact  

o Document Code 

o Extension Notice Required? 

o Fee Level 

o Item Code 

o Item Tax Type 

o Next Action 

o Payment Method 

o Request Method 

o Request Type 

o Requester Billing Country 

o Requester Billing Province 

o Requester Country 

o Requester ID 

o Requester Province 

o Requester Type 

o ROI Status 

o Sent by (Couriers) 

o Urgency of Request 

• Report Maintenance – to set up reports to be run using [F10] or  

Accessing Release of Information 

    WinRecs Module Menu → Chart Maintenance → [ROI] Release of Information  

- Or   - 

Modules → Chart Maintenance → [ROI] Release of Information 
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Figure 302 – Release of Information Module 

1. Tool Bar – see Tool Bars 
2. Bookmarks – Quick links to the Section Headers 

• - ROI Request Information 

• - Patient/Client Demographics Information 

• - Contact Information 

• - Action Data 

• - Sent Information 

• - Invoice Information 
3. Transaction Information – The Sections included in this area are: 

• Patient/Chart Demographics Information 

• Requestor Information 

• Request Information 

• Contact Information 

• Action Data – multiform 

• Document Information – multiform 

• Sent Information 

• Items Sent - multiform 

• Invoice Information 

• Payments Information – multiform 
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• User Fields Information – Set 1 

• User Fields Information – Set 2 

• User Fields Information – Set 3 

• User Fields Information – Set 4 

• User Fields Information – Set 5 
 

4. Messages – displays a message of any fields that need to be entered, the fields will 

disappear as they are filled in 

 

Creating a New Release of Information Transaction 

• Open up Release of Information Module and close the Record Search window pop up 

• To create a new Release of Information Transaction, press the  or [F5] 

• ROI Request Information 

o Regional Link – will populate if user is assigned to Regional Link, can press 

[F2] to look up 

o Hospital Link – will populate if user is assigned to Hospital Link, can press 

[F2] to look up 

o Site Number – Enter the site, can press [F2] to look up available sites 

o Tax Rate 1 – used to calculate the GST  

o Tax Rate 2 – used to calculate the PST  

o Request Number – A unique alphanumeric identifier for the request.  The first 

digit must be numeric.  Can be generated automatically 

• Patient/Client Demographics Information 

o Chart Number – enter the chart number 

o Last Name – populates the patient last name 

o First Name – populate the patient first name 

o Birth Date – populates the birth date 

o Age Code – the age in ‘Y’- years, ‘M’ – months, ‘D’- days will populate 

o Age Number – the number will populate 

• Requester Information 

o Requester ID – Mandatory – The ID of the person or organization requesting 

the information. Press [F2] to display the list of requestors from the look up 

o Requester Name – The name of the Requester 

o Requester Address –  will auto-populate if fields populated in the Requester 

ID Look up table or can be manually entered 

o Requester Postal Code - will auto-populate if fields populated in the 

Requester ID Look up table or can be manually entered 
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o Requester City - will auto-populate if fields populated in the Requester ID 

Look up table or can be manually entered 

o Requester Province - will auto-populate if fields populated in the Requester 

ID Look up table or can be manually entered 

o Requester Country - will auto-populate if fields populated in the Requester ID 

Look up table or can be manually entered 

o Requester Billing Address - will auto-populate if fields populated in the 

Requester ID Look up table or can be manually entered 

o Requester Billing Postal Code - will auto-populate if fields populated in 

the Requester ID Look up table or can be manually entered 

o Requester Billing City - will auto-populate if fields populated in the 

Requester ID Look up table or can be manually entered 

o Requester Billing Province - will auto-populate if fields populated in the 

Requester ID Look up table or can be manually entered 

o Requester Billing Country - will auto-populate if fields populated in the 

Requester ID Look up table or can be manually entered 

o Requester Phone Number - will auto-populate if fields populated in the 

Requester ID Look up table or can be manually entered 

o Requester Phone Extension - will auto-populate if fields populated in the 

Requester ID Look up table or can be manually entered 

o Requester Fax Number - will auto-populate if fields populated in the 

Requester ID Look up table or can be manually entered 

o Requester Type – type of information being requested, press F2 to display the 

list of types from the look up table 

• Request Information 

o Request Dated – the actual date on the request.  The number of days between 

the Request Received Date and the Request Dated are used to calculate the 

Duration Since Request Received 

o Request Received Date – mandatory – the date the request was received, 

press [Spacebar] [Enter] to enter todays date 

o Request Received Time – the time the request was received, press 

[Spacebar] [Enter] to enter the current time 

o Request Coder – the ID of the person entering the request, press [F2] to 

display the coder 

o Request Method – The way in which the request was received, press [F2] to 

display the look up list of Request Methods 

o Request Type – The type of information requested.  Press [F2] to display the 

look up list of Request Types 
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o Chargeable – Indicates if the request is chargeable (‘Y’ or ‘N’).  If Chargeable 

Request is ‘N’, the Fee Level field, Invoice Information & Payment Multiform are 

disabled.   

o Request Duration – The number of days between the Request Received 

Date and the Sent Date are used to calculate Request Duration.  

o Urgency of Request – Indicates the urgency of the request, can press F2 to 

display the look up list of Urgencies.  

o Fee Level – This is connected to the Requester ID.  If the requester has a fee 

level assigned, the Fee Level is entered automatically.   

o Request Comments – Used to enter any required comments. 

• Contact Information 

o Contact – The code for the contact.  This is linked to the Requester ID. 

o Contact Name – The name of the contact 

o Contact Email – email of the contact 

o Contact Phone Number – phone number of the contact 

o Contact Phone Extension – phone extension of the contact 

o Contact Fax Number – fax number of the contact 

o Authorization Required – Indicates if authorization is required (‘Y’ or ‘N’).  

If ‘N’ is entered then Authorization Received and Authorization Signed By are 

disabled.   

o Authorization Received – If Authorization Required is ‘Y’, this field will 

open and a (‘Y’ or ‘N’) will be required 

o Authorization Type – the type of authorization that was received, press F2 

to display the look up list of types.   

o Authorization Signed By – who signed the authorization 

• Action Data – multiform – what was done with the chart 
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Figure 303 – ROI – Action Data Multiform 

 

o Action Occurrence – The unique occurrence number of the action done.  

This is incremented automatically 

o Action Type – The field indicates the action taken.  As the table containing this 

information is user-defined, actions can be customized to fit your own 

departmental workflow and procedures.  Press [F2] to display the look up of 

Types.   

o Action Date – the date the action occurred, can enter date or press 

[Spacebar] [Enter] to enter the date 

o Action Time – the time the action occurred, can enter date or press 

[Spacebar] [Enter] to enter the date 

o Action Coder – The user who performed the action.  Press [F2] to display the 

list of users. 

o Follow Up Days – The number of days in which the action needs to be 

completed.  In combination with a report, this can produce workload information 

o Next Action – indicates what the next action (if any) may be 

o Action Comments – any additional comments 

• Document Information – multiform – the document and dates send from the chart 

 

Figure 304 – ROI – Document Information 

o Document Occurrence - The unique occurrence number of the document 

information.  This is incremented automatically 

o Document Start Date – the start date of the document information 

o Document End Date – the end date of the document information 

o Document Code – the type of document 
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o Document Comments – any additional comments 

• Sent Information 

o ROI Status – The status of the request.  Press [F2] to display the list ROI 

Status 

o Sent Date – the date the information was sent [Spacebar] [Enter] to populate 

today’s date 

o Sent Time – the time the information was sent.  [Spacebar] [Enter] to populate 

the current time 

o Sent Coder – The ID of the person who sent the request.  Press [F2] to display 

the list of coders. 

o Sent By (Couriers) – Indicates the method of delivery of the request.  This 

is normally a courier name, press [F2] to display list of couriers 

o Tracking Number – The tacking number assigned by the courier for following 

the information sent 

o Special Handling Instructions – Enter any special instructions for 

handling the item 

o Extension Notice Required? – Indicates if extension notice is required (‘Y’ 

or ‘N’) 

o Extension Days – Number of days for extension 

o Sent Item Comments – any additional comments 

• Items Sent - multiform 

o Item Sent Occurrence – This is a unique number, generated automatically 

to identify the occurrence of the item sent. 

o Item Sent Date – The date of information sent request.  A date is required.  

Can press [Spacebar] [Enter] to populate todays date 

o Item Quantity – the number of items sent with this occurrence, such as 

number of photocopied papers, etc. 

o Item Code – Required – The code identifying the item, based on tables set up 

by the facility.  Press [F2] to look up the item code.  

o Item Price – The item price.  This defaults from the Item Code, but can be 

entered manually as well 

o Item Tax Type – The tax type (GST, PST, ect) of the item.  The value in this 

field defaults from the Item Code, if applicable.  Press [F2] to display the list of 

types. 

o Item Total Amount – The total amount of the items being sent.  

o Sent Item Comments – any additional comments 

• Invoice Information 

o Invoice Number – the invoice number 
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o Invoice Date – the date the invoice was created.  Press [Spacebar] [Enter] 

to enter todays date 

o Invoice Time – the time the invoice was created.  Press [Spacebar] [Enter] 

to enter the current time 

o Invoice Total – the total amount of the invoice including applicable taxes 

o Account Number – the account number of requester 

o GST Number – The hospital’s GST number can be entered here.  This can be 

set up in the Control File default to avoid repetitive entry 

o Amount Paid to Date – the amount paid to date 

o Total Amount Due – the total due.  The field adjusts as payments are made 

and recorded in the Payments multiform 

o Due Date – the date the Total Amount Due must be paid.  

• Payment Information – multiform – Multiple payments may be recorded for each ROI 

request.  This allows for installment payments to be recorded and fields to record 

information for invoicing purposes.  The entire section is enabled if the ‘Chargeable 

Request’ Field is ‘Y’ 

o Payment Occurrence – This is a unique number, generated automatically to 

identify the occurrence of the payment 

o Payment Date – The date the payment is received.  [Spacebar] [Enter] to 

enter today’s date 

o Payment Time – The time the payment was received.  [Spacebar] [Enter] to 

enter the current time. 

o Payment Method – The method used to make the payment, such as cheque, 

cash, etc. 

o Payment Amount – The amount of this payment 

o Cheque No – enter the cheque number if paid by cheque 

o Payment Comments – any additional comments 

• User Fields Information – Set 1 – 5 – the User Fields Information provides 6 types of 

fields where data can be collected.  In each set there are 5 of these fields types available.   

o Date Fields 

o Time Fields 

o Look Up Fields – can create look up fields in look up maintenance 

o Numeric Fields – 10 charter numeric 

o Text – 50 characters free text 

o Note – 255 characters 

 

Modifying Release of Information Transactions 

Release of Information transactions may be modified as required. 
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• Open up Release of Information Module and the Record Search window will pop up, 

enter the chart number (or whatever type of Release of Information search option is 

preferred). 

- Or - 

• Press [F4] or  to bring up the search window 

• A window will display if there are multiple choices to make, double click on the 

transaction desired and the Release of Information Screen will display with the pertinent 

information.   

Deleting Release of Information Transactions 

• Open the Release of Information Transaction that needs to be deleted 

• Press F5 or the  to delete the transaction. 

• The following message will appear: 

 

Figure 305 – Release of Information – Delete Chart Record 

 

 

• Press Yes to delete or No to not delete.   

• The deleted record will go into the Purge/Recover module, where the user has the 

option to Purge the transaction or Recover the transaction.  Please refer to 

Purge/Recover 
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Release of Information Reports 

 

Figure 306 – Release of Information – Printing/Emailing Reports 

 

• To print or view ROI reports press [F10] or  button 

• A Select Report window will pop up giving the user the following two options: 

o Double clicking in the Report File rectangular window and searching for the ROI 

report to be printed 

o Press the  beside the rectangular window to display the report 

• Choose the report in the list and highlight the report and the following 3 options are: 

o  to view the report 

o  to email the report 

o to print the report 
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6.2 Abstracting – [DAD] AbsCare Inpatient 

 

Figure 307 – [DAD] AbsCare Inpatient Header 

The DAD – AbsCare Inpatient module is part of Abstracting Suite.  This module is used to 

collect Inpatient Hospital data as per the CIHI – DAD Abstracting Manual. 

To open the [DAD] AbsCare Inpatient module 

o Select the menu option Module → Abstracting → [DAD] AbsCare Inpatient 

— or — 

o Select WinRecs Module Menu → Abstracting→ [DAD] AbsCare Inpatient 

 

CMG Calculation 

The CMG Calculation can be found in the dockable window called Grouper.  This provides the 

user with all the grouper information related to the abstract.   

The following System Mandatory fields must be completed in order to save: Chart 

Number, Institution Number, Discharge Date and Discharge Time field entered.   
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Figure 308 – CMG Grouper – Dockable Window 

 

Double-click on any of the fields in the Grouper pane to open the CMG Batch/Optimizer window.    

 

Figure 309 - CMG Batch/Optimizer window 

1. Displays fields and values from the main grid that relate to the grouper 

2. Displays the intervention codes and descriptions. 
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3. Displays the grouper values for the Most Responsible Diagnosis. The grouper values are 

automatically calculated and are based on the current fiscal year. 

4. Displays the grouper values for each diagnosis other than the Most Responsible diagnosis. 

The values shown are what the grouper values would be if that diagnosis was to be selected 

as the Most Responsible Diagnosis. 

5. Pressing these buttons will navigate to the Diagnosis and Interventions multiform and gives 

the ability to change the order of the diagnosis or intervention.  

 

6.3 Abstracting – [CCR] DAD Concurrent Review 

 

Figure 310 [CCR] - Concurrent Review Inpatient Header 

The Concurrent Review module is used to abstract patient data during the patient’s 

hospitalization.   

The module can be used in Conjunction with the CMG+™ grouper to determine expected length 

of stays (ELOS) and predict expected dates of discharge.   

Data entry is completed the same as other abstracting modules.   The more data collected during 

the hospitalization, the more complete the abstract will be on discharge.  Once the Discharge 

Date is populated, the chart will move from the CCR module Inpatient module.   

To open the [CCR] DAD Concurrent review module 

o Select the menu option Module → Abstracting → [CCR] DAD Concurrent Review 

— or — 

o Select WinRecs Module Menu → Abstracting→ [CCR] DAD Concurrent Review 

Reporting [CCR] DAD Concurrent Review 

Data entered into CCR can be used in the Report Manager to prepare statistical reports on 

current inpatients.   

To report the LOS in the Concurrent Review Module, do not use the LOS in the Abstract Grid 

as the LOS is based on the discharge date.   Since CCR does not have a discharge date the LOS 

is not updated.  For reporting purposes in Crystal Report, do not use the LOS field in the 

Abstracting views, use the custom formula that uses the Admit Date and the Current Date.   A 

sample is provided below: 

Optimized data shown on the Batch Optimizing form is not stored in the database 

(unless the Batch Grouper has already been run), and is for information purposes 

only. The option of storing optimized data is given when the Batch Grouper is run.  
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Create the formula below with the name ‘LOS Calculation’ 

If {I10_Abstracting.AdmissionDate} = CurrentDate then 1 else DateDiff 
('d',{I10_Abstracting.AdmissionDate} , CurrentDate)  
 
Place the formula as the LOS field in the report.   

 

 

6.4 Abstracting – [SDS] AbsCare Day Surgery 

 

Figure 311 – [SDS] AbsCare Day Surgery Header 

The SDS – AbsCare Day Surgery module is used to collect Day Surgery data as per the CIHI – 

DAD/SDS Abstracting Manual. 

The Same Day Surgery Abstracting is completed in this separate module for all clients except 

Ontario clients where SDS is completed using the [NACRS] Level 3 AmCare Ambulatory 

module.   

To open the [SDS] AbsCare Day Surgery module 

o Select the menu option Module → Abstracting → [SDS] AbsCare Day Surgery 

— or — 

o Select WinRecs Module Menu → Abstracting→ [SDS] AbsCare Day Surgery 

 

  

In order to save the record, the abstract must have the Institution Number, Chart 

Number and Admit Date.  

The following System Mandatory fields must be completed in order to save: Chart 

Number, Institution Number, Discharge Date and Discharge Time field entered.   
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6.5 Abstracting – [NACRS] Level 0 (Clinic Lite) AmCare Ambulatory 

 

Figure 312 – [NACRS] Level 0(Clinic Lite) AmCare Header 

The [NACRS] Level 0 (Clinic Lite) AmCare Ambulatory module is used to collect Clinic Lite data.  

Records in Clinic Lite include Ambulatory Care Groups CL, DI, and OT.   A field has been created 

to identify the Clinic Lite records called ‘NACRS Clinic Lite Submission’: 

• ‘F’ means the chart is flagged and will be submitted 

• ‘Y’ means the chart has been submitted 

• ‘N’ means the chart will not be submitted as Clinic Lite record  

 

 

Changing Unsubmitted Level 0 chart to Level 3 

If an unsubmitted record is abstracted in Level 0 but should be a Level 3:  

• Open [NACRS] Level 3 AmCare 

• Search for the record  

• A warning message will display: 

 

Figure 313 – Changing Level 0 to Level 3 message 

• Click Yes to save the record or No to not save 

• Save the record in Level 3 and it will now be submitted as Level 3. 

 

 

Please note:  If the Ambulatory Care Group CL is submitted as Level 3 then be sure to 

create the record in [NACRS] Level 3 AmCare.   
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Changing Unsubmitted Level 3 to Level 0 

• Open [NACRS] Level 0 Amcare 

• Search for the record 

• Save the record and the ‘NACRS Clinic Lite Submission’ will be flagged with “F” 

6.6 Abstracting – [NACRS] Level 1 AmCare Ambulatory 

 

Figure 314 – [NACRS] Level 1 AmCare Header 

The [NACRS] Level 1 AmCare Ambulatory module is used to collect Emergency (NACRS) data 

as per the CIHI – NACRS Abstracting Manual.  As per CIHI Level 1 includes data elements 

required for ED wait time, also allows for optional collection of Presenting Complaint and ED 

Discharge Diagnosis (as directed by region/province). 

Using this module will display Level 1 edits only. 

To open the [NACRS] Level 1 AmCare Ambulatory module 

o Select the menu option Module → Abstracting → [NACRS] Level 1 AmCare Ambulatory 

— or — 

o Select WinRecs Module Menu → Abstracting→ [NACRS] Level 1 AmCare Ambulatory 

6.7 Abstracting – [NACRS] Level 2 AmCare Ambulatory 

 

Figure 315 – [NACRS] Level 2 AmCare Header 

The [NACRS] Level 2 AmCare Ambulatory module is used to collect Emergency (NACRS) data 

as per the CIHI – NACRS Abstracting Manual.   

As per CIHI Level 2 includes data elements required for ED wait time and the collection of one of 

Presenting Complaint and ED Discharge Diagnosis is mandatory. 

Using this module will display Level 2 edits only. 

To open the [NACRS] Level 2 AmCare Ambulatory module 

o Select the menu option Module → Abstracting → [NACRS] Level 2 AmCare Ambulatory 

— or — 
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o Select WinRecs Module Menu → Abstracting→ [NACRS] Level 2 AmCare Ambulatory 

6.8 Abstracting – [NACRS] Level 3 AmCare Ambulatory 

 

Figure 316 – [NACRS] Level 3 AmCare Header 

The [NACRS] Level 3 AmCare Ambulatory module is used to collect Emergency (NACRS), 

Clinical and Surgical Daycare (Ontario only) data as per the CIHI – NACRS Abstracting Manual.   

As per CIHI Level 2 includes all mandatory and optional data elements.  It is mandatory to 

capture ICD-10-CA/CCI Diagnosis and Intervention information.   

Using this module will display Level 3 edits only, Level 1 and 2 data will flow over to the 

Level 3 abstract.   

To open the [NACRS] Level 3 AmCare Ambulatory module 

o Select the menu option Module → Abstracting → [NACRS] Level 3 AmCare Ambulatory 

— or — 

o Select WinRecs Module Menu → Abstracting→ [NACRS] Level 3 AmCare Ambulatory 

 

 

 

 

 

 

6.9 Abstract Auto Coding 

Within each Abstracting Module (except CCR), there is an option of Abstract Auto Coding just 

above the module header. 

The following System Mandatory fields must be completed in order to save for all 

NACRS Levels: Chart Number, Institution Number, Registration Visit Date and 

Registration Visit Time field entered.   
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Figure 317 – Abstract Auto Coding 

There are two options: 

 

Figure 318 – Abstract Auto Coding Options 

Copy Abstract Profile 

Copy Abstract Profile is used to create generic abstracts in Amcare, Inpatient & Day Surgery 

modules.  Profiles are used for abstracts with the same type of admission/diagnosis/intervention. 

 

Create an Abstract Profile 

o Go to Tools→Abstract Profile  

o Click on Abstract Profile and the following screen will populate 
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Figure 319 – Abstract Profile Screen 

o Under Select Module – click on the drop-down menu and the list of modules will display, 

choose the appropriate module. 

 

Figure 320 – Abstract Profile – Select Module Options 

 

o The module fields will be displayed on the right-hand side. 
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Figure 321 – Abstract Profile – Module Fields 

 

o Click on New Profile 

o Abstract Profile Name will open along the top, type in the Profile Name 

o Enter the fields in the abstract that are the same for each profile such as dx, intervention.  

The user can put in as many or as little fields as required.   

o Once completed press  

 

 

Edit an Abstract Profile 

o Go to Tools→Abstract Profile  

If Abstract Profile does not display in the Tool menu, this option will need to be set 

up in User Profile/Access Tools.  Please contact your WinRecs System Administrator. 
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Figure 322 – Abstract Profile – Editing Abstract Module 

Under Select Module, choose the module of the profile that needs editing 

o If there are multiple profiles, filter in the “Enter a value here to filter the list” 

o Double click on the profile that needs editing. 

o The abstract profile will load on the right-hand side and make the necessary changes 

o When done press Save Profile 

 

Delete an Abstract Profile 

o Under Select Module, choose the module of the profile that needs editing 

o If there are multiple profiles, filter in the “Enter a value here to filter the list” 

o Highlight on the profile 

o Press  

o A message will pop up “Are you sure you would like to delete this record?”  Yes will 

delete it and No will not delete.   

Using an Abstract Profile 

o Go to Abstracting and choose the module where the abstract profile resides 

o Search for the abstract that the abstract profile will be copied to  

o When the abstract is up, choose Abstract Auto Coding/Copy Abstract Profile 

 

Figure 323 – Copy Abstract Profile 

o Choose from the list of on the Find Record Clone screen and press Select Record 
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Figure 324 – Abstract Profile List 

A message will pop up stating: 

 

Figure 325 - Abstract Profile Successful Message 

o The information in the abstract profile will populate the abstract.   

 

 

Clone Abstract 

Clone Abstract accelerates the data entry process when working with a patient that has many of 

the same visits.  For example, the information for a patient receiving chemotherapy or radiation 

treatment is the same for the majority of the abstract, using clone will speed up the data entry 

process. 

Using Clone Feature 

o If the abstract has been brought over by HL7 or Batch Interface do a search on the abstract 

needed to be coded 

If a field already has data in it, the Abstract Profile will not overwrite this.   
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o If the abstract is being created from New, enter the following fields: 

• Registration Visit Date/Time for Amcare and Discharge Date/Time for 

Inpatient 

• MIS Code for Amcare – Adding the MIS code will only bring up the similar MIS codes 

when looking for cloning.  Leaving the MIS code blank will pull up all visits.  

o Go to Abstract Auto Coding/Clone Abstract 

 

o A list of Abstracts will display all the available visits, select the visit to be used for the cloned 

abstract. 

o The following message will display 

 

Figure 326 – Abstract Clone Successful Message 

 

o WinRecs will copy the data from the selected abstract to the new abstracts, Date and Time 

Fields will be NOT be populated.  All remainder of the fields will be populated. 

o Review the record for any changes or updates that are needed 

 

  

If a field already has data in it, the Clone Abstract will not overwrite this.   
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6.10 Abstract Queue 

 

The Abstract Queue module is integrated with MED2020’s chart abstracting software, WinRecs. 

The Abstract Queue: 

 

1. Is available for AmCare (NACRS) and Inpatient (DAD) modules. 

2. Lists visits that have not been accessed, that contain errors or that have been created by a 

user. 

3. Provides assign capability by the Coder to themselves or by an Administrator to a Coder. 

 

Opening the Abstract Queue 

To access the Abstract Queue, the icon  is available in the icon bar in WinRecs. The 

Abstract Queue can be used to search for AmCare or Inpatient records. 

 

 

Figure 327 - Abstract Queue 

 

 

 
 

 

Click on the Abstract Queue icon to open the Abstract Queue window. 

 

To enable the Abstract Queue Icon, go to the Hospital Profile, System Wide Options 

and update field “Use Abstract Queue” to Yes. Save this value and then users must 

log out of WinRecs and back in for the change.  



 [T WinRecs Version 2025.01 User Guide 

© 2025 MED2020 Health Care Software Inc. All rights reserved. Page 389 

 

Figure 328 Abstract Queue Window 

  



 [T WinRecs Version 2025.01 User Guide 

© 2025 MED2020 Health Care Software Inc. All rights reserved. Page 390 

 

Searching for Records  

The Abstract Queue allows filtering by Institution Number, MIS Group (Ambulatory Care Group), 

Date Range and Chart Number, Encounter Number, Disposition Code, Main Service, Discharge 

Nursing. Click the Search button once you’ve entered the parameters in the fields to run the 

search.  

 

 

Search by Institution Number  

All Institution Numbers are available to search on and are presented in a drop-down list. Use the 

mouse to highlight the desired Institution Number or the arrow keys to select it from the list. 

 

 

Figure 329 Abstract Queue - Search by Institution Number 

 
 
Search by MIS Group  

AmCare Institution Numbers can be further filtered by selecting the Ambulatory Care Group – 

Emergency Department (ED), Day Surgery (DS), Clinic (CL), Ophthalmology (OT), or Diagnostic 

Imaging (DI). 

 

Figure 330 Abstract Queue - Search by MIS Group 
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Search by Date Range  

The date format is presented as YYYY-MM-DD. The first date field indicates the start date for the 

search; the second field the end date for the search. 

 

 
 

Type a date directly into the Date Range fields or use the arrow  to open the calendar and 

select a date. Forward and back arrows shown on either side of the name of the month let you 

move forward and back through the calendar one month at a time. 

 

 

 

Click on ‘Today’ at the bottom of the calendar to quickly fill today’s date into the Date Range 

fields. 

 

 

Figure 331 Abstract Queue - Search by Date Range 
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Search by Chart Number  

Enter a chart number into the Chart Number field. Chart Numbers must be an exact match to 

locate the record; records with a partial match to the chart number will not be returned. 

 

 

Figure 332 Abstract Queue - Search by Chart Number 

 

 

Search by Encounter Number 

Enter an encounter number into the Encounter Number field. Encounter Numbers must be an 

exact match to locate the record; records with a partial match to the chart number will not be 

returned. 
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Figure 333 Abstract Queue - Search by Encounter Number 

 

Search by Disposition Code 

Can search by Disposition and select from a drop-down list  

 

 

Figure 334 Abstract Queue - Search by Disposition Code 
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Search by Main Patient Service 

 

Can search by Main Patient Service and select from a drop-down list 

 

Figure 335 Abstract Queue - Search by Patient Service 

 

Search by Discharge Nursing Area 

 

Can search by Discharge Nursing Area and select from a drop-down list 
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Figure 336 Abstract Queue - Search by Discharge Nursing Area 

 

 
Click the Search button to search based on the parameters entered in the search fields.  
The search parameters entered are saved from one session to the next. 

 

 
 

 

 

Search Results  
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Charts returned by the Search will be shown in the search results panel on the left side of the 
Abstract Queue window. The search will return incomplete records for the date range entered.  
The following information is given for each result:  
 

o Institution Number  

o Chart Number  

o Registration Number  

o MIS Functional Centre/Service 

o Admit Date  

o Admit Time  

o Discharge Date  

o Discharge Time  

o Location – Current Location for Chart Locator module  

o Care Type 

o Disposition Code 

 

 

Figure 337 Abstract Queue - Search Results 

 

 

Assigning Records to Coders  

Charts can be assigned by a Coder to themselves or can be assigned to other Coders by an 
Administrator. Users must have proper permissions for to assign visits. 
 
Selecting a Coder  
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If a User is not an Administrator, the Coder field will allow the user to select only their own profile 
(User number) and name from the drop-down list in order to assign records to themselves for 
completion.  
If a User is an Administrator, all Users will be shown in the Coder list. The Administrator can then 

click the dropdown arrow next to the Coder list and use the mouse to select a Coder to assign 

records. The arrow keys can also be used to move through the Coder list. 

 

 

Figure 338 Abstract Queue - Selecting a coder 

 

 

 

 

When a user is selected from the Coder list, the Abstract Queue window will show any incomplete 
records that are currently assigned to that Coder.  
 
 

Assigning a Record to a Coder  

To assign a record to a Coder, select the record or records returned by the Search from the left 
side of the  
 

Abstract Queue window and use the arrow  to move the selected record(s) under the Coder 
name on the right side of the Abstract Queue window.  
 

The arrow can be used to assign all records showing in the search results to the selected 

Coder at once. 

 

 

A coder must be selected from the Coder list before records can be assigned to them. 

This also applies for users who are not Administrators; a user must select their own 

user number and name from the Coder list before they can begin assigning records 

to themselves. 
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Once abstracts are assigned to a Coder, the information for that record no longer appears in the 

left side of the Abstract Queue window and now only appears on the right under the Coder’s 

name. The Abstract Queue will automatically save this information to the database. 

 

Any abstracts that have been assigned to a Coder will remain assigned to them until the abstract 

is complete (i.e. verified and saved). 

 

 
 

 
 

Steps to Assign a Record to a Coder: 

 
 

 

1 Select the record from the search results in the left panel of the Abstract Queue. 

2 
Click the single arrow to move only the selected record(s) or the double arrow to 

move all records over to the Coder’s assigned list. 

3 The selected records now appear on the right panel under the selected Coder’s name. 

 

 

In the event more than one User tries to assign the same abstract to themselves at the same 

time, the second user who is attempting to assign the record will be presented with a message 

that the selected record will be removed from their list. 

 

Selecting a Coder from the Coder list will show any previously assigned records that 

are not complete. 

1 2 
3 
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Opening an Assigned Record 

Records that have been assigned to a Coder can be quickly opened in the appropriate module by 

double-clicking on the record in the assigned area of the Abstract Queue window. The Coder can 

now begin completing the record. 

 

Once the abstract is complete (i.e. verified and saved), it will be removed it from the Coder’s 

assigned list in the Abstract Queue window. 

 

Removing an Assigned Record  

 
Similar to the process for assigning records, a Coder can remove an incomplete record from their 

assigned list in the Abstract Queue window by using the .  arrow All records assigned to a 

coder can be removed using the  arrow.  
 
Records that are removed from a Coder’s assigned list on the right panel are returned to the left 
search results panel.  
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Steps to Remove an Assigned Record from a Coder: 

 

 
 

1 Select the record to be removed from the Coder’s assigned record list in the right panel 

of the Abstract Queue. 

2 

Click the single arrow  to remove only the selected record(s) or the double arrow 

 to move all records back to the search panel.  

3 The records are returned to the left panel.  

 

 

 

Enable Abstract Queue  

An Admin user can define whether a Coder will be able to choose any abstract on the queue or 
only the next available by check/uncheck in the field ‘Select abstracts in Abstract Queue’ In their 
User Profile.  A Coder will be allowed to select abstracts from the queue if the field is checked. If 
the user’s permission is unchecked, the coder can only select next available abstracts in the 
Queue.  All other abstracts will be disabled. 

1 

2 

3 
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Figure 339 Abstract Queue - User Profile 

 

Assigning Next Available Abstract  

Scenario 1: Is Administrator = Checked and Can Select abstracts in Abstract Queue = Checked  

Allows the User to see ALL Coder and assign abstracts from Queue to Coder task list. 

 

 

Figure 340 Abstract Queue - Assigning Next Available Abstract Scenario 1 
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Scenario 2: Is Administrator = Unchecked and Can Select abstracts in Abstract Queue = 

Unchecked 

User can only see the next available abstract in the Queue and transfer abstract to their task list.  

All other abstracts in the Queue will not display. 

 

 

Figure 341 Abstract Queue - Assigning Next Available Abstract Scenario 2 
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Scenario 3: Is Administrator = Unchecked and Can Select abstracts in Abstract Queue? = 

Checked 

User can only select abstract for their own coder number.  

 

 

Figure 342 Abstract Queue - Assigning Next Available Abstract Scenario 3 
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6.11 CJRR – Hips & Knees 

The Canadian Joint Replacement Registry (CJRR) module is a data collection tool within 

WinRecs suite of modules that allows for the specific collection of joint replacement data as set 

out by the Canadian Institute for Health Information for their CJRR Registry.  This registry focuses 

exclusively on gathering data related to knee and hip interventions as captured by the following 

CCI codes: 

1.VA.53.^^ – Implantation of internal device, hip joint 

1.SQ.53.^^ – Implantation of internal device, pelvis 

1.VG.53.^^ - Implantation of internal device, knee joint 

1.VP.53.^^ - Implantation of internal device, patella 

 

 

6.11.1 CJRR Legacy 

CJRR records can be created in one of three ways: 

1. Creating manually through the CJRR modules  

2. Creating through a DAD or NACRS abstract 

3. Creating through a Batch interface or HL7 from an OR system 

 

Creating Manually Through the CJRR Modules 

o Go to WinRecs Module Menu→ [CJRR] Hip Canadian Joint Replacement or [CJRR] 

Knee Canadian Joint Replacement 

– Or   – 

o Modules→Abstracting→ [CJRR] Hip Canadian Joint Replacement or [CJRR] Knee 

Canadian Joint Replacement 

o Press [F5] to create a new record or [F4] for an already existing CJRR record 

o The abstract will come up with any common data elements from the CPI MODULE 

o Move through the abstract and fill any fields that are required.  

o Error messages will display for mandatory elements in the message list box.   

 

Creating Through a DAD or NACRS Abstract 

1. Complete a DAD/SDS/NACRS abstract  

2. The following Criteria must be met in order for a CJRR form to be triggered: 

o Intervention code is one of the following: 

- 1.VA.53.^^ – Implantation of internal device, hip joint 

Each facility must supply CIHI with a list of their orthopedic surgeons prior to using 

CJRR.  CIHI assigns a unique CJRR Surgeon ID, that identifies the surgeon regardless 

of where the surgery is done.  This number is placed in Provider Maintenance.   



 [T WinRecs Version 2025.01 User Guide 

© 2025 MED2020 Health Care Software Inc. All rights reserved. Page 405 

- 1.SQ.53.^^ – Implantation of internal device, pelvis 

- 1.VG.53.^^ - Implantation of internal device, knee joint 

- 1.VP.53.^^ - Implantation of internal device, patella 

o Includes Knee and Hip replacements that are: 

- Emergency or elective 

- Total or partial 

- Primary or revision 

o Intervention date must be greater than or equal to April 1, 2012 

o Intervention Attribute Status does not equal “A” – Abandon after onset 

o If the above criteria are met the following message will pop up when you save the record: 

 

Figure 343 – CJRR Record Message 

 

o Clicking ‘No’ will take you back to the abstract, clicking ‘Yes’ will take you to the CJRR Links 

Screen: 
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Figure 344 – CJRR Links 

o Create – this section is used to create a new CJRR record.  The box must be checked in 

order for the CJRR form to open up (depending on the intervention code).  If the box is not 

checked the record will be flagged as incomplete and placed on the Incomplete Report.  

Press OK to confirm the response.   

o Update – this section is used to update an existing CJRR record and there has been a 

change on the DAD/SDS/NACRS record.  The box must be checked in order for the CJRR 

form to open up.  If the box is not checked the record will be flagged as incomplete and 

placed on the Incomplete Report.  Press OK to confirm the response.   

o Recover – this section is used when you have deleted a CJRR record and want to recover it 

from the purge file.  This is useful when the CJRR record has been accidentally deleted and 

need to recover it.  The box must be checked in order to recover it. 

o Delete – this section is used for deleting the records and moving them to the purge file 

o Click OK button with nothing checked will take you back to abstract.  If the file is checked in 

the Create and Update mode, the appropriate CJRR record will display. 
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o The information from the abstract will populate the appropriate fields and the user will need to 

populate the OR fields as required.  The record can be saved with mandatory fields missing 

and the errors will be displayed in the Message List box. 

Link CJRR Record to an Abstract 

o The abstract (DAD or NACRS) to be linked to the CJRR record should already be created 

and the CJRR record should also already exist with the same criteria as listed: 

o Chart Number 

o Institution Number 

o Admissions Date 

o Admissions Time 

o Open the CJRR Record. 

o From the CJRR Menu options select Action - Link CJRR Record to Abstract.  

                             

Figure 345 - CJRR Actions Menu 

o A window will open with the list of valid abstracts to link to the CJRR Record. Choose the 

abstract that is to be linked to the CJRR Records and Click OK.  
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Figure 346 - CJRR List of Abstracts 
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o User is then presented with the following screen to update the CJRR Record. Select the 

intervention code and click ok. The Abstract and CJRR Records are now linked. 

  

Figure 347 - CJRR Link window 

 

Creating Through a Batch Interface or HL7 from an OR system 

o Batch Interface (BI) 

MED2020 provides a standardized file layout of a flat file that must be followed.  The clients 

Operating Room (OR) system will generate a file based on the specifications provided by 

MED2020 and will load the file into a centralized location accessible to the WinRecs 

application.  This will be loaded into WinRecs via the Tools/Batch Interface. 

o HL7 

The ADT HL7 feed will send across demographic only information as well as the record type 

entered into ZZ-Segment.  MED2020 will work with the organization to determine which ZZ-

Segment will need to be populated in order for the record type to be populated correctly.  

MED2020 will provide the record type values in an Excel Spreadsheet.   
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6.11.2 CJRR DAD (Discharge Abstract Database) 

Enable CJRR Multiform 

To enable the CJRR Multiform got to: 

o Options → Institution Profile → Settings 

o Press  or [F4] to find the facility the CJRR multiform is to be added and double 

click on the facility 

o Press  or [F6] to edit 

o Click on the box next to ‘Use CJRR Worksheet’ and ensure there is a checkmark 

 

Figure 348 – Use CJRR Worksheet 

o Options → Control File 

o Press  or [F4] to choose the user or user profile, double click on the user 

o Click on [DAD] AbsCare Inpatient 

o Click on  - Group Headers 

o On the left-hand side find and click on the header Canadian Joint Replacement 

Registry (CJRR) 

o Ensure the Enabled and Visible fields have a checkmark beside them 

o If desired, to move the header/multi-form to a different area of the abstract press the  

and place on top or below the desired header.  It is suggested to place the CJRR 

multiform after the Intervention Data header.  
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Figure 349 – CJRR Multiform – Enable and Visible 

 

o Press  to save or Press  to save for all users. 

 

Activate CJRR Multiform 

The following criteria and fields from the Intervention Data multiform must be met in order for a 

CJRR multiform to be triggered: 

o Intervention code is one of the followings: 

- 1.VA.53.^^ – Implantation of internal device, hip joint 

- 1.SQ.53.^^ – Implantation of internal device, pelvis 

- 1.VG.53.^^ - Implantation of internal device, knee joint 

- 1.VP.53.^^ - Implantation of internal device, patella 

o Includes Knee and Hip replacements that are: 

- Emergency or elective 

- Total or partial 

- Primary or revision 

o Intervention date must be greater than or equal to April 1, 2018 

o Intervention Attribute Status does not equal “A” – Abandon after onset 

o The field ‘Intervention Joint Identifier’ must be populated with a ‘1’, if there are 2 CJRR 

intervention codes, then the second intervention will be populated with a ‘2’.  The 1 and 2 

values cannot be entered more than once.   

o If there is a Revision coded, ‘Revision Reason’ field must be populated.   
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If the CJRR multiform is placed after the Intervention Data multiform, then press F12 Next to 

open the CJRR multiform 

Or  

Go to the main grid and double click on Canadian Joint Replacement Registry (CJRR) header. 

                                                                                                                                                                                                                                           

Canadian Joint Replacement Registry (CJRR) Multiform 

Please see CIHI guidelines on how fields are to be completed: 

 

Figure 350 – Canadian Joint Replacement Registry (CJRR) Multiform 

 

6.11.3 CJRR NACRS (National Ambulatory Care Reporting System) 

Enable CJRR Multiform 

To enable the CJRR Multiform got to: 

o Options → Institution Profile → Settings 

o Press  or [F4] to find the facility the CJRR multiform is to be added and double 

click on the facility 

o Press  or [F6] to edit 

o Click on the box next to ‘Use CJRR Worksheet’ and ensure there is a checkmark 
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Figure 351 – Use CJRR Worksheet 

o Options → Control File 

o Press  or [F4] to choose the user or user profile, double click on the user 

o Click on Abstracting/[NACRS} Level 3 AmCare Ambulatory 

o Click on  - Group Headers 

o On the left-hand side find and click on the header Canadian Joint Replacement 

Registry (CJRR) 

o Ensure the Enabled and Visible fields have a checkmark beside them 

o If desired, to move the header/multi-form to a different area of the abstract press the  

and place on top or below the desired header.  It is suggested to place the CJRR 

multiform after the Intervention Data header.  

 

Figure 352 – CJRR Multiform – Enable and Visible 
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o Press  to save or Press  to save for all users. 

 

Activate CJRR Multiform 

The following criteria and fields from the Intervention Data multiform must be met in order for a 

CJRR multiform to be triggered: 

o Intervention code is one of the followings: 

- 1.VA.53.^^ – Implantation of internal device, hip joint 

- 1.SQ.53.^^ – Implantation of internal device, pelvis 

- 1.VG.53.^^ - Implantation of internal device, knee joint 

- 1.VP.53.^^ - Implantation of internal device, patella 

o Includes Knee and Hip replacements that are: 

- Emergency or elective 

- Total or partial 

- Primary or revision 

o Intervention date must be greater than or equal to April 1, 2022 

o Intervention Attribute Status does not equal “A” – Abandon after onset 

 

If the CJRR multiform is placed after the Intervention Data multiform, then press F12 Next to 

open the CJRR multiform 

Or  

Go to the main grid and double click on Canadian Joint Replacement Registry (CJRR) header. 

                                                                                                                                                                                                                                           

Canadian Joint Replacement Registry (CJRR) Multiform 

Please see CIHI guidelines on how fields are to be completed: 
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Figure 353 – Canadian Joint Replacement Registry (CJRR) Multiform 
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 [T WinRecs Version 2025.01 User Guide 

© 2025 MED2020 Health Care Software Inc. All rights reserved. Page 417 

6.12 Specialized Fields 

Some regions/sites have specialized fields that are required by their province, health region or 

individual site.  

Manitoba – Multi-forms 

All Manitoba multi-forms are to be filled out as per Manitoba Health guidelines.  The multi-forms 

will function the same as all other multi-forms.  See Multi-forms 

 

MADE Patient Transfer Service Worksheet 

 

Figure 354 – MADE Patient Transfer Service Worksheet Multi-form 

MADE Alternate Level of Care (ALC) Data 

 

Figure 355 – MADE Alternate Level of Care (ALC) Data Multi-Form 
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MADE Designation non-ALC Delay Data 

 

Figure 356 – MADE Designation non-ALC Delay Data Multi-Form 

MADE Supplemental (Facility Study) Data 

 

Figure 357 – MADE Supplemental (Facility Study Data) Multi- Form 

Manitoba – Main Grid 

All fields are to be filled out as per Manitoba Health Guidelines.  Data Entry into these fields are 

the same as WinRecs Navigation and Look Up Section.  These fields can also be moved 

elsewhere within the main grid of the abstract as described Changing Sort Order – Main Grid.   
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MADE Abstract Data 

 

Figure 358 – MADE Abstract Data – Main Grid 

MADE Demographic Data 

 

Figure 359 – MADE Demographic Data – Main Grid 
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MADE Obstetrical Data 

 

Figure 360 – MADE Obstetrical Data – Main Grid 
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MADE Newborn Data 

 

Figure 361 – MADE Newborn Data – Main Grid 
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6.13 Cancer Care Module – (CCM)  

 

Figure 362 - Cancer Care Module Header 

 

The Cancer Care module is a data collection tool within the WinRecs suite of modules, sharing a 
common Central Patient Index and allowing the collection of cancer care data specific to the 
Disease Registration  
 
To clarify, a patient is not registered with Cancer Care Ontario on each visit. They are registered 
once with Cancer Care Ontario per Primary Disease which is captured in the CCM module. Once 
the registration is received and processed, what Cancer Care Ontario gets sent is updates to the 
registration or disease information or the visit related information which is referred to as ALR 
reporting information (Activity Level Reporting) which is captured in NACRS. 
 
Please refer to the Basic WinRecs Functionality section of the User Guide for details on the 

record layout and functionality. 

To open the [CCM] Cancer Care Registration  
o Select the menu option Module Abstracting → [CCM] Cancer Care Registration 

 
— or —  

o o Select WinRecs Module Menu → Abstracting→ [CCM] Cancer Care Registration 

 
 
Go to Cancer Care Module  
F4 and search for an Interfaced in patient  

F5 and create a NEW entry for this disease registration  

F7 SAVE your registration 
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CCM Disease Registration 

 

Figure 363 - Cancer Care Module – Disease Registration 

 

The disease registration is captured in the CCM module. Mandatory fields required to save an 

CCM record are:  

o Chart Number 

o Master Hospital Number 

o Disease Registration Date.  

In the CCM record, this is where the disease registration is collected which includes; the 

demographic information, providers, disease details, Dates of Referrals and Staging information. 
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CCM Activity Level Reporting (NACRS) 

Patient visits for the disease registration will be created in the NACRS module. Additional Cancer 

Care fields have been added to the standard NACRS module to allow you to enter the Chemo 

and Radiation Treatment fields required for visit level reporting. 

 

Figure 364 - Cancer Care Module – Activity Level Reporting 

 

The NACRS CCM portion of the record is enabled when an applicable CCM MIS code is entered. 

 

 

 

Next, the activity level reporting captured through NACRS is linked to the Cancer Care Module 

disease registration sequence. To link a NACRS record to a CCM registration, select the disease 

sequence from the field “CCM Cancer Care Visit.” If a patient has multiple disease registrations, 

the disease selected will be the disease that the NACRS visit is applicable to.  

 



 [T WinRecs Version 2025.01 User Guide 

© 2025 MED2020 Health Care Software Inc. All rights reserved. Page 425 

 

After the record has been linked to the CCM registration using the “CCM Cancer Care Visit” field, 

the CCM link will show up in the NACRS side bar 

 

 

Figure 365 - Cancer Care Module Linking 

 

Once a NACRS visit is linked to the CCM record using the “CCM Cancer Care Visit” field. The 

remaining CCM fields are enabled where the treatment details can be collected. This includes the 

drug and radiation treatments used during that hospital visit. 

 

Submitting Data  

Cancer Care Module Extract & Submission to CCO  

See the Data Book for frequency expected in reporting and to confirm the extract required is what 

is within the Crystal Report.  

 

Creation of submission files is performed via the WinRecs Report Generator. Data is extracted 

based on the parameter values presented and entered.  

Specific submission reports for:  

1) Disease Entity  

2) NDFP Enrollment  

3) Provider’s Entity  

4) Patient Entity  

 

…are available to run and export to the desired application, such as Microsoft Excel.  

See the Report Manager section of the WinRecs User Guide for details on how to generate 

reports. 
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Pre-Designed Reports  

These reports were developed in Crystal 8, specifically for use with the Cancer Care Module and 

for the purpose of providing a means to submit data following the Data Submission Specifications 

in the CCO Database 2007 – 2008.  

 

CCM HealthCare Professional Submission Report.rpt – This report used to extract the data 

from the Cancer Care Module for the Healthcare Professionals Data Submission requirements as 

per the CCO Databook 2007 - 2008. View is selecting on HCP Program Code, HCP Status, and 

Main Provider Specialty. It is suggested report be set up to generate from the Provider 

Maintenance using Report Selection List. Once the report has been generated it is to be exported 

to Excel.  

 

CCM Patient Submission Report.rpt – This report used to extract the data from the Cancer 

Care Module for the Patient Entity Submission data requirements as per the CCO Databook 2007 

- 2008. The report uses a Registration date range parameter to select the date range for the data 

submission. Once the report has been generated it is to be exported to Excel.  

 

CCM Disease Submisson Report.rpt – This report used to extract the data from the Cancer 

Care Module for the Disease Entity Submission data requirements as per the CCO Databook 

2007 - 2008. The report uses a Registration date range parameter to select the date range for the 

data submission. Once the report has been generated it is to be exported to Excel.  

 

CCM Incomplete Staging Data.rpt – This report extracts abstracts if the Clinical Staging at 

Diagnosis OR Pathological Staging at Diagnosis fields are not completed and are required as per 

the Diagnosis Code. Records grouped by Group Option parameter, ie: Data Entry/Coder, 

Registration Month or None. Detailed listing displaying Chart #, Full Name, Registration Date, 

Diagnosis Code and Description, Clinical and Pathological Staging fields with summary data on 

number of abstracts by Group and Grand Total.  

 

CCM Incomplete Abstracts Report.rpt – This report extracts abstracts if the IsAbstractValidated 

is not equal to “Y”. Records grouped by Group Option parameter, ie: Data Entry/Coder, 

Registration Month, Incomplete Status or None. Detailed listing displaying Chart #, Full Name, 

Registration Date, Diagnosis Code and Description and incomplete status description with 

summary data on number of abstracts by Group and Grand Total. 

 

CCM Patient Listing with Referral Dates.rpt – This report extracts Cancer Care Module 

abstracts within the Registration Date Range. The records are sorted by Registration Date. The 

detailed listing displays, Chart #, Full Name, Registration Date, Diagnosis Code and description, 

Clinical Staging at Diagnosis, Pathological Staging at Diagnosis, Medical Oncologist Referral 

Date, Radiation Oncologist Referral Date, Surgical Referral Date and Other Support Care 

Referral Date. 

 

 



 [T WinRecs Version 2025.01 User Guide 

© 2025 MED2020 Health Care Software Inc. All rights reserved. Page 427 

6.14 Clinical – MDS (Continuing Care Reporting System – CCRS) 

CCRS is a clinical module used to collect clinical and demographic information on residents who 

receive services from hospital-based continuing care (extended, chronic care or complex care 

beds) or 24-hour residential care beds.   

To open the Clinical Modules – [MDS-XX] Assessments 

o Select the menu option Module → Clinical → [MDS-XX]  

— or — 

o Select WinRecs Module Menu → Clinical→ [MDS-XX]  

 

The module has 10 assessment types listed below: 

 

Figure 366 – Clinical MDS - Assessments 

Assessment Type & Description 

1. [MDS-01] Admission Continuing Care Reporting System (AD)  

• To be completed at any stage if changes or corrections to demographic information 
are required.  

2. [MDS-09] Re-Entry Continuing Care Reporting System (AD)  

• Used when a resident is readmitted following a previous discharge from the facility. 

Certain conditions must be met. 

3. [MDS-17] Update Record Continuing Care Reporting System (UP) 
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• To be completed at any stage if changes or corrections to demographic information 

are required. 

4. [MDS-05] Quarterly Assessment Continuing Care Reporting System (QA)  

• Used to track resident status between Full Assessments, and to facilitate 

monitoring of critical indicators relating to changes in the resident’s status.  The 

Quarterly Assessment must be completed within 92 days of the last Full or 

Quarterly Assessment.  To be completed at any stage if changes or corrections 

to demographic information are required. 

5. [MDS-01] Full Admission Assessment Continuing Care Reporting System (FA) 

• To be completed by the 14th calendar day of the resident’s admission to the 

facility if this is the resident’s first stay in the facility or if the resident returns to 

the facility after being discharged and the conditions for use of the Re-entry Form 

do not apply.  The 1st calendar day of admission = 0, i.e. If patient was admitted 

on January 1st, then the full admit should be completed by January 15.   

6. [MDS-02] Full Assessment Continuing Care Reporting System (FA) 

• To be completed within 366 days of the Assessment Reference Date (Element 

A3) from the last Full Assessment. 

7. [MDS-03] Significant Change Assessment Continuing Care Reporting System (FA) 

• Required if there is a significant change in Resident’s status. Complete a Full 

Assessment within 14 days of the day determination of a significant change has 

occurred. 

8.  [MDS-06] Discharge Return Not Anticipated Continuing Care Reporting System (DC) 

• Required whenever a resident dies or is discharged from the facility. This is the 

only record that must be completed at the time of any discharge or death. 

Complete the No Return (06) if no return to the facility is anticipated. 

9. [MDS-07] Discharge Return Anticipated Continuing Care Reporting System (DC) 

• Complete the Return Anticipated (07) if a return to the facility is anticipated.  
10. [MDS-08] Discharge Prior to Assessment Continuing Care Reporting System (DC) 

• Discharged prior to completing initial assessment. 
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Searching for a Clinical MDS Visit 

 

• Click on any of the Assessments and press F4 to search for the record (Please see 
section 5.1 Searching for a Record).   

 

 

Figure 367 – Clinical MDS - Searching 

 
 

• The ability to search on any field within that assessment.  For example: if the [MDS-
QA] Quarterly Assessment Continuing Care Reporting System is chosen, a search 
can be done on any of the fields in that assessment by clicking on the field name in 
the middle column.  As well a search can be performed on more than one 
assessment.  When the search results screen is displayed all assessments for that 
search option will display.   

 

• When a search is made by Health Record Number or Patient Name all the 
assessments will display for that patient. 

 



 [T WinRecs Version 2025.01 User Guide 

© 2025 MED2020 Health Care Software Inc. All rights reserved. Page 430 

 

Figure 368 – Clinical MDS – Search Patient Display 

 

• Double click on the assessment that needs to be accessed.  

• When the assessment displays all fields previously inputted with display. 
 

• To go to other assessments, click on the other assessments displayed in the Patient Visit 
History.   

 
 

 

Figure 369 – Clinical MDS – Patient Assessment 

 

 

Facilities that have a batch or HL7 (real-time) interface transferring records into the 

WinRecs program will use the F4 search function to locate the assessment records 

they need to complete. 
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Creating a New Assessment for a Clinical MDS Visit 

• Click on the Assessment Type that needs to be created and press New [F5] (See 5.2 
Creating a New Record)  

 

 

 

Auto-Completion of Fields 

 
Depending on the assessment section, some fields will auto-populate with values based on a 
key question.  If ‘Y’ is typed in the ‘None of the below’ fields, the remaining fields’ values will 
grey out and default to No. This assists with the completion of assessment fields where the 
section does not apply to that patient yet must be completed based on data submission 
requirements. This requires less key stroking for data entry and consistency in the quality of 
data entered in the abstract. 
 
An example from Section C – Communication/Hearing Patterns, a ‘Y’ was inputted into the 
field ‘None of the below’ and the fields below auto-completed and the fields greyed out.  
Leave the field ‘None of the below’ blank results in each of the fields needing to be populated.  
 

 

Figure 370 – Clinical MDS – Auto-Completion of Fields 

Copy Data from Latest Assessment 

This feature allows the information from one assessment copy to another assessment, 
creating less keystrokes for data entry.  The user would only need to go into the fields that 
have changed, not enter the whole assessment again.  The following assessments will copy 
to each other: 

o Full Admission Assessment to: 
▪ Quarterly Assessment  
▪ Full Assessment 

o Full Assessment to: 
▪ Quarterly Assessment 
▪ Full Assessment 

o Quarterly Assessment to: 
▪  Full Assessment 
▪ Quarterly Assessment 

A facility that does not have an interface to transfer the patient visit information into 

WinRecs ® will use the F5 (new) function to create a new assessment record. 
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For this feature to work the following must be completed within the Institution Profile & 
Control File: 

Institution Profile/Settings: 

• The field named ‘Copy Data from Latest Assessment’ in the Institution 
Profile/Settings needs to be set to either: 
o Yes, for assessments created by user or interface 
o Yes, only for assessments created by user 

 
 

 

Figure 371 – Clinical MDS – Copy Data from latest assessment – Institution 
Profile 
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Control File: 
 

1 – Choose [MDS-05] Quarterly Assessment Continuing Care Reporting System. 

2 –  
3 – Choose ‘Facility Number’ 
4 – Under ‘Default’ enter Facility Number 

Press  to save and Repeat for [MDS-01] Full Assessment Continuing Care 
Reporting System 

 

Figure 372 – Clinical MDS – Copy Data from Latest Assessment – Control File 
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RUGS Grouper 

 

Figure 373 – Clinical MDS – RUGS Grouper 

 

• Rehabilitation - Identifies Rehab RUG-III group the client has been assigned to. The table 
displays the RUG-III code and level as well as the Case Mix Index Value. 

• Extensive Care - Identifies Rehab RUG-III group the client has been assigned to. The table 
displays the RUG-III code and level as well as the Case Mix Index Value. 

• Special Care - Identifies Rehab RUG-III group the client has been assigned to. The table 
displays the RUG-III code and level as well as the Case Mix Index Value. 

• Complex Care - Identifies the Clinically Complex Care RUG-III group the client has been 
assigned to. The table will display the RUG-III code and level as well as the Case Mix Index 
Value. 
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• Impaired Cognition-Identifies the Impaired Cognition RUG-III group the client has been 
assigned to. The table will display the RUG-III code and level as well as the Case Mix Index 
Value. 

• Behaviour Problems -Identifies the Behaviour Problems RUG-III group the client has been 
assigned to. The table will display the RUG-III code and level as well as the Case Mix Index 
Value. 

• Physical Function-Identifies the Reduced Physical Function RUG-III group the client has 
been assigned to. The table will display the RUG-III code and level as well as the Case Mix 
Index Value. 

 
 

6.15 Clinical – NRS (National Rehabilitation Reporting System) 

The Rehabilitation module is a diagnostic tool to keep track of individual patients and their 

progress once transferred to a specialized rehabilitation facility.   

To open the Clinical Modules – [NRS}-XX National Rehabilitation Reporting System 

o Select the menu option Module → Clinical → [MDS]-XX National Rehabilitation 

Reporting System 

— or — 

o Select WinRecs Module Menu → Clinical→ [MDS}-XX National Rehabilitation 

Reporting System 

 

The National Rehabilitation Reporting System modules has the following assessment types: 

 

Figure 374 – Clinical NRS – Assessment Types 

 

• NRS A – 1 - Admission National Rehabilitation Reporting System 

• NRS D – 2 - Discharge National Rehabilitation Reporting System 

• NRS F - 3 – Follow up National Rehabilitation Reporting System 



 [T WinRecs Version 2025.01 User Guide 

© 2025 MED2020 Health Care Software Inc. All rights reserved. Page 436 

• NRS I - IA – Interim National Rehabilitation Reporting System 

• NRS P - PD – Post Discharge National Rehabilitation Reporting System 

All the assessment types will display in the Patient Visit History and Rehabilitation Visit boxes 

except for the Interim Assessment and Post Discharge Assessment which will display only in the 

Assessment Links Tab.  If the Assessment Links tab is not displayed go to View/Assessment 

Links.    

 

 Figure 375 – Clinical NRS – Visit History 

 

Figure 376 – Clinical NRS – Assessment Links 

 

Searching for a Clinical NRS Visit 

• Click on any of the Assessments and press F4 to search for the record (Please see 
section 5.1 Searching for a Record).   
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Figure 377 – Clinical NRS – Searching for an Assessment 

 
 

• The ability to search on any field within that assessment.  For example: if the [NRS] 
Discharge National Rehabilitation Reporting System is chosen, a search can be done 
on any of the fields in that assessment by clicking on the field name in the middle 
column.  When the search results screen is displayed all assessments for that search 
option will display.   

 

• When a search is made by Health Record Number or Patient Name all the 
assessments will display for that patient. 

 

 

Figure 378 – Clinical NRS – Search Patient Display 
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• Double click on the assessment that needs to be accessed.  

• When the assessment displays all fields previously inputted with display. 
 

• To go to other assessments, click on the other assessments displayed in the Patient Visit 
History.   

 

Figure 379 – Clinical NRS – Patient Assessment 

 

 

 

 

Creating a New Assessment for a Clinical NRS Visit 

• Click on the Assessment Type that needs to be created and press New [F5] (See 5.2 
Creating a New Record)  

 

 

 
 

Facilities that have a batch or HL7 (real-time) interface transferring records into the 

WinRecs program will use the F4 search function to locate the assessment records 

they need to complete. 

A facility that does not have an interface to transfer the patient visit information into 

WinRecs ® will use the F5 (new) function to create a new assessment record. 



 [T WinRecs Version 2025.01 User Guide 

© 2025 MED2020 Health Care Software Inc. All rights reserved. Page 439 

• When creating a discharge assessment some assessment values (as per CIHI 

Guidelines) are carried over from the admission assessment.  Several of these fields will 

be disabled (greyed out) with data in the fields.  These fields contain data provided in the 

Admission Assessment can cannot be changed.  

• An Admission Assessment must be completed before a Discharge Assessment.  It is 

optional to record a Follow-Up Assessment once the Discharge Assessment has been 

completed.   

• A Discharge Assessment must not be deleted without first deleting its associated Follow-

Up Assessment (if applicable).  Likewise, an Admission Assessment must not be deleted 

without deleting its associated Discharge Assessment.  

• A Post Discharge Assessment can only be created if there is an existing Discharge 

Assessment.  The Post Discharge Assessment is not submitted to CIHI . 

• If an Admission Class field 4 (unplanned discharge without assessment) is used in the 

Admission Assessment the system will not allow you to create a Discharge Assessment.    

 

Defaulting of Diagnosis Condition Type 

 

The Main Health Condition type (occurrence 1) currently defaults to M.  Diagnosis condition types 

for pre-admit and post-admit conditions will now default as follows:  

• Admission Assessments - For any diagnosis occurrence greater than 1, the diagnosis 

condition type will always default to 1 (to represent Pre-admit Health Conditions).   

• Discharge Assessments - For any diagnosis occurrence greater than 1, the diagnosis 

condition type will always default to 2 (to represent Post-Admit Health Conditions).  

Note that Transfer or Death Health Conditions (diagnosis condition type of W) will still need to be 

manually assigned.  

FIM – Functional Independence Measure 

Functional Independence Measure is the sum of all scores/values entered on fields 41 – 58 which 

denotes a GREEN COLOUR Icon in the Field Requirements Bar. They can be found under the 

section Activities and Participation.  The FIM instrument includes the following data elements: 

41.  Eating 50.  Transfers:  toilet 

42.  Grooming 51.  Transfers:  tub or shower 

43.  Bathing 52.  Locomotion:  walk/wheelchair 

44.  Dressing – Upper Body 53.  Locomotion:  stairs 

45.  Dressing – Lower Body 54.  Comprehension 

46.  Toileting 55.  Expression 

47.  Bladder Management 56.  Social Interaction 

48.  Bowel Management 57.  Problem Solving 

49.  Transfers:  bed, chair, wheelchair 58.  Memory 
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Figure 380 – Clinical NRS – FIM Values 

 

 

 

 

 

 

 

 

 

 

 

FIM calculates as each field is entered.  FIM values are not carried over to the 

Discharge Assessment.  
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On the Assessment grid, once a FIM field is highlighted, press the F2 function key or double-click.  

The usual look-up table will then display. The relevant information for that value displays in the 

Look Up Notes field. 

 

Figure 381 – Clinical NRS – FIM 

 

Record Validation and Submission Date 

 

• CIHI mandates that as of their annually-specified date, any assessments not already 

submitted that fall into the previous fiscal year, MUST be submitted under the new fiscal 

year edits/requirements.    

• To accommodate this requirement, WinRecs has a setting in the Rehab institution profile 

where this annual date is entered.  This field is the “Record Validation and Submission 

Date.”  (Please see the section on NRS Submissions for more information).  

• When an assessment is being completed in WinRecs, if it belongs to the previous fiscal 

year’s data, and the current system date is AFTER the Record Validation and 

Submission Date, the most current fiscal year edits/requirements will be applied to the 

assessment.  

• This may result in some unexpected error messages appearing at the bottom of the 

screen – but these will be relevant to the current fiscal year’s edit requirements and must 

be completed correctly. 

NRS RPG Grouper 

 

• To provide an integrated grouper and weighting methodology for adult inpatient 
rehabilitation care within the MED2020 National Rehabilitation Reporting System (NRS) 
module.  

• The embedded grouper and weighting methodology will allow MED2020 Clients to 
account for adult rehabilitation care data into their funding formula which is then reported 
to Canadian Institute for Health Information (CIHI) and eventually their Provincial 
counterparts.  Of note, currently, Ontario is the sole province where adult rehabilitation 
reporting is mandated.    Data calculated by the rehabilitation grouper will be stored within 
the WinRecs database, allowing users to report on the data by use of accompanying pre-
designed reports or ad-hoc reports created by the user facility by means of Crystal 
Reports™.  

• The Rehabilitation Cost Weight (RCW) represents an average relative resource use for 
patients in an RPG.  The data used to develop cost weights for the RPG was drawn from 
two sources of Ontario data:  the National Rehabilitation System (NRS) and the Ontario 
Cost Distribution Methodology (OCDM).  
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• At discharge, each patient episode is assigned an RCW.  The RCW depends on the 
assigned RPG and the length of stay (LOS) of the episode of care.   

 

Using the NRS RPG Grouper 

 
Once the facility has purchased the NRS Grouper and the WinRecs Update has been applied to 
their WinRecs database, any user with permissions to the NRS Module will be able to view the 
NRS Grouper information in the FIM/RPG grid of admission and/or discharge assessments.  
  
  

• When the Admission assessment has had adequate data entered to complete the 
calculation, the grouper data will display in the relevant cells in the FIM table. 

• Initial values are displayed at completion of the Admission Assessment however the full 
calculation is applied to the FIM grid once the Discharge Assessment has been 
completed.  

 

 

Figure 382 – Clinical NRS – RPG Grouper 

Batch Grouper 

Batch Grouping Batch Grouping of NRS RPG data is available using the Batch Grouping 

functionality in the Utilities menu.  Please see Using the Batch Grouper section in this User Guide 

for detailed information on the steps required. 

 

 



 [T WinRecs Version 2025.01 User Guide 

© 2025 MED2020 Health Care Software Inc. All rights reserved. Page 443 

6.16 Clinical – OMHRS (Ontario Mental Health Reporting System) 

The Ontario Mental Health Reporting System (OMHRS) serves to standardize the 
capture of mental health clinical and administrative information. 
 

To open the Clinical Modules – [OMHRS}-XX Ontario Mental Health Registry System 

o Select the menu option Module → Clinical → [MHRS]Mental Health Registry System  

— or — 

o Select WinRecs Module Menu → Clinical→ [MHRS]Mental Health Registry System 
 
 
 

The Ontario Mental Health Registry System module has the following assessment types: 

 

Figure 383 – OMHRS – Assessment Types 

 

Assessment Types 

• MHRS- FA – Record Type 3 - Full Admission Assessment 

• MHRS-SS – Record Type 7 – Short Stay Assessment 

• MHRS-CS – Record Type 6 – Change in Status Assessment 

• MHRS-QA – Record Type 4 – Quarterly Assessment 

• MHRS – DA – Record Type 5 – Discharge Assessment 

 

All the assessment types will display in the Patient Visit History. 
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Figure 384 – Clinical OMHRS – Patient History Assessment Types 

 
 

Searching for a Clinical OMHRS Visit 

• Click on any of the Assessments and press F4 to search for the record (Please see 
section 5.1 Searching for a Record).   

 

• The ability to search on any field within that assessment.  For example: if the [MHRS] 
Mental Health Reporting System is chosen, a search can be done on any of the fields 
in that assessment by clicking on the field name in the middle column.  When the 
search results screen is displayed all assessments for that search option will display.   

 

• When a search is made by Health Record Number or Patient Name all the 
assessments will display for that patient. 
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Figure 385 – Clinical OMHRS – Record Search 

 

 

Figure 386 – Clinical OMHRS – Search Patient Display 
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• Double click on the assessment that needs to be accessed.  

• When the assessment displays all fields previously inputted will display. 
 

• To go to other assessments, click on the other assessments displayed in the Patient Visit 
History.   

 

Figure 387 – Clinical NRS – Patient Assessment 

 

 

Creating a New Assessment for a Clinical OMHRS Visit 

There will be 2 occasions when an assessment will need to be manually created within WinRecs. 
One is the Quarterly assessment, the other is the Change in Status assessment.  Both 
assessments are created the same way and follow the same steps.  

• A Quarterly assessment is required when a patient has stayed more than 92 days since 
the last assessment was done.   

• A Change In Status assessment is required when “a patient has had a major physical, 
mental, or social change/event that would render the current assessment and care plan 
invalid” (CIHI 2006).   
 

• Click on the Assessment Type that needs to be created and press New [F5] (See 5.2 
Creating a New Record)  
 

Facilities that have a batch or HL7 (real-time) interface transferring records into the 

WinRecs program will use the F4 search function to locate the assessment records 

they need to complete. 
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SCIPP Grouper (System for the Classification of In-Patient Psychiatry 

 
The System for the Classification of In-Patient Psychiatry grouper is available to clients to 
purchase in addition to the OHMRS module. The SCIPP grouper data can be found in the right-
hand display panel of the OMHRS module, if you are unable to see the Grouper Calculator, go to 
View/Grouper Calculator.  An associated "auto-calculate SCIPP Grouper" option has been added 
to the User Profile. SCIPP Grouper pre-designed reports have been made available.    
  
 The SCIPP Grouper is only available to clients who have purchased this functionality in addition 
to the OHMRS module. 

Batch Grouper 

Batch Grouping Batch Grouping of SCIPP data is available using the Batch Grouping functionality 

in the Utilities menu.  Please see Using the Batch Grouper section in this User Guide for detailed 

information on the steps required. 

 6.17 Clinical – [IRRS] Integrated interRAI Reporting System - LTCF 

To open the Clinical Modules – [IRRS]-Integrated interRAI Reporting 

o Select the menu option Module → Clinical → [IRRS]-Integrated interRAI Reporting 

— or — 

o Select WinRecs Module Menu → Clinical→ [IRRS]-Integrated interRAI Reporting 
 

The module contains the following assessments: 

A facility that does not have an interface to transfer the patient visit information into 

WinRecs ® will use the F5 (new) function to create a new assessment record. 
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Figure 388 – IRRS – Assessment Types 

 
Assessment Types: 

• First Assessment  

• Routine Assessment  

• Return Assessment  

• Significant Change in Status Assessment  

• Discharge Assessment  

• Discharge Tracking Only – within the assessment is a field called ‘Discharge 
Tracking Type’ where you choose Regular, First or Return 

• Referral Request – used by Receiving facility when person is transferred to 
facility from other InterRai facility.   

 

Creating a New IRRS Assessment   

• To create a new assessment for First Assessment, Routine Assessment, Return 

Assessment, Significant Change Assessment, Discharge Assessment (Regular, Return), 

Discharge Tracking (Regular, Return): 

o Click on the Assessment Type that needs to be created and press New [F5] (See 
5.2 Creating a New Record)  

• To create a new assessment for Discharge Assessment First or Discharge Tracking First.  
o Create a new or search for the First Assessment  
o Go to Actions/Change Assessment Type 
o Choose which Discharge First you would like to complete, and the First 

Assessment will change to that Discharge Assessment first or Discharge 
Tracking First:  
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Figure 389 – IRRS – Creating Discharge Assessment/Discharge Tracking First 

 

 
 
 

Searching for a IRRS Visit 

• Click on any of the Assessments and press F4 to search for the record (Please see 
section 5.1 Searching for a Record).   

 

• The ability to search any field within that assessment.  For example: if the [IRRS] 
Integrated interRAI Reporting System is chosen, a search can be done on any of the 
fields in that assessment by clicking on the field name in the middle column.  When 
the search results screen is displayed all assessments for that search option will 
display.   

 

• When a search is made by Health Record Number or Patient Name all the 
assessments will display for that patient. 

 

• Double click on the Assessment to upload it.   
 

• Press F6/F7 to save.  A pop up will display asking ‘Is this record ready to send for 
submission?’ Pressing Yes will send submit the record if user is connected to CIHI 
Service or will wait till connection to the service occurs.  Pressing No will put the 
assessment in the IRRS Submit Approve List.   

Important:  Discharge Assessment First and Discharge Tracking First must be 

created from the First Assessment by opening the First Assessment go to 

Actions/Change Assessment Type and choose the appropriate Discharge.  
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Figure 390 – IRRS – CIHI Submission Message 

 

IRRS Actions Menu 

 

Figure 391 – IRRS – Action Menu 

 

Change Assessment Type 

Used to change First Assessment to Discharge Assessment First or Discharge Tracking First 

Default Values from Previous Assessment – when chosen will populate values from the 

previous assessment.  Cannot be used for First Assessments.  Can also auto populate from the 

previous assessment by going to Options/Institution Profile/Settings/Copy Data from Latest 

Assessment – change this field to Yes, for assessment created by User or Interface.  This will 

auto populate that assessment.    

Re-set Record Update Status – When a user saves a record that has been interfaced in the 

records is flagged as not being able to update if the interface is run again.  This will remove the 

flag and allow fields to be updated if the interface is run again.   

IRRS Submissions 

1. System Registration – to submit assessments to CIHI, sites must first contact CIHI to 

complete the System Registration.  

• Once registration is confirmed, the site will need to download the ASCII file and the 

exe will be run on the server to allow connection to CIHI via a service.   

2. Submitting to CIHI 
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• Once an Assessment is Validated and Completed without any errors, a message will 

pop up asking:  

 

• Selecting Yes – if the user is connected to the service this will submit the assessment 

to CIHI.  If the user is not connected to the service, once you connect the 

assessment will be submitted. 

▪ When selecting ‘Yes’ the screen will clear and opening ‘IRRS Submit Viewer’ 

will show if the Transactions if PASS or FAIL.  If the screen does not clear, 

the service is not connected to WinRecs.   

▪ Clicking on the transaction and choosing ‘Select’ will reload the assessment.  

• Selecting No – will put the assessment on the ‘IRRS Submit Approve List’. 

 

 

 

 

 

 

 

 

 

 

 

3. Submission Windows: 

• IRRS Submit Approve List – Go to View/IRRS Submit Approve List – this will display 

just like the Visit History 

o This will list all the records where it has been Validated and Completed but have 

not been submitted to CIHI 
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o Double-click on the record and it will load. Resave the record and select “Y” and 

the record will be sent to CIHI.  

 

Figure 392 – IRRS – IRRS Submit/Approve List 

 

 

 

 

 

 

 

• IRRS Submit Viewer 

o Icon is circled in red below

 
o Displays all the Successful and Failed transactions sent to CIHI.   

o Enter the Inst Number, Date From and Date To (this is date submitted), Press Search 

to display the transactions. Additional Fields to sort on is Nursing Unit/Area and 

Coder Number. 

o Click on a transaction below and Click ‘Select’ and it will open the assessment.   

o Right clicking on the transaction will display ‘Copy Transaction ID’.  CIHI may ask for 

this Transaction ID if there is an issue and they need to review the transaction.   

 

View Successful: 
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Figure 393 – IRRS – IRRS – Submission History Viewer – Successful Submissions 

 

View Failed: 

o When you click on the FAIL transaction the bottom will show what the error is 

and the error code.  

o Only displays the most recent error, once the assessment is complete and 

submitted successfully the FAIL transaction will disappear.     

 

Figure 394 – IRRS – IRRS – Submission History Viewer – Failed Submissions 

• IRRS Failed Submit List 

▪ Under View/IRRS Failed Submit List 

▪ Displays all Failed Submissions (Just like the IRRS Submit Viewer).   

▪ Click on a transaction and the error message will display below.   

▪ Once the file has been submitted successfully the transaction will disappear.   
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Figure 395 – IRRS – IRRS Failed Submit List 

 

 

 

 

 

 

 

 

 

 

4. Submission Control Data Elements: 

The following are created after a successful submission: 

• CIHI Patient ID – is the patient also known as Client ID – is the patient ID is associated 

with the administrative fields that are submitted to CIHI.  The patient ID will always be the 

same for each patient unless it is discharged.  Also know as Patient Information.  

• CIHI Encounter ID – encounter ID will be the same from the First Assessment to 

Discharge, if patient comes back after a discharge, it is a new encounter ID.   

• CIHI Assessment ID – each assessment will have its own Assessment ID 

• Transaction ID – is the ID for that submission found on the Submit Viewer for 

transactions that have a PASS or FAIL.  Right clicking on the ID will copy.  CIHI may ask 

for this when troubleshooting. 
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5. Corrections and Updates 

Updates 

• Some fields can be sent as a correction or an update.  If the fields are combined with 

fields that can only be sent as a correction, then these fields will be sent as a correction.  

If you would like to send as an update, then it will need to be done separately.   

• The following pop up will display when the only fields can be Updated or Corrected: 

 

Figure 396 – IRRS – Update/Correction Message 

 

o Update – sends the field as an update to CIHI 

o Correct – sends the field as a correction to CIHI 

o No – will not send the file 

Correction 

• Fields that are sent as a correction the following will display: 

 

Figure 397 – IRRS – Correction message 
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Update/Correction sent to CIHI 

• When the update or correction is sent to CIHI, the assessment will clear.   

• Clicking on the ‘IRRS Submit Viewer’ will display if the assessment was a PASS or FAIL 

or the ability to reload the assessment.   

6. Deletions 

Deleting requires the most recent assessment being deleted then back to the First 

Assessment.  When sending in a First Assessment, encounter and patient information will be 

deleted as well.  

• To delete an assessment press on the red x in the tool bar. 

 

• Unsubmitted Assessments – will go the Purge/Recover Records 

• Submitted Assessment – will be submitted to CIHI, screen will go blank when 

submission occurs. 
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7. WinRecs Regional Solution 

A Regional Solution is defined as a WinRecs implementation for a group of health regions, 

hospitals or sites using one single WinRecs installation.  In this environment, each hospital can 

store and work with patient data independently from other sites in the regional solution.  Regional 

users can be defined for situations where a user, regardless of physical location requires access 

to records belonging to a different site.   

The Regional Solutions is determined by the one icon: 

o Profile Links 

 

Figure 398 – Regional Solution – Profile Links Icon 

 

o Clicking on Profile Links will open the following window: 

 

Figure 399 – Regional Solution – Profile Links Screen 

o The left hand side lists all the Regions and the Right Hand Side lists all the Hospitals.   

o For each module that has the Profile Links, able to assign a user, field, project etc. to a 

specified region(s) or hospital(s) 
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8. Glossary 

Abstracting  

Procedure whereby a coder captures electronically, with WinRecs, records of a single in-patient 

or out-patient episode (visit event) that is usually sent to CIHI and the appropriate provincial 

ministry of health, after the patient is discharged.  

CCR (Concurrent Review)  

The process of starting to abstract prior to patient discharge.  

Submission  

The process of submitting abstracted information to CIHI. 

CCI 

Canadian Classification of Health Interventions. 

CIHI 

Canadian Institute for Health Information, the organization that defines and manages healthcare 

information in Canada. 

DAD 

Discharge Abstract Database 

ICD-10-CA 

International Statistical Classification of Diseases and Related Health Problems Tenth Revision, 

Canada. 

NACRS 

National Ambulatory Care Reporting System 

Occurrence 

Certain data elements can occur multiple times per visit. These are tracked as occurrences.    A 

patient may have multiple diagnoses and interventions during a hospital visit. Occurrences are 

handled in WinRecs using multi-forms. 
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